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1. What's New? 
• Support for SNI based HTTPS sites added to the URL (HTTP/HTTPS) check. 
• Support for TLS 1.2 HTTPS sites added to the URL (HTTP/HTTPS) check. 
• Authentication for both the service and process check can be done using direct 

connection (ipc$) or impersonation. 
• Enhanced ERROR LEVEL CHECK for better control over the result. 
• SSL start mode added to the SMTP alerts. 
• SSH command as alert can now use a KEYFILE (RSA or DSA) for the (remote) 

authentication. 
• Enhancements to the executive alerts. 
• SLACK is added as a new "instant messaging" alert. 
• Hyper-V alert was added (start/stop a virtual machine). 
• VMWare alert was added (start/stop a virtual machine). 
• Hyper-V check as was added - check parameter of a virtual machine. 
• VMWare check was added- check parameter of a virtual machine. 

2. Getting Started 
Welcome to Servers Alive, the award winning monitoring tool from Woodstone bvba. Servers 
Alive is designed to monitor many different types of servers and services from a central location 
and report their status. Servers Alive supports many generalized tests applicable to servers of 
all types, along with specialized tests for certain types of services. When Servers Alive detects 
that a server or service has become unavailable, Servers Alive can report this condition in a 
variety of ways. The software can even take care of the problem without any human interaction. 

Servers Alive is used all over the world by companies in all types of businesses, from computer 
to legal, military to government. The companies rely on the software to monitor their mission 
critical servers. 

Servers Alive is a compact and inexpensive tool, but it packs a lot of punch. It has a feature set 
that compares favorably with the most popular monitoring packages available, but sells for a 
fraction of the cost. You can register the product and then you can check up to 1000 entries 
with the Standard edition and up to 5000 with the Enterprise edition. 

We're sure you'll enjoy your experience with Servers Alive. As such, we offer the product free to 
those who only wish to monitor ten or less servers or services. We're confident you'll see the 
incredible worth you can get out of this amazing product!  

In This Chapter 

InstallationGetting Started in the Main Window 

 

 

[1] 
 



Servers Alive 8 

2.1 Installation 
Servers Alive has the following requirements for installation: 

Microsoft Windows 7, Microsoft Windows 8.x, Microsoft Windows 10, 2008(R2) or 
2012(R2) 

Network interface card. 

TCP/IP. 

Telephony service. 
Note: If the telephony service is not running, the application/service will start it. 

For more information about these requirements, see the online Help for Windows. 

You can purchase two different editions of Servers Alive: Standard and Enterprise. To find out 
more, see the Woodstone web site. 

The following table shows the differences between the editions and free version. 

  Free 
version 

Standard edition Enterprise edition 

Entries 10 1000 5000 

  Yes No Yes 

Alert schedules Yes No Yes 

On-call schedules Yes No Yes 

Schedules for each 
alert 

Yes No Yes 

RRD Tools Yes No Yes 

Custom fields Yes No Yes 

Visual Basic scripts   No Yes 

Network routes for 
checks 

Yes No Yes 

Alert on received 
SNMP traps 

Yes No Yes 

Checking Schedule No No Yes 

 

Remote Agents 

1 No Unlimited (2 included 
with license). 

VMWarw checks Yes No Yes 

Before Installing Servers Alive 
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Please note that you must be an administrative user on the computer before you can install 
Servers Alive. Also note that, for all operating systems, you must run the telephony service or 
the processor can take 100% CPU usage. For more information about telephony services, see 
the online Help for Windows. 

Make sure that Windows has been updated to include the most recent patches provided by 
Microsoft®. This ensures the best possible compatibility. If you plan to use Servers Alive to 
check Oracle® or Microsoft SQL® databases, you must install the corresponding client 
software provided by the database manufacturer, as Servers Alive uses the client to perform its 
checks. If you check any Novell®-specific servers, you must install the Client for Novell 
Networks provided by Novell. The Novell client provided by Microsoft is not sufficient for the 
Netware® checks. 

Downloading Servers Alive 

Servers Alive is obtained primarily through an Internet download at the Woodstone web site. 

You can find the download link on that page, or you can choose from any of the worldwide 
mirrors. 

Woodstone bvba can ship a CD to you when you purchase the full version of the software. Only 
one version of the software exists, regardless of whether you use it for ten or less entries or 
whether you have purchased a full license. 

Installing Servers Alive 

Make a backup of your Servers Alive installation file (.exe). Woodstone is not responsible for 
backups of this file. 

Once you have downloaded the software package and saved it to a convenient location, launch 
the Setup program. 

Note that you cannot install Servers Alive through a Terminal Server session. When running 
Servers Alive as a service through Terminal Server, you cannot see the tray icon. 

The system tray icon of Servers Alive is visible only on the desktop of the system running 
Servers Alive. If the software is running as a service, you can only see the icon when the 
service user interacts with the desktop. Note that a Terminal Server session does not display 
the actual desktop, but a virtual desktop. Also, you can see the actual desktop if you use the 
terminal server session with the /CONSOLE command line option of the Terminal Service 
client of Windows 2003 (R2) and Windows 2008 (R2). 

The Setup program asks you for a location where it can install the software. You can install the 
software in any location. The install program extracts all program files to the location you 
specify and creates entries for Servers Alive on your Start Menu under the heading Alive. 

Servers Alive can be run as a service if the computer for installation is running Microsoft® 
Windows® Vista, Microsoft® Windows® 7, Microsoft® Windows® 8.x, Microsoft® Windows® 
2003 (R2), 2008 (R2) or 2012 (R2). The Setup process detects your operating system and the 
service automatically installed. For Servers Alive to start automatically when you turn on your 
computer, you must go to the Services control panel and set the service called Servers Alive to 
automatic startup. 

Extending Servers Alive 
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When the Setup program installs Servers Alive, the Setup program also installs a few 
companion applications that you can use to extend the functionality of Servers Alive. A 
subdirectory called External includes sample external check applications that you can use. 
Woodstone bvba creates and maintains the applications that are included in the external 
directory, but there are other applications, made by other authors, provided free, that you can 
download from the Woodstone bvba web site. There are also applications in the main Servers 
Alive directory that you can use to create your own external checks. For more information, see 
External Checks. 

Configuring Servers Alive 

Before adding any monitored entries to Servers Alive, you need to configure its various options 
and features. Servers Alive has many powerful features that you can use to tweak the 
monitoring process. You should configure these before adding any entries, as you cannot use 
most of the alerting or monitoring features without globally configuring them first. 

The first thing to do is enter your registration code if you purchased the product. You can do 
this by selecting the Register menu option from the Main window. This menu option is visible 
only in the unregistered product. Woodstone bvba sends an email with the required name, 
company, and registration Code when you purchase the software. If you have purchased the 
product, but do not have a registration code, please send an email to Servers Alive support. 

Next, you can click the  button on the Main window. You can configure how Servers Alive 
monitors and alerts you by setting various options in the tree. 

2.2 Getting Started in the Main Window 
To get additional information about a dialog box or command, select the menu command and 
press F1on the keyboard. Or, you can open a dialog box and press F1. 

Moving, Displaying, Hiding Columns 

When you first open Servers Alive, the Main window does not display columns. 

 

You can display the columns by clicking any of the following commands on the View menu: 
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Host ID Column 

Last Checktime Column 

Roundtrip Column 

Response Column 

Status Column 

Pretty Name Column 

Host Name Column 

Check Description Column 

Priority Column 

 

You can customize your own view of the item entries by doing one of the following: 

Hide UP or MAINTENANCE entries by selecting View > Hide entries based on status 
then Hide UP entries or Hide MAINTENANCE entries. This takes effect during the next 
check cycle. 

Click the column heading to re-sort the list. 

If you resort, this affects the order in which Servers Alive checks the entries; but the 
software tracks the correct checking order for the dependencies. 

Drag the column heading to the place you want to change the order of the columns. 

You can hide different columns by selecting the name of the column on the View menu. 

You can also display or hide the status icons by selecting View > Status Icons within 
Tree. 

Adding and Editing Entry Items 

You can add an entry item by clicking the Add button on the Main window. If you want to 
change the configuration and global settings of Servers Alive while adding entries, click the 
Setup button. If you want to delete an item, select the row for the item and click the Delete 
button. 
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To copy an entry, select the entry and press Ctrl + D on the keyboard. The new entry appears 
in the window as Copy of <pretty name> or Copy of <host name>, in cases where the entry 
has no pretty name. 

To view information about an entry, select the entry and right-click. You can view the statistics, 
status, and maintenance information on the shortcut menu. 

 

To change the font size and font type, such as Arial, for entries in the Main window, you can 
enter the following registry entries: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Name (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Size (string) 

When you add an entry, you can enable the individual alert entry in the Main window by clicking 
the check box that appears next to the entry. You can disable the alert entry by clearing the 
check box. 

 By default, the software asks you to confirm if you want to drag and drop an entry on the Main 
window. To turn this off, you must add the following registry key and then assign a value of 1: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\No_confirmation_for_Drag_and_Drop (dword) 

Organizing Entries with Groups 
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You can organize your entries in the Main window by grouping them together. In the list in the 
Main window, select one of the existing groups, such as Firewalls, Webservers, and so forth, 
and right-click. Select Add Group on the shortcut menu. You can add a group to an existing 
group by clicking Add Sub Group on the shortcut menu. 

You can also rename a group by selecting an existing group and then clicking  on the shortcut 
menu. When you want to delete a group, select the group, right-click, and click Delete Group. 

 You can also drag groups to re-organize them: 

If you drag an entry to a group, the item becomes a part of that group. However, if the item 
depended on other items in the original group, those dependencies are lost when the item 
is dragged to the target group. 

If you drag a group to another group, the item becomes part of the target group. 

If you want to move a sub group to the top level of the tree, so that the sub group is not part of 
another group, select the sub group and right-click. On the shortcut menu, click Group to Top 
Level. 

Changing the Order of Entries 

You can change the order of entries in a subgroup with the following two commands: 

First in (sub)list/group 

Last in (sub)list/group 

In the Main window, you select an entry and right-click to use the commands. 

For example, if you have the following entry list in Main window: GROUP 1 contains 
SUBGROUP 1, which contains the following groups in the following order: 

Entry_A 

Entry_B 

Entry_C 

If you select Entry_C, and select First in (sub)list/group, the order in the Main window 
changes to the following: 

Entry_C 

Entry_A 

Entry_B 

Check Cycles 

Servers Alive performs a check cycle starting from the top of the entry list working to the bottom 
of the list. The software auto-arranges the list of entries by host in the correct order for the 
dependencies to work properly. 

You can see how often the software checks the servers in the lower left corner of the Main 
window. If you want to change how often the servers are checked, click the Setup button and 
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click Setup > Misc Settings in the Setup tree. You must edit one of the boxes according to the 
time you want in the Check Times area. You can set whether the checks occur in minutes or 
seconds. To do this, click File > Setup. In the Setup tree, click General > Startup Settings. 

If you want the view to scroll during checks, click the Setup button. In the tree on the Setup 
dialog box, click General > Interface Settings. You can then click the Scroll Interface While 
Checking check box. 

Start, Stop, Pause, and Update Buttons 

There are four command buttons in the lower right-hand corner of the Servers Alive window 
called Start, Stop, Pause and Update. Use these buttons to control the check cycle. If you 
pause the check cycle, it stops where it is and allows you to resume when ready. Note, 
however, that it only pauses until the next schedule check cycle, at which time the software 
checks entries again automatically. If you need to stop the check cycle for a long period of time, 
click the Stop button instead. When you are ready to resume, use the Start button. When you 
click the Update button, the software immediately begins a new check cycle. 

To display the status for entries in a group in the column of the Main window, you can click the 
Setup button and then click General > Interface Settings in the tree. Click the check box. The 
status displayed in the Main window applies only to the entries in the group—and not 
subgroups. 

Rechecking an Active Entry 

You can recheck a single entry that has gone down to verify its condition. You do this by first 
clicking the Stop button to stop any check cycle currently in progress. Select an entry and right-
click to select Check Now. Servers Alive checks that single entry and displays the status in the 
left-most column. 

Statistics 

Servers Alive maintains statistics on the availability of the servers that you monitor. You can 
access these statistics by first selecting an entry. You then right-click and select the Statistics 
command on the shortcut menu. The Statistics box displays response time statistics, showing 
the minimum, maximum, and average response times. The dialog box also shows how many 
times the server was detected as up and down. Currently, there is no process to produce 
reports based on this information. 

 

Servers Alive does not keep previous statistics when you stop and then restart the software. 
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Active and Maintenance Modes 

An entry can be in one of two modes: Active or Maintenance. Hosts are only included in the 
check cycle if they are active. Most entries stay in active mode all the time and only can be 
switched to maintenance mode when work is being performed on them. If you have regularly 
scheduled maintenance periods for a server, you should click the Add button and use the tab in 
the host entry to schedule periods when the item is switched to maintenance mode. 

You can change an entry from active to maintenance states quickly and easily. Select an entry 
in the Main window and right-click. You can then select Active or Maintenance from the 
shortcut menu. 

You can also change all the entries in a group with one click. Select a group and right-click. On 
the shortcut menu, click Set All Entries to Active or Set All Entries to Maintenance. 

Sound 

To turn off the sound for an entry, select it, right-click and select Mute Sound. 

Alerts 

To turn off alerts for an entry, select it, right-click and select Mute all alerts. The setting is not 
saved in the entries file, and is reset when you edit the entry. 

See Also 

Getting Started 

Installation 

Default Host Names 
 
License Agreement 

Technical Support 

Trademarks and Copyrights 

2.3 Default Host Names 
@DNS1 which refers to the first DNS server as defined within the OS. 

@DNS2 which refers to the second DNS server as defined within the OS. 

@WINS1 which refers to the first WINS server as defined within the OS. 

@WINS2 which refers to the second WINS server as defined within the OS. 

If the result that the OS gives back is blank, or none, the software executes the command with 
a blank host name. Some of the checks, such as the ping check, use your own local Internet 
protocol (IP) address. 

See Also 
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Getting Started in the Main Window 

License Agreement 

Technical Support 

Trademarks and Copyrights 

2.4 License Agreement 
This license agreement covers your use of Servers Alive by bvba Woodstone. This includes the 
executable files and documentation and is hereafter referred to as the "Product". The Product 
is Copyright © 1997-2015 by bvba Woodstone. If you do not agree with these terms you may 
not install the Product. By incorporating the Product in your work or distributing the Product 
to others you implicitly agree to these license terms. This End User License Agreement (EULA) 
covers the current version of the Product. bvba Woodstone reserves the right to modify the 
terms of this License Agreement at any time and without prior notification, in future releases 
of the Product. 

Copyright The Product is, and remains, copyright 1997-2015 bvba Woodstone. All rights 
reserved. 

All title and copyrights in and to the PRODUCT (including but not limited to any text, images, 
and other materials incorporated into the PRODUCT), and any copies of the PRODUCT are 
owned by the software publisher or its suppliers. All title and intellectual property rights in 
and to the content which may be accessed through use of the PRODUCT is the property of the 
respective content owner and may be protected by applicable copyright or other intellectual 
property laws and treaties. This EULA grants you no rights to use such content. If this 
PRODUCT contains documentation which is provided only in electronic form, you may print 
one copy of such electronic documentation. 

Conditions of Use 

The Product is provided in one (1) form: as a downloadable, ready-to-run, installation kit 
consisting of executable programs, release notes, and documentation, hereafter referred to as 
the "Product Executable". You may freely use and distribute the trial version of the Product 
Executable so long as you provide the complete and unmodified original trial version of the 
Product Executable installation kit as supplied by bvba Woodstone. Woodstone provides only 
the latest version of the Product Executable for download from the Woodstone Web site. 
Older versions of the Product will not be provided by Woodstone at any time. It is your 
responsibility to create an archived copy of the downloaded Program Executable which you 
have purchased. 

Disclaimer Of Warranty 
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The Product is provided on a trial basis for evaluation, in the hope that it will be useful. It is 
provided "AS-IS", without warranty of any kind, either expressed or implied, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. The 
entire risk as to the quality and performance of the Product is with you. Should the Product 
prove defective, the full cost of repair, servicing, or correction lies with you. The trial version is 
limited to ten (10) check entries and this is the only limitation. You may purchase either the 
Standard Edition or the Enterprise Edition, depending on your needs. Each registration code 
covers ONLY a single copy of the PRODUCT EXECUTABLE installed on a single machine. You 
need a unique registration code for each copy of the program you want to run. The license 
covers one (1) additional installation, which must be off-site and for disaster recovery and/or 
testing the DRP, only. You cannot run this concurrently with your main installation. 

Technical Support 

Limited technical support is available from Woodstone. Full, guaranteed technical support is 
available only with a support license purchased from bvba Woodstone. Current prices and 
conditions may be obtained by emailing support@woodstone.nu 

Other Licensing Conditions 

For commercial distributors, other licensing conditions may be negotiated with respect to 
technical support and redistribution rights. Before selling Servers Alive, you should contact 
bvba Woodstone in order to negotiate a redistribution license. Commercial distributors 
interested in OEM deals should contact us.  

See Also 

Installation  
Getting Started in the Main Window 
Default Host Names  
Technical Support  
 

2.5 Technical Support 
Email 

Limited email support is available from Woodstone support. 

Full guaranteed technical support is subject to a Woodstone bvba support license. For current 
prices and conditions, please send email to Woodstone support. 

Mailing List 

You can obtain technical information quickly by signing up for our mailing list. To sign up for the 
list, see the subscriber page. 

You can also search the mail archives for useful information. 
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2.6 Trademarks and Copyrights 
Trademarks 

Servers Alive is a registered trademark of Woodstone bvba. 

Oracle is a registered trademark of Oracle Corporation. 

Novell is a registered trademark of Netware. ICQ is a registered trademark of Mirabilis LTD 
(copyright 1996). 

Microsoft, Windows, Windows NT, Visual Basic, and MSN are registered trademarks of 
Microsoft Corporation. Citrix is a registered trademark of Citrix Systems, Inc. 

The term "Linux" is a registered trademark of Linus Torvalds, the original author of the Linux 
kernel. UNIX is a registered trademark of The Open Group. 

Lotus and Lotus Notes are registered trademarks of Lotus Development Corporation. 

Domino and Notes are trademarks of Lotus Development Corporation. 

IBM, the IBM logo, and Wake on LAN are trademarks of International Business Machines 
Corporation in the United States and/or other countries. 

Intel is a trademark of Intel Corporation in the United States, or other countries, or both. 

AOL and AIM are registered trademarks of America Online, Inc. AOL® Instant Messenger is a 
trademark of America Online, Inc. 

ICQ is a registered trademark of ICQ, Inc. 

Google is a trademark of Google, Inc. 

Twitter is a registered trademark of Twitter, Inc. 

Hyper-V is a registered trademark of Microsoft Corporation 

VMWare is a registered trademark of VMWare Inc. 

Slack is a registered trademark of Slack Technologies, Inc. 

All other brands and product names are trademarks or registered trademarks of their respective 
owners. 

Copyright 

The product is, and remains, copyright © 1997-2015 Woodstone bvba. All rights reserved 
including software, file formats, and audiovisual displays; may be used pursuant to applicable 
software license agreement; contains confidential and proprietary information of Woodstone 
bvba and/or third parties which is protected by copyright and trade secret law and may not be 
provided or otherwise made available without proper authorization. 

Warranties and Liabilities 

All warranties given by Woodstone bvba about software are set forth in your purchase contract, 
and nothing stated in, or implied by, this document or its contents shall be considered or 
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deemed a modification or amendment of such warranties. Woodstone bvba believes the 
information in this publication is accurate as of its publication date. The information and the 
software discussed in this document are subject to change without notice and are subject to 
applicable technical product descriptions. Woodstone bvba is not responsible for any error that 
may appear in this document. 

The software discussed in this document is furnished under a license and may be used or 
copied only in accordance with the terms of this license. 

No responsibility is assumed by Woodstone bvba for the use or reliability of software. THE 
USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALUATION AS TO THE 
USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT. 

 

Schrieksebaan 146 

3140 Keerbergen 

Belgium 

Web site 

Email 

Copyright Notices for MIB Parser 

Part 1: Copyright 1989, 1991, 1992 by Carnegie 
Mellon University 

Derivative Work - 1996, 1998-2000 

Copyright 1996, 1998-2000 The Regents of the University of California 

All Rights Reserved 

Permission to use, copy, modify and distribute this software and its documentation for any 
purpose and without fee is hereby granted, provided that the above copyright notice appears in 
all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of CMU and The Regents of the University of California not 
be used in advertising or publicity pertaining to distribution of the software without specific 
written permission. 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE 
REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
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Part 2: Networks Associates Technology, Inc 
copyright notice (BSD) 

Copyright (c) 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Part 3: Cambridge Broadband Ltd. copyright 
notice (BSD) 

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

The name of Cambridge Broadband Ltd. may not be used to endorse or promote products 
derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
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WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

Part 4: Sun Microsystems, Inc. copyright notice 
(BSD) 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, 
U.S.A. All rights reserved. 

Use is subject to license terms below. 

This distribution may include materials developed by third parties. 

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the U.S. and other countries. Redistribution and use in source and 
binary forms, with or without modification, are permitted provided that the following conditions 
are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; 

OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Part 5: Sparta, Inc copyright notice (BSD) 

Copyright (c) 2003-2004, Sparta, Inc 

[15] 
 



Servers Alive 8 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

See Also 

Getting Started 

Installation 

Getting Started in the Main Window 
Default Host Names 

License Agreement 

Technical Support 

3. Servers Alive and Terminal Server 
Sessions 
You can run Servers Alive natively as a service in Microsoft® Windows® Vista, Microsoft® 
Windows® 7, Microsoft® Windows® 8.x, Microsoft® Windows 10, Microsoft Windows® 2003 
(R2), 2008(R2) and or Microsoft Windows 2012(R2). You must set Servers Alive as a system 
account with desktop interaction. To do this, you open the Microsoft Management Console, 
select the Local System Account option on the Properties dialog box, and click the Allow 
Service to Interact with Desktop setting. 
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Terminal Server Sessions 

If you want to use a Terminal Server session to manage Servers Alive running as a service, you 
must run Terminal Server for Windows 2003 and the Windows 2003 Terminal Server client. 

When using a Terminal Server session, you interact with a virtual desktop, not the actual, or 
real, desktop of the remote system. The system tray icon of Servers Alive is visible only on the 
real desktop of the system running the service and only if you are logged in with the correct 
privileges as the user of the service, and you are running an older OS like Windows 2003. For 
more recent Operating Systems, please see Servers Alive and the Remote Client/Icon. 

To display the actual desktop of the system running the service, not the virtual desktop, you 
must type the command line option /CONSOLE on the client at the DOS prompt. 

The Console option is available only for Windows 2003 Terminal Service client. 

Security Issues with Services Running in 
Windows 

Any services that run in Windows have a common security issue. To run Servers Alive under 
the system account with desktop interaction, you should carefully consider the following: Any 
process started from within Servers Alive has the same access rights as the system 
administrator. 

You must protect the system running Servers Alive by ensuring that only users with a correct 
security clearance are allowed to log on to the local system. Remote log-ons have serious 
security implications. Users who log on remotely can perform tasks as though they were sitting 
at the console. For this reason, you should make sure that the server is behind a firewall. You 
should require that all users who use remote connections log in with a strong password. 

For example, an administrator installs Servers Alive on a workstation and configures the 
software to run as a service, using the system account with desktop interaction. A non-
administrative user can log on to the workstation and see Servers Alive as an icon in the 
system tray. The user can open the Servers Alive Help file and click the View Source 
command in the Windows Help viewer. Subsequently, in the Open dialog box, the user can 
open and run CMD.exe. The non-administrative user can now run the command line with all the 
access rights as the system administrator. 

Members of the Server Operator group can list, monitor, and restart services. 

Servers Alive and the Remote Client/Icon 

When running Servers Alive as a service (system account with desktop interaction) you get a 
system tray icon in the previous Microsoft Operating Systems like Windows 2000 and Windows 
2003. In more recent versions (Windows 2008, Windows 7, Windows 8, and Windows 2012) 
the "desktop interaction" no longer shows the system tray icon, and hence we have added a 
new tool called Remote Client. When you run the Remote Client on the system running Servers 
Alive, you can get the system tray icon (just like in the previous Microsoft Operating Systems) 
and you can open the Servers Alive interface in none-checking mode, so that you can do 
entries and setup changes. If you run the Remote Client on a different system than the system 
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running Servers Alive, you can just get the "moon" and "stop" icon that tells you if (and how 
many) entries are down or not. 

In order to run the Remote Client you need to create a PERSON in Servers Alive (EDIT menu - 
PERSON) and give that person the right to run the Remote Client. 

 

  
Within the Remote Client you need to configure the user name and password of that person 
and the IP of the system running Servers Alive. 
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If you run the Remote Client on the system running Servers Alive then you can call from the 
context menu (right click on the icon) Servers Alive in GUI-only (none-checking) mode. 
  

 

Remote Windows Systems 

When you run Servers Alive as a service in Windows, using the System account with desktop 
interaction, you can perform checks. Consider the following example: The System account of 
host_1 has no rights to host_2; and you cannot assign rights to it. However, you can still check 
services, processes, or diskspace on the remote Windows system. To do this, you should 
specify a user name and password for each of the checks. 

If the host is part of a domain, you should include the domain name with the user name as in: 
domain_name\user_name. 

4. File Menu 
The File menu has many commands that help you manage your information: 

File - Open a new list of entries. 

Import Old Hostfile - Open a host file saved in earlier versions of Servers Alive. 

Print Tree - Preview and print a picture of entries in the Main window as shown on your 
computer screen. In the print preview window, click to zoom in to the view. 
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Save - Save your settings and list of entries. The Save command prompts you for a 
location and name to save the list of entries. Select a location and name that is easy to 
remember. 

Save As - Save your list of entries as a text file with a .txt extension. 

Exit - Close Servers Alive. 

Setup - Edit the global settings for Servers Alive. You can also click the Setup button in 
the Main window. 

Most Recently Used List - Displays the list of most recently used host files. 

If you want Servers Alive to load a listing by default, you can set that by clicking the File > 
Setup command and then entering the information on the Startup tab. 

 

In This Chapter 

File > Setup (Setup Dialog Box) 

4.1 File > Setup (Setup Dialog Box) 
The Setup dialog box allows you to enter global settings for Servers Alive with the following 
branches in the Setup tree: 

Alerts 

Logging 

Output 

General 

Built-in Servers 

Check Settings 

When you select a branch in the tree, different setup options appear on the right side of the 
dialog box. 
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In This Section 

Alerts (Setup Dialog Box) 

Logging (Setup Dialog Box) 

Output (Setup Dialog Box) 

General (Setup Dialog Box) 

Built-in Servers (Setup Dialog Box) 

 

4.1.1 Alerts (Setup Dialog Box) 
The Alerts section of the  tree specifies the alerts that are sent when a server malfunctions. 
When Servers Alive detects a down condition, it can respond with a wide array of notifications 
and alerts, depending on the settings that you choose, including the following: 

Sending an email using SMTP, indicating what server is down. 

Paging you with a numeric or alphanumeric warning. 

Executing a program. 

Playing a sound. 

Restarting an NT service. 

Mail alerting is one of the most common types of alerting used. Servers Alive supports two 
different methods of sending mail: SMTP and Other Mail. Usually, you should choose settings 
on the SMTP tree unless your mail server does not support SMTP or you have special mailing 
needs. In these cases, you should examine the Other Mail options in the tree. 

When you add an entry, you can enable the individual alert entry in the Main window by 
clicking its check box. You can disable the alert entry by clearing the check box. 

In This Section 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 
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SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

 

4.1.1.1 SMTP (Setup Dialog Box) 
Mail alerting is one of the most common types of alerting used. Servers Alive supports two 
different methods of sending mail:  and Other Mail. Usually, you should choose settings on the 
SMTP tree unless your mail server does not support SMTP or you have special mailing needs. 
In these cases, you should examine the Other Mail 

In This Section 

Primary (Setup Dialog Box) 

Alternate (Setup Dialog Box) 

See Also 

Alerts (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 
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4.1.1.1.1 Primary (Setup Dialog Box) 

 

Enable Primary SMTP Mail 

Enables this feature and allows you to enter values on the dialog box. If you do not click this 
box, the software sends mail through both the primary and alternate SMTP servers. 

Mail Host 

Enter the mail host as a NetBIOS name, DNS name or IP address; for example, HERMES, 
mail.domain.com, or 123.45.67.89. 

Send Direct 

Click this check box to send the alert message directly to the mail server that is responsible for 
the domain in the To box of the message. If you select DUN options and click the check box, 
Servers Alive sends the DNS request for the MX record before making the DUN connection. 
For more information about DUN options, see Advanced Settings for the SMTP Primary Mail: 
DUN and ESMTP 

When you click the Send Direct check box, with certain versions of the IPHLPAPI.DLL file, you 
must specify the DNS servers to use when querying for the MX records in the following registry 
key. If you do not specify the DNS servers, Servers Alive attempts to determine which DNS 
servers to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use_2 (string) 
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If the first DNS server does not respond correctly, the software uses the second DNS server, if 
specified, to get the MX record for the recipient domain. 

From 

Enter a name or a fully-qualified domain name; for example, serversalive@company.com. Your 
entries depend on the way your SMTP server is configured; most SMTP servers require a 
FROM name that looks like a valid email address, such as salive@domain.com. If you have 
trouble, please contact your mail server administrator for the appropriate settings. 

If you do not enter correct information in the From box, you might receive a message from the 
mail server indicating that relaying has been denied. 

Default To 

Enter an email address, such as person@company.com. To send the message to several email 
addresses, separate the addresses with a comma, as in the following example: 
user1@company.com,user2@company.com. 

Default Subject 

Enter the information that you want to appear in the Subject line of every SMTP alert message. 
The default message displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%t for the last check time. 

%u for the unique ID of the host. 
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%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Default Message 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Enter the message for the body of every SMTP alert message. You can enter multiple lines by 
pressing Shift + Enter on the keyboard. 

The default message displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can also use the parameters in the previous description. 

Priority of Mail 

Select one of several different levels of priority for sending the message. 

Send mails to multiple recipients as multiple mails 

When checked, Servers Alive uses one session per outgoing email. This is slower than sending 
all the emails in a single session. However, using a single session means that the entire batch 
is lost should the server reject a single recipient. 

Fall Back to Alternate When Primary Not Responding Correctly 

Check so that the alternate server is used only when the primary server is down or not 
responding correctly. 

Test It 

Sends a test message to the specified users. Remember to click the Apply button first; 
otherwise, Servers Alive uses the previous values for the test mail. Messages about the results 
of the test appear next to the Test It button. 

In This Section 

Advanced Settings for the SMTP Primary 
Mail: DUN and ESMTP 
Registry Settings for SMTP 

See Also 

SMTP (Setup Dialog Box) 

Alternate (Setup Dialog Box) 
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4.1.1.1.1.1 Advanced Settings for the SMTP Primary Mail: 
DUN and ESMTP 
Servers Alive also supports ESMTP, POP3 and CRAM-MD5 authentication. ESMTP 
authentication is limited to AUTH LOGIN, a clear text authentication method using a base-64-
encoded user name and password. 

 

Servers Alive uses your LAN (network) connection to send the mail to your SMTP server. 
Servers Alive can also do this using DUN (Dial Up Networking). 

Servers Alive sends SMTP mail through your usual LAN connection (__LAN__). You can, 
however, force Servers Alive to dial into a remote network before sending mail to an SMTP 
server. To do this, you first must configure the correct Dial-up Networking settings in Windows. 
You can then select them using the appropriate dropdown boxes on the DUN-SMTP branch of 
the tree. If you need to provide a user name, password, and domain to establish the 
connection, you can enter them in the appropriate text boxes. 

Many organizations do not allow standard SMTP connections for outgoing mail, as outside 
spammers use them to send unsolicited mail. Most have an option to use ESMTP, which forces 
a person to log in to the SMTP mail server before allowing that person to send any mail. If your 
company uses ESMTP, you must supply a use name and password combination for your 
primary and/or alternate mail settings to allow Servers Alive to send mail. 

For both the primary and the alternate SMTP configuration you can set the SSL Start Mode. 
When setting it to IMPLICIT the SSL negotiation will start immediately after the connection is 
established. When setting it to EXPLICIT, the connection will first be in plaintest and then 
explicitly start SSL negotiation through a protocol command such as STARTTLS. 
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To use this, select an authentication type in Use Authentication, and then type the user name 
and password. 

DUN Entry to Use 

DUN Entry to Use dropdown list. 

The DUN feature is available only if a dial-up network connection is installed on the computer 
running Servers Alive. See the online Help for Windows for more information on how to create 
a dial-up network connection. To use this feature effectively, Servers Alive must make the 
connection completely unattended. For that reason, you must configure the dial-up entry to 
save passwords. 

Username 

Enter the user name required to log in to the network. 

Password 

Enter the password required to log in to the network. 

Domain 

Enter the name of the domain. 

Use authentication 

Select to use ESMTP, POP3 or CRAM-MD5 authentication. You can also select to not use 
authentication. If you click ESMTP, this type of authentication is limited to AUTH LOGIN type, a 
clear text authentication method using a base-64-encoded user name and password. 

Username 

Enter the user name required for authentication. 

Password 

Enter the password required for authentication. 

POP3 Server 

Type the name of the POP3 server. 

Sender IP 

Specify the IP address to use for sending emails. This applies to systems with more than one 
IP address. The default is localhost. If using a DUN connection, select "DHCP" to use the IP 
assigned to the DUN adapter once the connection is actually made. 

SMTP Port 

If the mail server you want to use when sending mail is not using the default port (Port 25), you 
can change this by altering the “SMTP port” field. 
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Sender Threads 

Servers Alive is able to send mail in more than one thread. You can change the number of used 
threads via the “Sender Threads” field. 

See Also 

Primary (Setup Dialog Box) 

Registry Settings for SMTP 

 

4.1.1.1.1.2 Registry Settings for SMTP 
Ping Settings 

Before sending an e-mail, Servers Alive pings the SMTP server to see if it is responding. You 
can use the following SMTP\PingTimeout parameter to determine the amount of time Servers 
Alive should wait for a response (max. 32 sec). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\pingtimeout (dword) 

Servers Alive can send you an email every few minutes, based on the interval that you choose, 
to show that the software is still running. The mail is sent using the default settings of the 
primary SMTP server. When Servers Alive starts or stops checking, it can also send an email, 
using the settings of the primary SMTP server. Before sending email to an SMTP server, 
Servers Alive pings the server and only sends email to the server if it gets a response. If your 
server is not responding to pings, because a router or fire wall filters out the ICMP packages, 
the email is not sent. You can disable this ping-before-send feature to get around this. All email 
sent by Servers Alive is by default sent as URGENT email (high priority). 

By default, the keep-alive mailings are sent to the default primary Mailto parameter. This can be 
altered with the following registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\KeepAliveTo (string) 

SMTP Timeout 

Another parameter called SMTP\Timeout controls how long Servers Alive waits for the SMTP 
server to respond. The default is 15 seconds, and the maximum is 60 seconds. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\timeout (dword) 

If SMTP/ResolveAtStart equals 1, then Servers Alive attempts to resolve the SMTP, and 
alternate SMTP, server name to its IP address when Servers Alive starts and uses that from 
then on. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword) 1 or 0. 

If ExcludeDateTimeInMail is 1, the generated SMTP mailings do not include the last line (Mail 
generated by ... date/time). 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) 1 or 0 

Custom Mail Headers and Footers 

You can use the following keys to add custom headers to any SMTP mail Servers Alive sends: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateXHeader (string) 

You can use the following keys to add custom footers to any SMTP mail Servers Alive sends: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryFooter (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateFooter (string) 

You can use the following variables in the PrimaryFooter entry: 

{{time} hh:mm:ss format 

{date} dd:mm:yy format 

{sdate} dd:mm:yy format 

{stime} hh:mm format 

{saversion} Servers Alive version number 

{0d} Carriage return character 

{0a} New line character 

{25} Colon 

Custom Date and Time Formats 

You can specify a custom date and time format for the customer headers and footers in SMTP 
mail: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomDateFormat (string) 

{cdate} custom date format 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomTimeFormat (string) 

{ctime} custom time format 
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Create or Edit HELO/EHLO Commands 

The HELO/EHLO command is used to identify the client sender to the SMTP server. The 
sending server identifies itself and the receiving server accepts any given name, per request. 
EHLO is the Enhanced SMTP (ESMTP) version of HELO. To create or edit an HELO/EHLO 
command, you can edit the following registry entries: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryHELO (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateHELO (string) 

You can use the following variables in the entry. The default value is 5. 

A value of 0 uses the name of the SMTP server as defined in the Setup dialog box for the 
HELO/EHLO command. 

A value of 1 uses the name of the system that runs Servers Alive for the HELO/EHLO 
command. 

A value of 2 uses the domain name of the system running Servers Alive for the 
HELO/EHLO command. If no domain name is defined, Servers Alive uses 
NO.DOMAIN.NAME for the command. 

A value of 3 uses machinename.Domainname; for the HELO/EHLO command. If no 
domain name is defined, Servers Alive uses machinename.NO.DOMAIN.NAME. 

A value of 4 uses the IP address of the system running Servers Alive for the command. 

A value of 5, the default, uses the machinename.domainname for the command. If no 
domain name is added, Servers Alive uses the IP address for the command. 

If no numeric value is used, Servers Alive uses whatever string is defined for the HELO/EHLO 
command. 

Size of Body Text 

You can limit the size of the body text by editing the following registry entries. This value does 
not count the size of the additional footers or the "main generated" section. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_max_size (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_max_size (string) 

 See Also 

Primary (Setup Dialog Box) 

Advanced Settings for the SMTP Primary Mail: DUN and ESMTP 
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4.1.1.1.2 Alternate (Setup Dialog Box) 

 

Enable Alternate SMTP Mail 

Enables this feature and allows you to enter values on the dialog box. If you do not click this 
box, the software sends mail through both the primary and alternate SMTP servers. 

Mail Host 

Enter the Mail Host as a NetBIOS name, DNS name or IP address; for example, HERMES, 
mail.domain.com, or 123.45.67.89. 

Send Direct 

To box of the message. 

When you click the Send Direct check box, with certain versions of the IPHLPAPI.DLL file, you 
must specify the DNS servers to use when querying for the MX records in the following registry 
key. If you do not specify the DNS servers, Servers Alive attempts to determine which DNS 
servers to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use_2 (string) 

If the first DNS server does not respond correctly, the software uses the second DNS server, if 
specified, to get the MX record for the recipient domain. 
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Enter a name or a fully-qualified domain name; for example, Servers 
Aliveserversalive@company.com. Your entries depend on the way your SMTP server is 
configured; most SMTP servers require a FROM name that looks like a valid email address, 
such as salive@domain.com. If you have trouble, please contact your mail server 
administrator for the appropriate settings. 

If you do not enter correct information in the From box, you might receive a message from the 
mail server indicating that relaying has been denied. 

Default To 

Enter an email address, such as person@company.com. To send the message to several 
email addresses, separate the addresses with a comma. For example, 
user1@company.com,user2@company.com. 

Default Subject 

Enter the information that you want to appear in the Subject line of every SMTP alert message. 
The default message displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 
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%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Default Message 

 (09) for a TAB. 

%o (letter o) gives a description of the actual check. 

Enter the message for the body of every SMTP alert message. You can enter multiple lines by 
pressing Shift + Enter on the keyboard. 

The default message displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can also use the variables described in the previous description. 

Priority of Mail 

Select one of several different levels of priority for sending the message. 

Send mails to multiple recipients as multiple mails 

When checked, Servers Alive uses one session per outgoing email. This is slower than sending 
all the emails in a single session. However, using a single session means that the entire batch 
is lost should the server reject a single recipient. 

Fall back to primary when alternate not responding correctly 

Check so that the primary server is used only when the alternate server is down or not 
responding correctly. 

Test It 

Sends a test message to the specified users. Remember to click the Apply button first; 
otherwise, Servers Alive uses the previous values for the test mail. Any error messages that 
result from the test display on the dialog box next to the Test It button. 

You can enter registry settings for SMTP. See Registry Settings for SMTP. 

In This Section 

Advanced Settings for SMTP Alternate 
Mail 

See Also 

SMTP (Setup Dialog Box) 

Primary (Setup Dialog Box) 
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4.1.1.1.2.1 Advanced Settings for SMTP Alternate Mail 
The advanced settings for the SMTP Alternate Mail are identical to the Advanced Settings for 
the SMTP Primary Mail. 

Servers Alive also supports ESMTP, POP3 and CRAM-MD5 authentication. ESMTP 
authentication is limited to AUTH LOGIN, a clear text authentication method using a base-64-
encoded user name and password. 

 

Servers Alive uses your LAN (network) connection to send the mail to your SMTP server. 
Servers Alive can also do this using DUN (Dial Up Networking). 

Servers Alive sends SMTP mail through your usual LAN connection (__LAN__). You can, 
however, force Servers Alive to dial into a remote network before sending mail to an SMTP 
server. To do this, you first must configure the correct Dial-up Networking settings in Windows. 
You can then select them using the appropriate dropdown boxes on the DUN-SMTP branch of 
the tree. If you need to provide a user name, password, and domain to establish the 
connection, you can enter them in the appropriate text boxes. 

Many organizations do not allow standard SMTP connections for outgoing mail, as outside 
spammers use them to send unsolicited mail. Most have an option to use ESMTP, which forces 
a person to log in to the SMTP mail server before allowing that person to send any mail. If your 
company uses ESMTP, you must supply a use name and password combination for your 
primary and/or alternate mail settings to allow Servers Alive to send mail. 

For both the primary and the alternate SMTP configuration you can set the SSL Start Mode. 
When setting it to IMPLICIT the SSL negotiation will start immediately after the connection is 
established. When setting it to EXPLICIT, the connection will first be in plaintest and then 
explicitly start SSL negotiation through a protocol command such as STARTTLS. 
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For both the primary and the alternate SMTP configuration you can set the SSL Start Mode. 
When setting it to IMPLICIT the SSL negotiation will start immediately after the connection is 
established. When setting it to EXPLICIT, the connection will first be in plaintest and then 
explicitly start SSL negotiation through a protocol command such as STARTTLS. 

To use this, select an authentication type in Use Authentication, and then type the user name 
and password. 

Select whether to use the local area network or dial-up network. By default, Servers Alive 
connects to the host using the normal LAN connection (__LAN__). Additionally, Servers Alive 
can also create a dial-up network (DUN) connection to an external network before completing 
the check. After the check, Servers Alive disconnects from the external network. If you have 
created dial-up network connections on your computer, those connections appear on the DUN 
Entry to Use dropdown list. 

The DUN feature is available only if a dial-up network connection is installed on the computer 
running Servers Alive. See the online Help for Windows for more information on how to create 
a dial-up network connection. To use this feature effectively, Servers Alive must make the 
connection completely unattended. For that reason, you must configure the dial-up entry to 
save passwords. 

Username 

Enter the user name required to log in to the network. 

Password 

Enter the password required to log in to the network. 

Domain 

Enter the name of the domain. 

Use authentication 

Select to use ESMTP, POP3 or CRAM-MD5 authentication. You can also select to not use 
authentication. If you click ESMTP, this type of authentication is limited to AUTH LOGIN type, a 
clear text authentication method using a base-64-encoded user name and password. 

Username 

Enter the user name required for authentication. 

Password 

Enter the password required for authentication. 

POP3 Server 

Type the name of the POP3 server. 

Sender IP 

Specify the IP address to use for sending emails. This applies to systems with more than one 
IP address. The default is localhost. If using a DUN connection, select "DHCP" to use the IP 
assigned to the DUN adapter once the connection is actually made. 
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SMTP Port 

If the mail server you want to use when sending mail is not using the default port (Port 25), you 
can change this by altering the “SMTP port” field. 

Sender Threads 

Servers Alive is able to send mail in more then one thread. You can change the number of used 
threads via the “Sender Threads” field. 

See Also 

Alternate (Setup Dialog Box) 

4.1.1.2 SLACK (Setup Dialog Box) 
You need to generate an integration URL - via the settings of the "company". 

 

Select CONFIGURE INTEGRATIONS, then within the DIY INTEGRATIONS & 
CUSTOMIZATIONS screen select INCOMING WEBHOOKS 
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Configure with the info you want it to have. The WebhookURL will be shown as in the image 
below: 

 

The Slack alert is not created by, affiliated with, or supported by Slack Technologies, Inc. 
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In This Section 

Primary (Setup Dialog Box) 

Alternate (Setup Dialog Box) 

See Also 

Alerts (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

4.1.1.3 Numeric Paging (Setup Dialog Box) 

 

You must install a modem in Windows to use this feature. 
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You must enable paging on a host-by-host basis. By default, you are not paged by any hosts 
when a DOWN condition is detected. Because numeric paging is not based on a standard 
protocol, numeric paging is not as reliable as alphanumeric paging. 

Enable Pager 

Enables Servers Alive to send you alerts through an attached modem to a numeric pager. 

Phone Number 

Specify a phone number of your numeric pager to which Servers Alive can send a message. 

 

End Message Indicator 

After a numeric message has been entered, specify an end-of-message indicator. Generally 
paging providers use # as the indicator. 

Wait String 

Specifies the wait time for Servers Alive. In most cases, after dialing the phone number of your 
pager, Servers Alive must wait several seconds before sending out the numeric information. 
You can enter a time in the Wait box as a number of commas. Every "," represents about 2 
seconds. 

Add 0 When Down and 1 When Back Up to Host-id 

Check this option to receive extended information on your page. Servers Alive adds a -0 for a 
down host to the host ID and a -1 for an up host to the host ID. Numeric paging is unreliable 
because it is not based on any standard protocol. 

The message that you get on your pager displays a number. This number is the Host ID, which 
you can change when creating or editing a host. 

If you select the Add 0 When Down and 1 When Back Up to Host-id option, Servers Alive 
sends a "-" (dash) between the host ID and the 0/1 (down/up). You can change this if you add 
or edit the following registry value: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU ConsultingWOW6432Node\Servers 
Alive\Pager\Separatorstring (string) 

Port to Use 

Specifies the COM port to which your modem is attached. In most cases, you can enter TAPI.   
When using TAPI, Servers Alive uses only the TAPI modem that you installed first. 

Test It 

Tests the pager. Remember to click the Apply button first, or Servers Alive uses the previous 
settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
button. 

[39] 
 



Servers Alive 8 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

4.1.1.4 Alpha Paging - SMS (Setup Dialog Box) 
The alpha paging feature sends a text-based message to a cell phone or paging device. You 
must install a modem in Windows to use alpha paging. Note that Servers Alive also supports 
GSM modems using the AT+C protocol. 
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One of the most common methods of alerting is alphanumeric paging, which sends a text-
based message to a cell phone or pager device. You can send small alerts to your 
alphanumeric pager detailing exactly which server is down, often with collaborating information. 
To do this, you must provide a modem device that allows you to send alphanumeric pages. The 
actual paged device or number is added on a host-by-host basis. 

Enable Alpha Paging and SMS Messaging 

To turn on this feature, click the Enable Alpha Paging & SMS Messaging box. 

Devices 

Configure the device that Servers Alive uses to send the message. Click the Devices list to 
choose a modem. This drop down box displays any modems that you have installed in 
Windows. 

Comm Settings 

Enter the communication settings in the Comm Settings box. Contact your paging/SMS 
provider for these settings, along with the protocol and SMSC. 

In general, you can try entering 7E1, 7N1, or 8N1. Woodstone bvba maintains an informal list 
with settings reported by users of Servers Alive for providers around the world. You can find 
this list at the Woodstone web site. Woodstone bvba takes no responsibility for the accuracy of 
the supplied information. 

Baud rate 

Choose a setting that is appropriate for your service provider. 

Devices 

SMSC No 

Enter the phone number for the modem of your service provider. You can enter an international 
format as +1 bbccccccc, such as +1 812123456. 

When using an international format, make sure that you include the space between the country 
number and the rest of the number. In the previous example, +1 is the country number. You 
must also set the country and area code correctly in the software that comes with your modem. 

When using the AT+C protocol for GSM modems, you do not need to provide an SMSC 
number. Servers Alive uses the settings of the attached GSM modem. You must configure 
your modem to send SMS messages. 

Protocol to Use 

Select the protocol used by your provider. This is either TAP, AT+C, or UCP. 

UCP Operation 

If your provider uses UCP, you must also specify settings for the UCP Operation box. 

You can view the list at the pager settings page at the Woodstone web site, but the information 
might not be listed for your provider or contain up-to-date settings. Please contact your provider 
for the correct information. 
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Message 

In the Message section, you must provide authentication information. This information is 
available from your provider and is required in order to send a message. 

Sender 

Enter the name of the sender for authentication purposes. In most cases, this can be left blank. 

Legitimization Code 

Enter the code, if required by your provider. 

Authentication Code 

Enter the authentication, if required by your provider. 

Send Multiple Messages Per Call 

Allows the software to send multiple messages per call. 

Max. Number of Messages per Call 

Specifies the maximum number of messages allowed. 

Format 

Enter ALPHA NUMERIC, in most cases. 

Receipt Type 

Enter GSM, in most cases. 

Test It 

Tests the settings to receive a test page. Remember to click the Apply button first, or Servers 
Alive uses the previous settings. 

Sending SMS Messages 

Note that, in some rare cases, the SMS message must be sent twice before it is received. To 
enable this feature, you must add or edit the following registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\DoubleMessage (dword) 1 or 0 

By default, the SMS feature tries to send the message twice, using one re-dial. You can change 
the number of re-dials to a maximum of ten re-dials by editing the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxRedials 

Most SMS providers limit the number of characters within a message. Servers Alive provides a 
default limit of 160 characters. You can change this limit in Servers Alive by editing the 
following registry entries: 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxMessageSize (string) 

Enter a number to define the maximum size of the message. 160 characters is the default 
if you do not edit this registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\SplitLongMessage (string) 

If you enter a value of 1, Servers Alive splits messages that exceed the number of 
characters that you enter in the MaxMessageSize registry entry. If you enter a value of 0, 
Servers Alive truncates the message at the number of characters that you enter in the 
MaxMessageSize entry. Any characters after that point are not sent. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 
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4.1.1.5 Audio (Setup Dialog Box) 

 

If you have the Servers Alive monitoring server near your operations staff, you can use audible 
alerts to tell them that something is down. 

Enable Audio Alarm 

If you want Servers Alive to warn you of a failure with a sound, click the Enable Audio Alarm 
box. If no WAV-capable device is available, you cannot check the Enable Audio Alarm check 
box. However, you can still use sounds as alarms by enabling the Beep via Speaker option. 

File to Play 

Select a WAV file on the computer. The file name you enter is the default that Servers Alive 
uses. You can set a different file name for every host. 

Beep Via the Speaker 

Select this if you do not have a device on your computer that is capable of playing WAV files. 

Test It 

Tests the settings. You should receive a test page. Remember to click the Apply button first, or 
Servers Alive uses the previous settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

Registry Settings for Sounds 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartSound (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\\StopSound (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAliveSound (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\\KeepAliveSoundMinutes (dword) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\\KeepAlivewithSound (dword) 1 to enable 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 
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4.1.1.6 SNMP Trap Sending (Setup Dialog Box) 

 

SNMP Trap 

Enables this feature and allows you to enter settings on the dialog box. For setting the 
SPECIFIC TRAP value, see HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\Servers Alive\SNMPTrap\SpecificType (string) IP, see 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\Localhost (string) 

Receiver 

Indicates the name of the destination host. 

 

 

Port 

Indicates the destination port for sending traps. The default standard port number is 161. 
However, for security purposes, you can enter a different, non-standard port number. 

Community 

Enter a community string to use in the traps that the software sends. The default string is 
public. 

Sender OID 

Controls which varbinds to include in the trap; all varbinds are included by default. This option is 
not available when you select SNMPV2SNMP Version list. 
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SNMP traps can only include a IP or OID within the Header when for SNMP Version 1 traps. 

An OID is a dotted numeric string that identifies an object. Typical objects that can be identified 
using OIDs include: attributes in X.500/LDAP-based directories, certificate policies and practice 
statements, MIBS for network management, and encryption algorithms. Two objects are 
considered to be the same only if they have the exact same OID. 

Sender IP 

Specifies the destination host name or IP address for sending traps. This option is not available 
when you select SNMPV2 on the SNMP Version list. To send the trap to two otherwise 
identical hosts, enter two IPs separated by a comma. 

SNMP Version 

Select from either SNMP Version 1 or Version 2. 

Log Trap Sending to Logfile 

Writes the event to a file. 

Test It 

Tests the settings. Remember to click the Apply button first, or Servers Alive uses the previous 
settings. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 
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4.1.1.7 Other Mail (Setup Dialog Box) 

 

Servers Alive can natively send mail using an SMTP server. If you are not using an SMTP 
server, Servers Alive can still send mail using your mail server, if you define a command line 
mailer for your mail system. 

Send Other Mail 

Enable Other Mail 

Click the check box to allow Servers Alive to send mail using the command line mailer you 
specify. 

Command Line 

Defines the command line that the software uses. You can define an alert for each entry that 
sends a message using these settings. The entry has its own message. In the command line, 
you enter the command that Servers Alive issues when sending mail with your command line 
mailer. Within the command line, the %m is replaced with the actual message that Servers 
Alive generates. 

Test It 

Tests the settings. You should receive a test message. Remember to click the Apply button 
first, or Servers Alive uses the previous settings. 

Registry Settings for Verifying Messages 

You can modify the message that Servers Alive sends by adding or editing the following 
registry value: 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\OtherMail\OtherMessage (string) 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

 {09} for a TAB. 

%o (letter o) gives a description of the actual check. 

If you want to force the case of the message to uppercase or lowercase only, you must add or 
edit the following registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Othermail\ForceCase (string) U or L 

See Also 
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Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 
SNMP Trap Sending (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 
XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

 

4.1.1.8 MSN Messenger (Setup Dialog Box) 
Note: This feature will be removed in the next version of Servers Alive. 

To use MSN® Messenger, you must install the high encryption pack from Microsoft. To ensure 
that you have installed the pack, click Help > About Internet Explorer in Internet Explorer. The 
About box should display Cipher Bits as 128 bits or higher. 

This feature works only with TCP protocol, not UDP or HTTP. No proxy support is provided. 
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In order to send a Microsoft Network (MSN) message, Servers Alive must log on to the MSN 
network. Because an MSN user can have only one concurrent log-in, you should use a 
different user account for sending the MSN alerts than the user account that you use to receive 
the alerts. 

If sending an MSN alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. For more information, see Failure Settings. 

Enable MSN® 

Click this check box to send messages over the Microsoft Network (MSN) messenger service 
and enter information on the dialog box. 

From (MSN Username) 

Enter the name for your MSN account. 

From (MSN Password) 

Enter the password for your MSN account. 

Default To 

Enter the default name to appear in the To line of the message. 

Default Message 

Enter text that you want to appear in the message each time it is sent. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 
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%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Test It - Tests the settings. You should receive a test message. 
Remember to click the Apply button first, or Servers Alive uses the previous settings. 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 
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Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 
SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 
NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

 

4.1.1.9 XMPP (Jabber) (Setup Dialog Box) 

 

When using Google Talk, you can enter the following settings in the dialog box: 

XMPP Host: talk.google.com 

Port: 5222 

SSL Mode: Explicit 

Auth. Mech. SASL/PLAIN 

Enable XMPP (Jabber) 
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Click this check box to send messages XMPP, or Jabber, and enter information on the dialog 
box. 

XMPP Host 

Enter the name of the XMPP host. 

Port 

Enter the port number that you want to use. The default is 0. 

SSL Mode 

Select Automatic, Implicit, Explicit, or None. 

Automatic enables Servers Alive to detect the SSL mode of the server. 

Explicit uses an explicit command, such as AUTH SSL or AUTH TLS, to ask a server to 
initiate a secure control connection. The server must support AUTH, PBSZ, and other types 
of commands. Explicit SSL takes place on the port and is initiated usually right before the 
system sends the login information. 

Implicit uses an SSL socket to connect to the server. Most servers support the Implicit 
mode. Implicit SSL takes place on a dedicated port and occurs before data is transmitted 
between the server and client. 

Auth. Mech. 

Plain, SASL/Plain, or Digest. SASL/Plain allows encrypted connections. Digest 

Username 

Enter the user name to send the message. 

Password 

Enter the password for the XMPP account. 

Default Recipient 

Type the name of the email address where you want to receive alert messages. 

Default Message 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 
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%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Include XMPP debug messages in logfile. Enable to add XMPP debug 
information to the logfile. 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Note: For all % parameters, include XMPP debug messages in logfile. Enable to add XMPP 
debug information to the logfile. 

...messages send since last resent 

Counter showing how many messages were sent since the last reset. (To reset, click the Reset 
button.) 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 
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SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

4.1.1.10 SNPP (Network Paging) (Setup Dialog 
Box) 

 

If sending an SNPP alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. For more information, see Failure Settings. 

Enable SNPP 

Allows you to send messages over the Simple Network Paging Protocol (SNPP). Click the 
check box to enable the feature and enter values on the dialog box. 

The SNPP sender can work with SNPP gateways that need authentication. You will have to 
create a custom command within the registry as follows: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNPP\CustomCommand (string) with value LOGI username password. 

SNPP Host 

Enter the name of the host. 
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Port 

Enter the port that you want to use. 

Connection 

Click to select the level of the connection that you prefer. Level Two allows you to enter 
information about caller ID in the Caller ID box. 

Caller ID 

Enter the caller ID of your SNPP account. 

Timeout 

Enter the time that you want Servers Alive to keep trying to send you a message. 

Default Pager ID 

Enter the pager ID. 

Default Message 

Enter the text that you want to appear in the body of the message. The default message 
displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 
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%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Test It 

Tests the settings. You should receive a test message. Remember to click the Apply button 
first, or Servers Alive uses the previous settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

In This Section 

Failure Settings 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box)  

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 
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4.1.1.10.1 Failure Settings 

 

To display these settings, click the Setup button and then, in the tree, click Alerts > SNPP 
(Network Paging). 

You can then click Failure Settings. 

Use DUN Connection When LAN Connection Fails 

Click the check box to allow Servers Alive to use the DUN connection when network paging 
connection fails. 

DUN Entry to Use 

Select the current DUN entry or _LAN_. If you have created dial-up network connections on 
your computer, those connections appear on the dropdown list. 

The DUN feature is available only if a dial-up network connection is installed on the computer 
running Servers Alive. See the online Help for Windows for more information on how to create 
a dial-up network connection. To use this feature effectively, Servers Alive must make the 
connection completely unattended. For that reason, you must configure the dial-up entry to 
save passwords. 

Username 

Enter the user name. 

Password 
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Enter the user password. 

Domain 

Enter the domain. 

See Also 

SNPP (Network Paging) (Setup Dialog 
Box) 

4.1.1.11 SMPP (Network Paging) (Setup Dialog 
Box) 

 

If sending an SMPP alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. For more information, see Failure Settings. 

Enable SMPP 

Allows you to send messages over the Short Message Peer to Peer (SMPP) protocol. Click the 
check box to enable the feature and enter values on the dialog box. 

SMPP Host 

Enter the name of the host. 

Port 

Enter the port that you want to use. This option specifies the TCP/IP port on the SMPP server 
that the gateway should connect to. 
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Encoding Schema 

Select from a list of options for encoding the message including: SMSC Default, IA 5 ASCII, 
Cyrillic, 8 bit binary B, and so forth. 

System Type 

Specifies an optional parameter for logging in. This parameter should be set only if required by 
the SMPP server. The system administrator provides this value, which is usually a short text 
string. 

System ID 

Enter the user name, or system ID, for the gateway to use when connecting to the SMPP 
server. 

Password 

Indicates the password for the gateway to use when connecting to the SMPP server. 

Many SMPP SMSC providers require specific parameters for SMPP. Servers Alive uses 
automatic defaults for the TON and NPI values that work for most SMPP connections. For 
more information about the parameters you should use, contact your SMPP provider. 

Bind TON 

Select from several options including Unknown, International, National, Net Specific, and so 
forth. 

Bind NPI 

Select from several options including ISDN, Data, Telex, and so forth. 

If one of the following options is set, the values are used in place of the automatic values 
determined by the software: SSource TON, SDestination TON, SSource NPI, SDestination 
NPI. 

SSource TON 

Applies to the sender address that is associated with messages that are submitted to the 
SMSC. Select from several options including Unknown, International, National, Net Specific, 
and so forth. 

Servers Alive automatically sets the SSource TON to 1 if the sender address is in international 
format, or, rather, starts with a + character. If the sender address is not in international format, 
Servers Alive sets the SSource TON to 0. The software sets the SSource NPI to 1 in both 
cases. If the sender address contains alphabetic characters and is not a valid phone number, 
the software sets the SSource TON to 5 and the SSource NPI to 0. 

SSource NPI 

Applies to the sender address that is associated with messages that are submitted to the 
SMSC. Select from several options including: ISDN, Data, Telex, 
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SDestination TON 

Applies to the receiver addresses for messages that are submitted to the SMSC. Select from 
several options including Unknown, International, National, Net Specific, and so forth. 

SDestination NPI 

Applies to the receiver addresses for messages that are submitted to the SMSC. Select from 
several options including ISDN, Data, Telex, and so forth. 

From 

Enter a name or a fully-qualified domain name; for example, Servers Alive or 
serversalive@company.com. Your entries depend on the way your SMPP server is 
configured; most SMPP servers require a FROM name that looks like a valid email address, 
such as salive@domain.com. If you have trouble, please contact your mail server administrator 
for the appropriate settings. 

Test It 

Tests the settings. You should receive a test message. Remember to click the Apply 

Default To 

Enter the default name to appear in the To line of the message. 

Message 

Enter the text that you want to appear in the body of the message. The default message 
displays the following tokens: 

%p for the pretty name. 

%s for the status. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 
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%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

%{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

Don't Use MULTI for Sending to Multiple Recipients 

Select this check box if your host provider does not support the MULTI option. The SMPP alert 
uses the MULTI option by default when sending an alert to several recipients. 

Include SMPP Debug Messages in the Log File 

Set this option to include information about SMPP errors in the log file. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 
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Add/Edit Executive Alert Dialog Box  

Twitter (Setup Dialog Box) 

4.1.1.12 NotePage - PageGate (Setup Dialog Box) 
To use PageGate and the protocols that it supports, including SNPP, WCTP, and SMTP, 
download and install it from the NotePage web site. 

PageGate is 3rd party software from NotePage, Inc. 

 

Enable NotePager - PageGate 

Allows you to send messages using PageGate. Click the check box to enable the feature and 
enter values on the dialog box. 

Default To 

Enter the default name to appear in the To line of the message. 

Default Message 

Enter text for the body of the message. This is the default text for the alert message. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 
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%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 
 
{25} for a : (colon).Path to Save to. Enter the directory path to save the message to. 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

Test It 

Tests the settings. You should receive a test message. Remember to click the Apply button 
first, or Servers Alive uses the previous settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box)  
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Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box)  

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

Twitter (Setup Dialog Box) 

4.1.1.13 Executive Alerts (Setup Dialog Box) 
The Executive Alerts branch of the Setup dialog box allows you to create a schedule of when 
certain alerts are sent based on the criteria you select. These criteria include checking certain 
categories of entries, such as all the entries or entries in a certain group, or a certain 
percentage of a category. You can also select the type of protocol, such as SMTP, and 
condition of the server, such as down or in maintenance. 

When you click the Add or  button, the Add/Edit Executive Alert dialog box appears. 

In This Section 

Add/Edit Executive Alert Dialog Box 
4.1.1.12.1) 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 
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Twitter (Setup Dialog Box) 

4.1.1.13.1 Add/Edit Executive Alert Dialog Box 
You can display this dialog box when you click the Add or Edit button on the Executive Alerts 
branch of the Alerts Setup dialog box. 

 

The options of the What tab of the Add/Edit Executive Alert dialog box are different, 
depending on the option you select when you click the Add button. The following list shows the 
different settings that appear on the What tab for each option: 

What Tab: Send SMTP Mail (Primary) 

What Tab: Send SMTP Mail (Alternate) 

What Tab: Send Other Mail 

What Tab: Alpha Page/SMS 

What Tab: Send Network Page (SNPP) 

What Tab: Send Network Page (SMPP) 

What Tab: Generic NotePager-PageGate Message File 

What Tab: Numeric Page 

What Tab: Execute Command 
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What Tab: Sound 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message 

What Tab: Send WinPOPUP Message 

What Tab: Send SNMP Trap 

What Tab: Do an SNMP SET 

The dialog box also displays the following tab: 

Executive When Tab 

In This Section 

Executive When Tab (Add/Edit Executive Alert 
Dialog Box) 

See Also 

Executive Alerts (Setup Dialog Box)  

4.1.1.13.1.1 Executive When Tab (Add/Edit Executive Alert 
Dialog Box) 

 

Select one of the following options and enter the appropriate information for when you want to 
receive an alert. 

An Entry of ______ 
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Select an option to determine the type of entry that sends an alert when the alert check 
encounters the conditions that you enter. 

If you select All, then the executive alert is sent when all entries meet the criteria you enter 
in the boxes. All entries are included in the conditions. 

If you select Check Type, you can click the protocol you want in the dropdown list that 
appears. The executive alert is sent when all entries of a certain type of check protocol 
meet the criteria you enter in the boxes. 

If you select Group, you can click a group of entries that you have created from the 
dropdown list. The executive alert is sent when all entries in the group meet the criteria you 
enter in the boxes. 

If you select Level, you can select a numeric value for all entries that are that number of 
levels deep in the tree in the main window. For example, if you select 9 on the list, Servers 
Alive checks 9 levels deep in the tree. 

Is _____ for More than ________ Minutes 

Specify the condition and minimum number of minutes that the condition exists for the entry 
that you want an alert for: 

Down 

Possible Down 

Unavailable 

Maintenance 

Up 

Unchecked 

Possibly Available 

For example, you can enter the following conditions to send an alert when all entries are down 
for at least 30 minutes: 

An Entry of __All____ 

Is __Down___ for More than ___30_____ Minutes 

More than ________ % of _________ 

Enter a percentage of the number of entries to check a condition for. This is the percentage of 
servers in the selected category that meet the conditions you enter in the Is box. 

If you select All Entries, then the executive alert is sent when all entries meet the criteria 
you enter in the boxes. 

If you select All Entries of Check Type, you can click the protocol you want in the 
dropdown list that appears. The executive alert is sent when all entries of a certain type of 
check protocol meet the criteria you enter in the boxes. 
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If you select All Entries of Group, you can click a group that you have created from the 
dropdown list that appears. The executive alert is sent when all entries in the group meet 
the criteria you enter in the boxes. 

Are _________ 

Specify the condition to check before sending the alert message: 

Down 

Possible Down 

Unavailable 

Maintenance 

Up 

Unchecked 

Possibly Available 

For example, to check send an alert when 50% of all entries are in maintenance mode, you can 
enter the following: 

More than __50______ % of _________ 

Are ___Maintenance______ 

Approximately at 

Specify a daily executive alert at approximately this time. The alert body will include a summary 
even if none of the criteria are met. 

See Also 

Add/Edit Executive Alert Dialog Box 

4.1.1.14 Twitter (Setup Dialog Box) 
Allows you to send an alert to a twitter account. 
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Enter the login details for the twitter account (login and password). 

Default Message 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the error 
message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is not 
known, the host name is used. (For an HTTP check via a proxy-server it will contain the IP 
address of the proxy-server) 
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%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

If you defined a proxyserver via the SETUP-GENERAL-PROXY SETTINGS, then you can 
select what proxy to use when sending the Twitter messages. 

 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box)  

Executive Alerts (Setup Dialog Box) 

4.1.2 Logging (Setup Dialog Box) 
The two different editions of Servers Alive provide slightly different logging capabilities: 

The Standard edition accepts 1000 entries. 

The Enterprise edition accepts 5000 entries and provides logging capabilities to an ODBC-
compliant database. The Enterprise edition also offers RRD Tools (Round Robin Database) 
for processing and displaying logs. 
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In This Section 

Logfile (Setup Dialog Box) 

Syslog (Setup Dialog Box) 

Statistical Logging (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools > 
General) 

4.1.2.1 Logfile (Setup Dialog Box) 
For more information about logging to a file or to a database, see one of the following sections. 

In This Section 

To File (Logfile) (Setup Dialog Box) 

To Database (Logfile) (Setup Dialog Box) 

See Also 

Logging (Setup Dialog Box) 

Syslog (Setup Dialog Box) 

Statistical Logging (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools >General) 
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4.1.2.1.1 To File (Logfile) (Setup Dialog Box) 

 

Enable File Logging 

Click the check box to enable Servers Alive to log all its activities to a log file. 

Log File 

Fixed Name 

Select this box and enter the name of the log file, if you want Servers Alive to log events to a 
fixed log file. All new logging is appended to the end of the file. 

Automatically Change the Name Every Month 

Click this option to allow Servers Alive to rotate your log file every month. The file is written to 
the Servers Alive product directory. 

Automatically Change the Name Every Day 

Click this option to allow Servers Alive to rotate your log file every day. The file is written to the 
Servers Alive product directory. 

Automatically Change the Name Every Hour 

Click this option to allow Servers Alive to rotate your log file every hour. The file is written to the 
Servers Alive product directory. 

Log Options 

Advanced Options 

Path Used for Auto-Generated Logfiles 

[74] 
 



Servers Alive 8 

Enter the path that you want for the log file that is automatically generated. By default, Servers 
Alive saves the log file, except for the fixed name log, in the same directory as Servers Alive. 
You can change this by entering the path that you want in the box. 

Username 

Enter the user name for the log file. 

Password 

Enter the password for the log file. 

Registry Settings for Saving a Retrieved Web Page in the Log File 

When performing a URL check with a "contains" clause, Servers Alive saves 150 bytes (by 
default) of the retrieved web page in the log file. You can change how much is saved or 
changed by adding or editing the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\HTTPBytesinLog (string) 

A value of -1 means the full web page. Use this with care because your log filewill grow very 
fast. A value of 0 defaults back to 150 bytes. 

If you want to safeguard the Servers Alive logs against missing data due to power failures or 
critical operating system errors, you can request that Servers Alive close the log file each time 
the software writes to the log file with the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\CloseEachTime (dword) 

  

See Also 

Logfile (Setup Dialog Box) 

To Database (Logfile) (Setup Dialog Box) 
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4.1.2.1.2 To Database (Logfile) (Setup Dialog Box) 

 

This feature is available only in the Enterprise edition and free version of Servers Alive. It is not 
available in the Standard edition. 

Enable Database Logging 

Click the check box to enable this option. 

ODBC Connection String 

Enter the connection string for the Open Database Connectivity (ODBC) database. Click the 
browse button to open the Create Database Connection String dialog box and select a data 
source. The browse button is not available until you click the Enable Database Logging check 
box. 

You can also use UDL files for database logging. Because UDL files use OLEDB providers, the 
files use memory more efficiently than ODBC drivers. To create a UDL file, open Notepad and 
save an empty file as <your_filename>.UDL. Double-click the .UDL file to open the Data Link 
Properties dialog box and configure the UDL connection. To use the file, enter the path to the 
UDL file as a connection string in the ODBC Connection String box. 

Table 

Enter the name of the table for the database that you want to send information to. 

Enter this name before you click the Create Table button. 
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Create Table 

Click this button to create the database. 

Registry Settings for Date and Time Format 

You can define the date and time format for the database logging by specifying the following 
registry entry keys. When the registry keys are empty, the date and time format of the operating 
system are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\db_DateFormat 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\db_Timeformat 

In This Section 

Create Database Connection String 
Dialog Box 

See Also 

Logfile (Setup Dialog Box) 

To File (Logfile) (Setup Dialog Box) 

 

4.1.2.1.2.1 Create Database Connection String Dialog Box 

 

List of Data Sources Available 

Name 

Lists the type of databases available on your computer. 

Driver 

Lists the application drivers used to create the corresponding database. 
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Username 

Enter the user name for logging in to the database. 

Use "DSN=" Syntax 

Click this check box to create a connection string in the following syntax: 

oConn.Open "DSN=mySystemDSN;" &"Uid=myUsername;" & "Pwd=myPassword" 

Password 

Enter the password used to log in to the database. 

See Also 

To Database (Logfile) (Setup Dialog Box) 

 

4.1.2.2 Syslog (Setup Dialog Box) 

 

Syslog is a standard method of centralizing various logs. You can use a syslog server to store 
your Servers Alive logs in a remote location for later perusal or long-term storage. If you want to 
use the Syslog feature, there are various freeware syslog servers on the Internet. Syslog is an 
established standard so Servers Alive works with any syslog servers. 

For a Windows based syslog server, we recommend Kiwi Syslog Daemon, available from 
www.kiwisyslog.com. 
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You must enable syslog logging for each particular entry that you want to log. It is not turned on 
for every entry by default. You should determine if you want to use this service before adding 
many entries so that you can turn it on as needed as you add entries. 

Enable Syslog 

Click to enable this feature and enter information on the dialog box. 

Syslog Host (Name or IP) 

Enter an IP address for your server. 

Port 

Enter the port for your server. The port number is usually 514 unless you are using a non-
default port number on your syslog server. When you have entered the server and port, click 
the Apply button and then the Test It button. You can check the logs on your syslog server to 
verify that the server is correctly logging events from Servers Alive. 

Priority to Use When Entry Is 

Specifies which entries are logged and how often they are logged. 

Down 

Specifies how to log an entry when the server is down. You can choose from Emergency, 
Error, Alert, Critical, Warning, Info, Notice, and Debug. 

Up 

Specifies how to log an entry when the server is up. 

Maintenance 

Specifies how to log an entry when the server is in maintenance mode. 

Unavailable 

Specifies how to log an entry when the server is unavailable. 

When to Send 

Always 

Specifies that the log message should be sent on every check cycle. 

Status Change 

Specifies to send the log message only when the log status changes. 

Options 

Include RFC header 

Adds RFC compliancy. This RFC compliant header adds information to the message, such as 
date stamp of send, or who sent the message, and the name of the process that sent the 
message. 
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Use TCP 

Sends the syslog message with TCP to the remote syslog server, usually on port 1468. 

Test It 

Click to verify your settings. After you have entered the server and port, click the Apply button 
and then the Test It button. You can check the logs on your syslog server to verify that the 
server is correctly logging events from Servers Alive. 

Registry Settings for Process Name 

By default, the syslog messages sent by Servers Alive include the process name "Servers 
Alive". You can remove this by adding or editing the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SYSLog\WithoutProcess (dword) 

Value of 1 

See Also 

Logging (Setup Dialog Box) 

Logfile (Setup Dialog Box) 

Statistical Logging (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools > 
General) 

 

4.1.2.3 Statistical Logging (Setup Dialog Box) 
Servers Alive only writes entries to the statistical log when an entry changes state; for example, 
when an entry goes from up to down. 

You can choose to export a statistical log file to either a file or, in the Enterprise edition, a 
database. You can set options to write the log to a file or a database. 

Statistical logging is created only at the end of a check cycle. When you perform a manual 
check, the data is not written to the log. Thus, in the Main window, when you select an entry 
and right-click, you can select Check Entry Now on the shortcut menu. If a change of state 
occurs, no data is written to the database. The new status of the entry is not recorded to the 
log. 

In This Section 

To File (Statistical Logging) (Setup Dialog Box) 

To Database (Statistical Logging) (Setup Dialog 

See Also 

Logging (Setup Dialog Box) 

Logfile (Setup Dialog Box) 
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Box) Syslog (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 

RRD Tools (Round Robin Database) (Setup 
Dialog Box > RRD Tools > General) 

 

4.1.2.3.1 To File (Statistical Logging) (Setup Dialog Box) 

 

You can export a statistical logging file in Servers Alive. The format of the log file is as follows: 
<prettyname>,<UID>,<current status>,<previous status>, <current date>, <current time>, <date 
of previous status change>, <time of previous status change>, <time difference between 
previous and current in minutes> 

The values for the status are as follows: 

Down = 1 
POSDOWN = 2 
Unavailable = 3 
Maintenance = 4 
Up = 5 
Unchecked = 6 
POSUNAVAILABLE = 7 

The dates within the file are in the format yyyymmdd. The times are in the format hhmm, unless 
you select seconds as the unit, which makes the time format hhmmss. 

The values you can get for the status are as follows: 

1 down 
3 unavailable 
4 maintenance 
5 up 

Export Statistical Logging File 

Click to activate this feature and enter settings on the dialog box. 

Path 

Enter the path to which you want to write the log file. 
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File Extension 

Specify the file extension for the log file. 

Separator 

Specify the separator for entries in the log file. 

Time Unit 

Select the time unit used to indicate how long an entry was in a certain status before the status 
changed. The statistical logging creates an entry, in the log file, when the entry that is checked 
changes status; for example: from up to down. The logging includes the time the entry was in a 
previous status. So, for example, when the status goes from up to down, the record shows the 
time the entry was up before the server went down. The Time Unit box determines how the 
software indicates how long the entry was in that status: x minutes - x hours, and so forth. 

Registry Settings for the Host Name 

You can also edit the Windows registry to define whether to use the host name: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StatsLog\AlwaysHostName(regdword) 

0 - use the host name if no pretty name is defined, otherwise use the pretty name. 

1 - always use the host name. 

See Also 

Statistical Logging (Setup Dialog Box) 

To Database (Statistical Logging) (Setup Dialog Box) 
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4.1.2.3.2 To Database (Statistical Logging) (Setup 
Dialog Box) 

 

This feature is available in the free version of Servers Alive and in the Enterprise edition. This 
feature is not available in the Standard edition. 

Export Statistical Logging to Database 

Click the check box to enable this feature and enter settings on the dialog box. 

ODBC Connection String 

Enter the connection string for the Open Database Connectivity (ODBC) database. Click the 
browse button to open the Create Database Connection String dialog box and select a data 
source. 

You can also use UDL files for database logging. Because UDL files use OLEDB providers, the 
files use memory more efficiently than ODBC drivers. To create a UDL file, open Notepad and 
save an empty file as <your_filename>.UDL. Double-click the .UDL file to open the  dialog box 
and configure the UDL connection. To use the file, enter the path to the UDL file as a 
connection string in the ODBC Connection String box. 

Table 

Enter the name of the table for the database that you want to send information to. 

Enter this name before you click the Create Table button. 
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Create Table 

Click this button to create the database. 

Time Unit 

Select the time unit used to indicate how long an entry has been in a certain status before the 
status changed. The statistical logging creates an entry, in the database, when the entry that is 
checked changes status; for example: from up to down 

The logging includes the time the entry was in a previous status. So, for example, when the 
status goes from up to down, the record shows the time the entry was up before the server 
went down. The Time Unit box determines how the software indicates how long the entry was 
in that status: x minutes - x hours, and so forth. 

You can define the date and time format for the database logging by specifying the following 
registry entry keys. When the registry keys are empty, the date and time format of the operating 
system are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_Dateformat 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_Timeformat 

Include Host ID 

Click the check box to include the ID of the host server. 

Include Cycle Start (yyyymmddhhmmss) 

Select the check box to include the date and time for the start of the cycle. The format is 
yyyymmddhhmmss. For example, 20041206093035 would mean the cycle started at December 
6, 2004 at 9:30:35 in the morning. 

Registry Settings for Host Name 

You can edit the Windows registry with the following registry key to define the size of the host 
name, also known as the pretty name, within the database for statistical logging: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_prettynamesize (string) 

You can also edit the Windows registry to define whether to use the host name: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_AlwaysHostName (regdword) 

0 - use the host name if no pretty name is defined, otherwise use the pretty name. 

1 - always use the host name. 

See Also 

Statistical Logging (Setup Dialog Box) 

To File (Statistical Logging) (Setup Dialog Box) 
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4.1.2.4 Interchange Data (Setup Dialog Box) 
You can choose to export interchange data to either a file or, if you have the Enterprise edition, 
a database. You can set options for either of these two features. 

In This Section 

To File (Logfile) (Setup Dialog Box) 

To Database (Logfile) (Setup Dialog Box) 

See Also 

Logging (Setup Dialog Box) 

Syslog (Setup Dialog Box) 

Statistical Logging (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools >General) 

 

4.1.2.4.1 To File (Interchange Data) (Setup Dialog Box) 

 

This feature exports a result file after each check file that contains the status of all entries. You 
must specify the file name, including the full path, to which the export file is written. 

The interchange log file is overwritten after each check cycle. You must get the data after each 
cycle. 
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Export Interchange Data to File 

Click the check box to enable this feature and enter settings in the dialog box. 

File Name 

Enter the name of the file to write the information to. Click the browse button to select a file on 
the computer. 

Command 

Enter the command. Click the browse button to select a command file on the computer. The 
command is executed after the interchange log file is generated. You can use a command to 
insert the interchange data into a database. However, this process is easier if you have the 
Enterprise edition of Servers Alive. 

Separator 

Select the separator to use as a column delimiter in the log file. If the separator that you select 
appears within the data that should be logged, the software replaces that separator with an 
underscore _. For example, you might select a comma as a separator. The Extra Info field 
contains a comma, as follows: 

Welcome, coming from IP 1.2.3.4 

The software converts the comma in the Extra Info field to the following text: 

Welcome_ coming from IP 1.2.3.4 

Fields to Include in Interchange Data 

Click the following check boxes to include the information in the log. 

Host Name 

Includes the host name in the log. 

Pretty Name 

Includes the pretty name in the log. 

Check Info 

Includes information that is checked. For example, for an SMTP check, the information could be 
(TCP port 25) - ping. 

Extra Info 

Includes the response on the check. For example, this information could be "Service is running" 
or "404 not found error" for a URL check. 

Additional Info 

Includes additional information in the log for the round trip or the time necessary to complete 
the test. 
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Number of Cycles Since Start 

Includes the number of cycles since the start. The UID is the unique ID that Servers Alive 
assigns to each host entry. This UID cannot be changed. 

Host ID 

Includes the ID of the host server. 

Group ID 

Includes the group ID. 

Cycle Start 

Includes the date and time for the start of the cycle. The format is yyyymmddhhmmss. For 
example, 20041206093035 would mean the cycle started at December 6, 2004 at 9:30:35 in 
the morning. 

Remark 

Includes a remark in the log file. 

See Also 

Interchange Data (Setup Dialog Box) 

To Database (Interchange Data) (Setup Dialog Box) 

4.1.2.4.2 To Database (Interchange Data) (Setup 
Dialog Box) 
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This feature is available in the free version of Servers Alive and in the Enterprise edition. This 
feature is not available in the Standard edition. 

Export Interchange Data to Database 

Click the check box to enable this feature and enter settings in the dialog box.This feature now 
uses a new database engine that works faster than the previous versions. 

Connection String 

You can now capture logs directly for some database types, in addition to the ability to capture 
logs through ODBC like in previous versions. In order to configure them please use the settings 
below: 

Type of 
Database 

Connection String 

Oracle Connection String: Database name as specified in the TNSNAMES.ORA file 

Requires: OCI 7.3 or higher, it will first try OCI 8  

SQL Server Connection String: 

"" (empty) or "@" connects to the default database on the local server 

databasename or @databasename: connects to databasename on the local 
server 

servername@ connects to the default database on servername 

 

to connect to a named instance of SQL server as servername\instancename 
instead of servername 

Requires: OLEDB v2.5 or higher. 

Sybase Connection String: 

"" (empty) or "@" connects to the default database on the local server 

databasename or @databasename: connects to databasename on the local 
server 

servername@ connects to the default database on servername 

Requires: OpenClient 10.0 or higher  

DB2 Any valid DB2 connection string 

Requires: DB2 CLI v6.X or higher  

Informix Connection String: Any valid Informix  connection string 
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Requires: Informix CLI v2.X or higher  

Interbase Connection String: 

for a local database use a filename 

for a remote server using TCP/IP: servername:filename 

Requires: API version 5. X or higher  

SQLBase Connection String: 

Requires: CAPI v6.x or higher  

MySQL Connection String: 

" (empty) or "@" connects to the default database on the local server 

databasename or @databasename: connects to databasename on the local 
server 

servername@ connects to the default database on servername 

servername@databasename connects to databasename on servername 

Requires: MYSQL C API v3.23 or higher  

PostgreSQL Connection String: 

"" (empty) or "@" connects to the default database on the local server 

databasename or @databasename: connects to databasename on the local 
server 

servername@ connects to the default database on servername 

servername@databasename connects to databasename on servername 

Requires: libpq v7.1 or higher  

ODBC Connection String: any valid ODBC string 

Requires: ODBC v3.X or higher  

  Connection String: path to a SQLIte database file 

Requires: SQLIte v3.x or higher 

Table 

Enter this name before you click the Create Table button. 

Enter the name of the table for the database that you want to send information to. 
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Create Table 

Click this button to create the database. 

Log to db every 

Specify the number of cycles between interchange logging. 

Fields to Include in Interchange Data 

Click the following check boxes to include the information in the log. 

Host Name 

Includes the host name in the log. 

Pretty Name 

Includes the pretty name in the log. You can enter the size of the Pretty Name Create Table 
button. 

Check Info 

Includes information that is checked. For example, for an SMTP check, the information could be 
(tcp port 25) - ping. 

Extra Info 

Includes the response on the check. For example, this information could be "Service is running" 
or "404 not found error" for a URL check. 

Additional Info 

Includes additional information in the log for the round trip or the time necessary to complete 
the test. 

Number of Cycles Since Start 

Includes the number of cycles since the start. 

Host ID 

Includes the ID of the host server. 

Group ID 

Includes the group ID. 

Cycle Start 

Includes the date and time for the start of the cycle. The format is yyyymmddhhmmss. For 
example, 20041206093035 would mean the cycle started at December 6, 2004 at 9:30:35 in 
the morning. 

Remark 

Includes a remark in the log file. 
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Registry Entries for Date and Time Format 

You can define the date and time format for the database logging by specifying the following 
registry entry keys. When the registry keys are empty, the date and time format of the operating 
system are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Interchange\db_Dateformat 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Interchange\db_Timeformat 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Interchange\db_sqlcmd_before (string) is the SQL command that is executed before 
interchange records are added to the database. 

See Also 

Interchange Data (Setup Dialog Box) 

To File (Interchange Data) (Setup Dialog Box) 

 

4.1.2.5 RRD Tools (Round Robin Database) (Setup 
Dialog Box > RRD Tools > General) 

 

This feature is available in the free version of Servers Alive and in the Enterprise edition. This 
feature is not available in the Standard edition. 

[91] 
 



Servers Alive 8 

The Round Robin Database (RRD) Tools store and display time-series data, such as network 
bandwidth, server load average, and so forth, from many different data sources. The RRDTools 
compact the data so that it does not expand over time. The tool then displays graphs of the 
data. 

For more information about RRDTools, see the RRDTools web site. 

Servers Alive updates existing RRDTools databases. 

Benefits 

RRDTools databases give the following benefits: 

Round robin logging resulting in minimal data transfer. 

Fixed resolution logging with random data arrival. 

Storage of data at different resolutions in parallel. 

On-the-fly data consolidation. 

The RRDTools graphs provide the following benefits: 

You can use data from any number of databases. 

You can display line, area, and stack charts. 

RRDTools perform powerful RPN math on data before graphing it. 

 

RRDTools Databases 

Unlike linear databases, the size of an RRDTools database remains constant. In linear 
databases, the size continuously increases because new data gets appended to the end of the 
data table. In contrast, the maximum size of an RRDTools database is determined when the 
database is created. Data is added until the database reaches the maximum size. When the 
database reaches the maximum size, the new data overwrites existing data at the beginning 
point. 

Other databases store the values as supplied. RRDTools can calculate the rate of change from 
the previous to the current value and store this information instead. 

Other databases get updated when values are supplied. The RRDTools only needs data at pre-
defined time intervals. If the database does not get a new value during the interval, the 
database stores an Unknown value for that interval. So, when using the RRDTools database, 
you must use scripts that run at regular intervals to ensure a constant flow of data. 

Implementing RRD Tools 

1. Click File > Setup. In the Logging > RRD Tools area, enter the appropriate options. 

2. Edit > Changes Wizard. 

3. Click File > Setup. 
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4. Click the Generate Create Script and Generate Graph Script buttons to create the .bat 
files. 

5. From the command prompt or a DOS window, browse to the database directory and 
execute the Create script in the .bat file. Type sa_create_rrd.bat. For each entry that has 
RRD logging enabled, a database file is created. 

6. To create the graphs after each cycle, enter the command in Command to Execute 
after the Update (see below). Type the directory path and sa_graph_rrd.bat. 

Enable RRDTool Logging 

Click to enable logging of data with the RRDTools. 

After you enter your settings for RRD graphs and databases, you can edit each entry to enable 
them for RRD logging. You can do this quickly by clicking After you edit each entry, you then 
click File > Setup and, in the Logging > RRD Tools area, click the Generate Create Script 
and Generate Graph Script buttons. 

Path to RDDTool 

Enter the path where you installed the RRDTools. You should include the .exe that you 
compiled. 

 

Database Path 

Enter the path where you want the databases stored 

Command to execute after the update 

Enter a command to start Servers Alive updates to the RRDTools databases. For example, you 
can enter the name of the .bat file that Servers Alive generates to create the data graphs. 

Registry Entry for Log Times 

By default, the RRDTools logging is completed in UTC (GMT) time. You can change the 
logging time to the local time by editing the Windows registry with the following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\RRD\UseLocalTime (dword) to 1 

 

RRD Logging (Round Robin Database) 
(Setup Dialog Box) 

Check Result RRD Logging (Round Robin 
Database) (Setup Dialog Box) 

See Also 

Logging (Setup Dialog Box) 

Logfile (Setup Dialog Box) 

Syslog (Setup Dialog Box) 

Statistical Logging (Setup Dialog Box) 

Interchange Data (Setup Dialog Box) 
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4.1.2.5.1 RRD Logging (Round Robin Database) (Setup 
Dialog Box) 

 

Each RRD tool type has the same basic settings. However, UpDown logging has additional 
"How to log" settings. 

Database Prefix 

Enter the prefix for the names of all the databases. This ensures that each database has a 
unique name. Once you enter the prefyou should not change it. By default, Servers Alive 
creates and updates database files with the name xy, where xy is the unique ID of the entry. 
For example, if you want to name the database sa_xy.rrd, enter sa_ for the prefix and .rrd for 
the suffix. 

Database Suffix 

Enter the suffix for the names of the databases. See the previous paragraph. For example, if 
you enter RRD for the prefix and .DB for the suffix, the database for the entry with a unique ID 
of 4 is called RRD4.DB. 

Generate Create Script 

Click to generate a .bat file that creates the databases for all the entries. You can review and 
edit the .bat file before executing it by entering your changes on the RRD Create Parameters 
dialog box. 

UpDown Logging 

How to log 

Assign values to each status for logging purposes. 
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For performance reasons we generally advice not to generate all the RRD graphs after each 
cycle. Infact re-generating a YEAR graph after each cycle does not have much impact either. 
We recommend using prime numbers for the number of cycles for each of the generation. 

  

See Also 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools > General) 

Check Result RRD Logging (Round Robin Database) (Setup Dialog Box) 

4.1.2.5.2 Check Result RRD Logging (Round Robin 
Database) (Setup Dialog Box) 

 

Directories 

Enter the directory where you want to store graphs that are generated at the following intervals. 
You can click the browse button next to the box to select a directory. You must create the 
directories in Windows Explorer before entering them in the Directories box in Servers Alive. 

Hour 

Web 

Day 

Week 

Month 
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Year 

Generate Graph Script 

Click to generate a script that creates the graphs of data in the databases. You must run the 
.bat file to create the graphs. Servers Alive prompts you to review or edit the contents of the 
.bat file in Notepad. Servers Alive does not actually create the graphs directly. 

The graphs are in .gif or .png format. You can include these graphs in web pages. 

Add type subdirectory name to the directory name of the graphs 

Select this to create a subdirectory for each of the Types, e.g. 

<what-you-entered>\roundtrip 

<what-you-entered>\checkresult 

<what-you-entered>\updown 

See Also 

RRD Tools (Round Robin Database) (Setup Dialog Box > RRD Tools > General) 

RRD Logging (Round Robin Database) (Setup Dialog Box) 

4.1.3 Uptime Logging (Setup Dialog Box) 

 

Uptime logging creates a daily record for each entry for each day. This record contains the time 
and total cycles spent in each state. 
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Enable uptime db logging 

Select to enable this feature. 

ODBC connection string 

Log to the database opened by this connection string. 

Table 

Log to this table. 

See Also 

File > Setup (Setup Dialog Box) 

Alerts (Setup Dialog Box) 

Logging (Setup Dialog Box) 

Output (Setup Dialog Box) 

General (Setup Dialog Box) 
 

Built-in Servers (Setup Dialog Box) 

4.1.4 Output (Setup Dialog Box) 
You can specify outputs to an HTML page, WAP page, or status summary message. 

In This Section 

HTML Page (Setup Dialog Box) 

WAP Page (Setup Dialog Box) 

Status Summary (Setup Dialog Box) 

 

4.1.4.1 HTML Page (Setup Dialog Box) 
If you choose to have Servers Alive generate an HTML page that is based on a template, you 
have tools that allow you a higher degree of control over the final product. To use a template, 
you must first tell Servers Alive the name of the resulting page and then select the HTML 
template to use. Servers Alive reads through the template after each cycle and uses the 
template to generate the end result page. 

For caching HTML Templates during generation, see Startup Settings (Setup Dialog Box). 

Sections 

A template has three parts and supports a set of custom HTML tags that Servers Alive replaces 
on-the-fly with the associated information. The three parts are as follows: 
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Header 

Core 

Footer 

The header part is everything before the <sa_report> tag. The header is only interpreted once 
per page generation. Everything between <sa_report> and </sa_report> is interpreted for every 
host that must be on the page. The footer part is the part after </sa_report> and is also 
interpreted only once. 

Sorting 

You can add an optional parameter to sa_report called SORT that determines how the hosts 
are sorted. The default sort is set in the software. 

To sort by status, you would use <sa_report sort=status>. 

To sort by the type of check, you use <sa_report sort=check>. 

You can add the name of the top level group with <sa_topgroup_name>. Use the following tags 
for the header and footer: 

<sa_topgroupheader> 

<sa_topgroupfooter> 

Header and Footer Tags 

The interpretation of the header and footer part converts these tags to their current value: 

<sa_currentlongtime> - 1:32:07 PM. 

<sa_currentshorttime> - 13:32. 

<sa_currentlongdate> - Day, Month Date, Year (Monday, May 1, 2002). 

<sa_currentshortdate> - Day/Month/Year (5/1/2002). 

Note that sa_currentlongtime, sa_currentshorttime, sa_currentlongdate and 
sa_currentshortdate use the format that is defined within the international settings of the 
control panel of the Servers Alive computer. 

<sa_version> - ex. 2.1.952. 

<sa_cycles> - Number of cycles since Servers Alive started. 

<sa_cyclestart> - Date/time when the cycle started. 

<sa_cyclestop> - Date/time when the cycle stopped. 

<sa_cycletime> - Time the last check cycle occurred in minutes-seconds format. 

<sa_avgcycletime> - Average time a cycle takes (since the last time START was clicked). 

<sa_alerts> -List of all alerts for this entry. 
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The <sa_alerts> tag displays a <br> tag between each alert, by default. You can change the 
<br> to another value by entering the string you want in the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting 
\ServersAlive\StartUp 

\HTMLAlertsSeparator(string) 

<sa_startshorttime> - Returns the time, in a short format, when Servers Alive started. 

<sa_startlongtime> - Returns the time, in a long format, when Servers Alive started. 

sa_startshortdate> - Returns the date, in a short format, when Servers Alive started. 

<sa_startlongdate> - Returns the date, in a long format, when Servers Alive started. 

<sa_nr_entries> - Returns the number of entries. 

<sa_nr_unavailable> - Returns the number of entries that are not available. 

<sa_nr_unchecked> - Returns the number of entries that are unchecked. 

<sa_nr_maintenance> - Returns the number of entries in maintenance. 

<sa_fullpath> - Displays the path of the entry. 

Additional structures are available for headers and footers: 

<sa_groupheader> </sa_groupheader> 

<sa_groupfooter> </sa_groupfooter> 

<sa_select_case STATUS> 

<sa_case> 

• </sa_select_case> 

<sa_case> can also use the values in <sa_rrd_checkresult_graph_available>, 
<sa_groupid>, <sa_groupname>, <sa_checktype>, 
<sa_rrd_checkresult_graph_available>. 

<sa_said> Contains the name of the system on which Servers Alive is running. This tag is 
equivalent to the SAID tag used in database logging. You can use this tag in the Core 
section too. 

<sa_nr_up> - Returns the total number of up entries. 

<sa_nr_down> - Returns the total number of down entries. 

<sa_receivedtraps> - Returns the SNMP received traps. 

For more information, see SNMP Trap Receiver (Setup Dialog Box) 

 

The following parameters are valid within a group header and group footer: 
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<sa_group_name> 

<sa_group_up_entries> 

<sa_group_down_entries> 

<sa_group_maintenance_entries> 

<sa_groupid> 

<sa_group_path> 

<sa_group_number_of_entries> - Returns the total number of entries within the group. 

The following parameter is valid outside of the entries loop: <sa_receivedtraps>. 

The following parameter is valid within the entries loop: <sa_groupid>. 

Core Section 

Within the core section, between <sa_report> and </sa_report>, you can specify many more 
options. You can use the following tags in the core section: 

<sa_hostname> 

<sa_prettyname> 

<sa_priority> - priority for an entry as seen on the Schedule Tab (Entries Dialog Box). 

<sa_startcycle> the startcycle for an entry as seen on the . 

<sa_status> 

<sa_remark> - Gives the remark field. 

<sa_statuschangedate> 

<sa_statuschangetime> 

<sa_onstatustime> - Time that an entry is on a specific status in days-hours-minutes-
seconds format; for example, 3d 7h 32 m 45s. If the days are 0, days are not displayed. 

The HTML template can sort with sa_onstatustime to list the more recent up/down 
entries before older entries. 

<sa_checkdescription> 

<sa_checkresponse> - Same as the %e parameter. This tag returns whether the SAIF tag 
contains (CON) or does not contain (NC0) a specific string. 

<sa_checkresponse_num> - Shows only the numeric value of <sa_checkresponse>. For 
example, if <sa_roundtrip> returns 2567 ms, then <sa_roundtrip_num> shows 2567. 

<sa_checkinterval_unit> - supplies "minute(s)" or "second(s)" as specified in 

<sa_hostid> 
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<sa_ip> - IP address of the host that the software checks, if known. If the IP address is not 
known, the host name is used. (For an HTTP check via a proxy-server it will contain the IP 
address of the proxy-server) 

<sa_levelsdeep> - Gives back a number that shows the level for an entry. This is useful if 
you want to determine where an item is in the tree, as in the following: 

ASP: 

<% 

for i=1 to X 

response.write "X" 

next 

%> 

PHP: 

<?php 

for(i=1; i<=x;i++) {print "X";} 

?> 

<sa_uid> 

<sa_depends_on_uid> - Gives the UID of the parent entry. When no parent entry exists, 
returns -1. 

<sa_roundtrip> - Same as the %a parameter. 

<sa_rrd_roundtrip_enabled> Reads true/false. 

<sa_rrd_updown_enabled> Reads true or false depending on whether RRD logging is 
enabled. 

<sa_rrd_checkresult_enabled> Reads true/false. 

<sa_rrd_roundtrip_graph_available> Reads true/false. 

<sa_rrd_checkresult_graph_available> Reads true/false. This value is true if the 
<sa_rrd_checkresult_enabled value> = true and the entry is the check type D/M/F/E. 

<sa_roundtrip_num> - Shows only the numeric value of <sa_roundtrip>. For example, if 
<sa_checkresponse> shows 220 myMailHost version 2.51, then <sa_checkresponse_num> 
shows 220. 

<sa_rrd_roundtrip_graphname> - Displays the name of the RRD graph that Servers Alive 
generates if this feature is enabled. For more information about this feature, click RRD 
Tools (Round Robin Database) (Setup Dialog Box) 

<sa_rrd_checkresult_graphname> - See the previous tag. 

tag <sa_mute_alerts> - Mute alerts for this entry (possible values T or F). 

Tags supplying the interval time as specified in Misc Settings (Setup Dialog Box 
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<sa_checkinterval_saturday_day> 

<sa_checkinterval_saturday_night> 

<sa_checkinterval_sunday_day> 

<sa_checkinterval_sunday_night> 

<sa_checkinterval_weekday_day> 

<sa_checkinterval_weekday_night> 

Tags supplying the real name of graphs: 

<sa_rrd_checkresult_day_graphname> 

<sa_rrd_checkresult_hour_graphname> 

<sa_rrd_checkresult_month_graphname> 

<sa_rrd_checkresult_week_graphname> 

 <sa_rrd_checkresult_year_graphname> 

<sa_rrd_roundtrip_day_graphname> 

<sa_rrd_roundtrip_hour_graphname> 

<sa_rrd_roundtrip_month_graphname> 

<sa_rrd_roundtrip_week_graphname> 

<sa_rrd_roundtrip_year_graphname> 

<sa_rrd_updown_day_graphname> 

<sa_rrd_updown_hour_graphname> 

<sa_rrd_updown_month_graphname> 

<sa_rrd_updown_week_graphname> 

<sa_rrd_updown_year_graphname> 

Tags supplying the name of the graph with the web directory 

<sa_rrd_checkresult_day_web_graphname> 

<sa_rrd_checkresult_hour_web_graphname> 

<sa_rrd_checkresult_month_web_graphname> 

<sa_rrd_checkresult_week_web_graphname> 

<sa_rrd_checkresult_year_web_graphname> 

<sa_rrd_roundtrip_day_web_graphname> 

<sa_rrd_roundtrip_hour_web_graphname> 
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<sa_rrd_roundtrip_month_web_graphname> 

<sa_rrd_roundtrip_week_web_graphname> 

<sa_rrd_roundtrip_year_web_graphname> 

<sa_rrd_updown_day_web_graphname> 

<sa_rrd_updown_hour_web_graphname> 

<sa_rrd_updown_month_web_graphname> 

<sa_rrd_updown_week_web_graphname> 

<sa_rrd_updown_year_web_graphname> 

<sa_said> Contains the name of the system on which Servers Alive is running. This tag is 
equivalent to the SAID tag used in database logging. You can use this tag in the header 
and footers sections too. 

<sa_threshold> 

<sa_threshold_num> - Shows only the numeric value of <sa_threshold>. This is the first 
value in the returned string. See <sa_checkresponse_num> for an example. 

<sa_stats_avgrtrip> - Average roundtrip time of all UP cycles. 

<sa_stats_avgrtrip_num> - Shows only the numeric value of <sa_stats_avgrtrip>. This is 
the first value in the returned string. See <sa_checkresponse_num> for an example. 

sa_stats_avgrtrip> - Average roundtrip time of all UP cycles. 

<sa_stats_maxrtrip_num> - Shows only the numeric value of <sa_stats_maxrtrip>. This is 
the first value in the returned string. See <sa_checkresponse_num> for an example. 

<sa_stats_minrtrip> - Minimum roundtrip time of all UP cycles. 

<sa_stats_minrtrip_num> - Shows only the numeric value of <sa_status_minrtrip>. This is 
the first value in the returned string. See <sa_checkresponse_num> for an example. 

<sa_stats_upcycles> - Number of UP cycles. 

<sa_stats_uptime> - Up time as a percentage. 

<sa_stats_downtime> - Down time as a percentage. 

<sa_stats_maintenancetime> - Maintenance time as a percentage. 

<sa_stats_nondowntime> - Consecutive UP time. 

<sa_stats_downcycles> - Number of DOWN cycles. 

<sa_stats_maintenancecycles> - Number of MAINTENANCE cycles. 

<sa_stats_totalcycles> - Number of total cycles. 

<sa_inverted> - Displays T if the Invert option is enabled for a check; otherwise, 
sa_inverted displays F. 
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<sa_syslog_enabled> - Displays true/false. 

<sa_syslog_facility> 

<sa_syslog_message> 

<saif> - Most powerful tag. See the following section for more information. 

SAIF Tag 

SAIF allows you to include certain HTML code depending on the condition of the current host. 
SAIF is used as follows: 

<SAIF variable IS value AND variable IS value>something</SAIF> 

<SAIF variable IS value OR variable IS value>something</SAIF> 

<SAIF variable NOT value>something</SAIF> 

Note that an SAIF statement must be on one continuous line. You can have many things inside 
the SAIF start and stop tags, but they must all be on one line, with no line breaks. 

The variables you can check are listed here along with their possible values: 

sa_status – Possible values are UP, DOWN, MAINTENANCE, UNAVAILABLE, and 
UNCHECKED. 

sa_check – Possible values are NETWARE, ORACLE, SQL, URL, DISKSPACE, 
PROCESS, SERVICE, PING, IPXPING, UDP, SNMP, WINSOCK, EXTERNAL, and 
EXTERNALCOM. 

sa_hostname – Host name of the entry. 

sa_hostid – ID assigned to entry. 

sa_UID – Unique ID assigned automatically to the entry by Servers Alive. 

sa_depends_on_UID - Gives the UID of the parent entry. If no parent entry exists, the tag 
returns -1. 

sa_depends_on_entry - Returns the description or pretty name of the entry on which the 
current entry depends. For all entries that depend on another entry, the description of the 
entry on which they depend is shown within brackets. For hosts that do not depend on other 
hosts, nothing displays. 

sa_checkresponse - Same as the %e parameter. This tag returns whether the SAIF tag 
contains (CON) or does not contain (NC0) a specific string. 

sa_prettyname - Returns the pretty name of the entry. 

sa_previous_hostname_in_html - Returns the previous hostname. This is useful, for 
example, in order to only show the hostname if it is different from the previous one: <saif 
sa_hostname not sa_previous_hostname_in_html><sa_hostname></saif>. 

sa_mute_alerts - mutes alerts for the item (possible values TRUE and FALSE) 

and for the output itself you can use as tag <sa_mute_alerts> (will get T or F as value) 
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sa_nr_up,sa_nr_down,sa_nr_maintenance,sa_nr_unchecked,sa_nr_unavailable and 
sa_nr_entries (they are all based on the total number of entries matching not those part of 
this HTML output page) 

SAIF Examples 

<SAIF SA_STATUS IS DOWN>help us please it's down</SAIF> 

<SAIF SA_STATUS IS DOWN AND SA_CHECK IS SQL>The SQL database is down, 
again.</SAIF> 

<SAIF SA_CHECK IS ORACLE OR SA_CHECK IS SQL>A database.</SAIF> 

<SAIF SA_CHECK IS URL OR SA_CHECK IS SERVICE OR SA_CHECK IS DISKSPACE 
AND SA_STATUS IS DOWN>Big alert. Houston we have a problem</SAIF> 

<SAIF SA_HOSTNAME IS www.domain.com AND SA_STATUS IS DOWN>Might wanna 
update the resume, pal.</SAIF> 

The evaluation is always processed from left to right and case does not matter. Also, you can 
include quotes around the values, but they are not necessary. 

<SAIF SA_DEPENDS_ON_ENTRY NOT -1>(<sa_depends_on_entry>)</saif> 

If you would like additional information and a starter template, you can download a zip archive 
with helpful information from the Woodstone web site. 

If you choose to use the sort=check option in the sa_report tag, you can specify a custom 
priority for the various check types. You edit the following registry entry and supply a string that 
lists the order of importance for all checks. 

HKEY_LOCALMACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\CheckTypeSortOrder (string) 

Ex. Default is WIPXSRDUQONME 

(Winsock TCP (W) - Winsock UDP (I) - PING (P) - IPX Ping (X) - NT Service (S) - NT process 
(R) - Disk space (D) - URL (U) - SQL server (Q) - Oracle (O) - Netware (N) - SNMP (M) - 
External (E)) 

Status 

Additional features include the following tags used to filter, on the page, the entries that can be 
displayed based on their status. 

<sa_report sort= status=ALL,DOWN,UNAVAILABLE,UP,UNCHECKED> 

You can have one or more of the list. For example, status=DOWN,UP gives only the entries 
that are up or down. 

You can sort the entries for the page with the following tags. Sorting is always by group by 
default and then by the parameter that you give within the page. 

sort=HOSTID,UID,NAME (or HOSTNAME),CHECK,STATUS,PRETTYNAME,IP, ENTRYPATH 

You can have one or more in the list; for example sort=name,check. 
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If you do not want to sort by group first, then set the nogroup option. 

In the group My Entries, each entry is part of a group, or subgroup. The full path is the 
ENTRYPATH, or the path to the entry: 

group \subgroup\subsubgroup 

When sorting the template-based HTML output by GroupPath or EntryPath, you can edit the 
registry to set the number of bytes used by those parameters: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\SortStringPathSize (string) 

Not in the registry or =0 defaults to 250. Above 1250 goes back to 1250. 

In This Section 

Example Template 

Default Page (Setup Dialog Box)  

See Also 

Output (Setup Dialog Box) 

WAP Page (Setup Dialog Box) 

Status Summary (Setup Dialog Box) 

 

4.1.4.1.1 Example Template 
Carriage returns and line feeds are removed from outputs based on the HTML template. 

<!--This is the header section.--> 

<BODY> 

<!--Here the current date and time variables are used--> 

<H4>Last check done on <sa_currentlongdate>&nbsp&nbsp&nbsp<sa_currentlongtime> 

 <!—Add in a comment that notes that Servers Alive generated the page.--> 

<!-- Generator Servers Alive version <sa_version> via template....--> 

<p> 

<TABLE WIDTH="762" cellpadding="4"> 

<TR><TD WIDTH="32" align="center"><FONT face="verdana" size="2"><B>Up?</TD> 

<TD width="20" align="center"><FONT face="verdana" size="2"><B>ID</TD> 

<TD width="130" align="center"><FONT face="verdana" size="2"><B>Host</TD> 

<TD width="280" align="center"><FONT face="verdana" size="2"><B>Host Check</TD> 

<TD width="80" align="center"><FONT face="verdana" size="2"><B>Parameter</TD> 

<TD width="70" align="center"><FONT face="verdana" size="2"><B>Actual</TD> 
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<TD width="145" align="center"><FONT face="verdana" size="2"><B>Time of Last Status 
Change</TD> 

</FONT> 

</TR> 

<!--The core section begins here. It is repeated for every host on the page.--> 

<sa_report sort=status> 

<!--Use SAIF to change the color depending on whether the host is up or down.--> 

<tr bgcolor="<saif sa_status is down>ff0f00</saif><saif sa_status is up>dbdcaf</saif>"> 

<TD BGCOLOR="#ffffff"> 

<!--Use SAIF to display the correct icon (not supplied with Servers Alive) 

depending on the host condition.--> 

<SAIF SA_STATUS IS UP><img src="images/running.jpg"></SAIF> 

<SAIF SA_STATUS IS DOWN><img src="images/stop.gif"></SAIF> 

</TD> 

<TD WIDTH=20 BGCOLOR="#8fbc8f"> 

<!--Display Host ID with SA_HOSTID.--> 

<CENTER><FONT SIZE=2><sa_hostid></FONT></CENTER> 

</TD> 

<TD WIDTH="145"> 

<!--Display Pretty Name with SA_PRETTYNAME.--> 

<FONT FACE=verdana SIZE=1><sa_prettyname></FONT> 

 

<TD WIDTH="280"> 

<!--Display the type of check with SA_CHECKDESCRIPTION.--> 

<FONT FACE=verdana SIZE=1><sa_hostname> (<sa_checkdescription>)</FONT> 

</TD> 

<TD WIDTH="80"> 

<!--Display check parameters with SA_THRESHOLD.--> 

<FONT FACE=verdana SIZE=1><CENTER><sa_threshold></CENTER></FONT> 

</TD> 
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<!--Display the response time/data with SA_CHECKRESPONSE.--> 

<FONT FACE=verdana SIZE=1><CENTER><sa_checkresponse></CENTER></FONT> 

</TD> 

<TD WIDTH="175" valign="center" align="center"> 

<!--Display the time of the last status change with SA_STATUSCHANGETIME and 
SA_STATUSCHANGEDATE.--> 

<FONT FACE=verdana SIZE=1><sa_statuschangetime>, <sa_statuschangedate></FONT> 

</TD> 

</TR> 

<!--End of the core section.--> 

</sa_report> 

<!--Beginning of footer.--> 

</TABLE> 

<BR> 

<!--Display when the last check cycle occurred using SA_CURRENTLONGDATE 

and SA_CURRENTLONGTIME.--> 

<H4>Last check done on <sa_currentlongdate>&nbsp;&nbsp;&nbsp;<sa_currentlongtime> 

</BODY> 

See Also 

HTML Page (Setup Dialog Box) 

Default Page (Setup Dialog Box) 
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4.1.4.1.2 Default Page (Setup Dialog Box) 

 

Servers Alive creates HTML pages, but does not serve the pages using the built-in web server. 

Publish This Web Page 

Click this check box to enable Servers Alive to create one or more HTML pages after every 
check cycle. 

Add 

Click to enter the name of a web page. The name of the new page appears in the tree on the 
left side of the Setup dialog box. 

Delete 

Click to delete a web page. 

Generate 

Click this button to generate the page using the known values. 

Clear Cache 

Reloads Servers Alive's cache of templates in order to reflect any changes made to the 
originals. 

Add To 

Click to add the HTML page as output page for the following: 

All entries. 
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All entries for a specific type of check. 

All entries for a specific group. 

Delete From 

Click to delete the HTML page from the following: 

All entries. 

All entries for a specific type of check. 

All entries for a specific group. 

Page Name 

Enter the page name for the resulting HTML page. The name must also include the directory in 
which the file is created. 

When you click the Generate button and not all the cycles are complete in Servers Alive, the 
values on the resulting page could be part of cycle_n and parts of cycle_n+1, if cycle_n+1 is in 
progress. 

Template Based 

Click to define a template file. 

Template File 

Enter a file name to use as boiler plate for the log file. You can click the browse button and 
select a file. This option is available only if you click the Template Based checkbox. 

For more on templates, see http://www.woodstone.nu/salive/documentation 

Header File 

Customize the web page by specifying a custom HTML header page. You must also specify 
both the name and directory for these two files. If you use this option, you must also specify a 
footer file. When creating the HTML page, Servers Alive copies the header, adds the Servers 
Alive grid to it, and appends the footer at the end. To publish this page on the Internet or 
intranet, you need a third-party web server. 

Footer File 

Enter the file to use as a footer. See the previous option for more information. 

Look 

Customize the contents of the grid created by Servers Alive. 

Technical 

Specifies that the grid contains the name, port number, and pretty name. 

Manager 

Specifies that the grid contains the pretty name, but not the name and port number. 
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Exclude Time Info 

Specify whether the grid includes the current status and the time/date that it detected that 
status. Click Yes or No. 

Upload It Via 

Select the check box to upload the page to your server with a protocol. Click one of the 
following protocols in the dropdown list. 

FTP - File Transfer Protocol. For faster cycles, this is now performed asynchronously, 
meaning Servers Alive does not wait for completion of the upload. FTP is the least secure 
protocol. 

SFTP - Simple File Transfer Protocol, 

FTP + SSL insecure data channel, 

FTP + SSL secured data channel, 

FTP + SSL wrapped SSL channel. 

FTP Server 

Enter the name and IP of the remote FTP server; for example, you can enter: ftp.company.com. 

If you want to upload the information using a port other than the default port, enter the host 
name and port number in the following format: host_name:port. 

Remote Name 

Enter the directory and filename that the file should have on the FTP server; for example, if you 
want to upload to ftp.company.com and store the file in /user/me/directory and call the file 
myfile.asp, then you can enter: /user/me/directory/myfile.asp. 

User Name 

Specify the user name if the page must reside on a remote computer that requires 
authentication before you can write on the computer's disk. 

If webpage authentication is required, Servers Alive initially sends a frame without 
authentication, then based on the response of the server (401 frame is 'authentication is 
needed') resends the request with authentication. However you can send authentication 
directly by manually editing the authentication type in the entries file: 
ADPA="#WEBAUTHTYPE=<name>#" <name> can have the following values: basic, ntlm, 
digest, auto (this is the default if none is mentioned too). 

Password 

Specify the password. 

PASV 

Specifies to use passive ftp. This mode works better when you are connecting through a 
firewall than the normal FTP connection mode. 
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However, clicking this check box does not guarantee that PASV mode works for your 
connection. PASV causes some security risks, so some network administrators disable PASV 
mode on the server side. 

Registry Settings for Reset Times 

The upload of HTML pages can give a "Busy executing command" error when several files 
have to be uploaded. 

If you decide not to use a template page, refer to the following information. 

Registry Settings for Status 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the following registry keys: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStart 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStop 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStart 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStop 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStart 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStop 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStart 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStop 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStart 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStop 

Registry Settings for Last Check Times 

Servers Alive displays the last check time just before or just after the table with the hosts. This 
can be configured by adding or editing the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\PlaceOfCheckTime (dword) 

0 is below the table, 1 is above the table 
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Registry Settings for Tables 

You change the default size of the columns by adding or editing the following registry values: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\HostColumn (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\StatusColumn (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\SmallStatusColumn (string) 

Example: "100" or "35%" or "AUTO" 

To change the background color of the table of the generated HTML page, you must add or edit 
the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableBackground (string) 

Example: "#FF0000" or "Red" 

By default, Servers Alive generates <TABLE BORDER="1"> as beginning of the table with the 
entry's statuses. Using the previous table background property gives you the option to specify 
<TABLEBGCOLOR="tablebackground">. 

By adding or editing the following registry value you are now able to specify <TABLE 
BGCOLOR="tablebackground" tableproperties> 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableProperties (string) 

Registry Settings for the Number of Host Down Times 

If you want to see the number of times a host has been down since the last log filename 
change in the saved HTML file, you must add or edit the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\Includedownstats (dword) with a value of 1 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this 
you must add or edit the following registry values: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpIcon (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownIcon (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceIcon (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedIcon (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableIcon (string) 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\IncludeIcons (dword) When this value is 1, are substituted for the normal 
words. 

Registry Settings for Different Pages 

All the previous registry settings can be used differently for all the pages that Servers Alive 
must generate. 

The default page uses HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\Servers Alive\HTMLPage\ as the root for its registry keys. 

A web page with a display name of WebServers uses 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ as the root for its registry keys. 

 

HTML Page (Setup Dialog Box) 

Example Template 

 

4.1.4.2 WAP Page (Setup Dialog Box) 

 

Servers Alive is the first monitoring platform to support alerting using WAP (wireless access 
protocol) pages. If you have a cellular device that can view WAP pages, you can spot check 
your servers while on the road. 
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Enable WAP Output 

Click the check box to enable this feature and enter settings on the dialog box. 

WAP alerting uses the concept of WML cards, which are similar to linked HTML pages, to allow 
you to choose the way you view Servers Alive's current status. There are four different page 
types that can be used. 

To enable one of the pages, you type a full file path, including file name, or you can click the 
button on the right side of each location box and browse to the correct location. 

All Hosts with Status (Small) 

Produces a page that shows only the host names and their status. 

All Hosts with Status (Large) 

Produces a page with an initial view showing the names of the hosts and their status, with a link 
to show their exact check description. 

If you are using this option, the resulting WML file can become very big. If you encounter size 
problems within your browser, you can use the Only Down Hosts (Large) option to produce a 
WML file. Future versions of Servers Alive will provide more control over what host should be 
in which WML file. 

On some WML browsers, the size of a deck is limited. This is the compiled size of a deck, and, 
because no direct link exists between the size of the source WML file and the size of the 
compiled WML file, Servers Alive cannot limit the size of the source WML file. In addition, not 
all browsers have the same limit. 

Only Down Hosts (Small) 

Produces a page that shows only the host names of down servers and their status. 

Only Down Hosts (Large) 

Produces a page with an initial view showing the names of the down hosts and their status, with 
a link to show their exact check description. 

Add tag to refresh after 

Force the browser to reload the page after the specified number of seconds. 

Upload Via 

Select the check box to upload the page to your server with a protocol. Click one of the 
following protocols in the dropdown list. 

FTP - File Transfer Protocol. For faster cycles, this is now performed asynchronously, 
meaning Servers Alive does not wait for completion of the upload. FTP is the least secure 
protocol. 

SFTP - Simple File Transfer Protocol, 

FTP + SSL insecure data channel, 
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FTP + SSL secured data channel, 

FTP + SSL wrapped SSL channel. 

FTP Server 

Enter the name and IP of the remote FTP server; for example, you can enter: ftp.company.com. 

If you want to upload the information using a port other than the default port, enter the host 
name and port number in the following format: host_name:port. 

Remote Dir 

Enter the directory and filename that the file should have on the FTP server; for example, if you 
want to upload to ftp.company.com and store the file in /user/me/directory and call the file 
myfile.asp, then you can enter: /user/me/directory/myfile.asp. 

User Name 

Specify the user name if the page must reside on a remote computer that requires 
authentication before you can write on the computer's disk. 

Password 

Specify the password. 

PASV 

Specifies to use passive FTP. This mode works better when you are connecting through a 
firewall than the normal FTP connection mode. 

However, clicking this check box does not guarantee that PASV mode works for your 
connection. PASV causes some security risks, so some network administrators disable PASV 
mode on the server side. 

Registry Settings for WAP Pages 

If you want to store your WAP page on a remote server that requires authentication, you can 
use the following registry entries to supply the authentication information. The server listed here 
should be the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Username (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Password (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Server (string) 

The upload of WAP pages can give a "Busy executing command" error when several files have 
to be uploaded. By default, Servers Alive waits 100ms after the upload in order to give the 
socket the time to do a correct reset. If this is too much or too little time, you can change the 
value in the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\FTPSleepTime (dword) Max is 5000 (ms). 
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Servers Alive does not provide any WAP access through its built-in web server. It only 
generates WML files that can be viewed with a WML enabled browser, typically a WAP-
enabled phone, through a third-party web server. 

Registry Settings for WML Pages 

If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. 

You will need the following: 

Associated extension: WML 

Content type (MIME):  text/vnd.wap.wml 

You can edit the Windows registry with the following keys to modify the responses: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeAllLargeResponse (dword) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeDownSmallResponse (dword) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeDownLargeResponse (dword) 

With a value of 1 it will add the response column too. (%e parameter) 

To change the DOCTYPE header of the WAP file, edit the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\WML_Version (string) with acceptable values: 1.1 or 1.2 or 1.3 or 2.0 

See Also 

Output (Setup Dialog Box) 

HTML Page (Setup Dialog Box) 

Status Summary (Setup Dialog Box) 

4.1.4.3 Status Summary (Setup Dialog Box) 
The Status Summary dialog box allows you to enter conditions for sending a status summary 
message through the protocol that you want. This is useful if you want to receive a quick, 
periodic update on your servers. 
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Servers Alive can send an email to show the status of the entries by email, paging, or instant 
message (IM). 

Enable Status Summary 

Click the check box to enable this feature and enter settings on the dialog box. 

When to Send 

Click an option to determine when to send the status summary message. You can send an 
email after each cycle or at a predefined time. If you select Approximately At, you can enter a 
time and date for sending the message. 

What Entries 

Select an option from the dropdown list to specify the information to include in the message. 
You can choose to receive information for certain types of entries or the summary line, as 
follows: 

Status Change Entries 

Status Change Entries and ALL Down Entries 

All Entries 

Summary Line Only 

Summary Line per Group 

All Down Entries 
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To 

Enter an email address, such as person@company.com. To send the status summary 
message to several email addresses, separate the addresses with a comma, as in the following 
example: 

user1@company.com,user2@company.com. 

Message 

Enter the message you wish to receive as part of the status summary. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Via. Select the protocol for sending the status summary from the 
dropdown list. You can select any protocol, such as SMTP, SMS, and so forth. 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 
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Registry Settings 

You can enter a default subject for the status summary by editing the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatusSummary\FixedSubject (string) 

See Also 

Output (Setup Dialog Box) 

HTML Page (Setup Dialog Box) 

WAP Page (Setup Dialog Box) 

4.1.5 General (Setup Dialog Box) 
The General settings for Setup include the following: 

Proxy settings, 

Startup settings, 

And various settings for the individual user. 

In This Section 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 

See Also 

File > Setup (Setup Dialog Box) 

Alerts (Setup Dialog Box) 

Logging (Setup Dialog Box) 

Uptime Logging (Setup Dialog Box) 

Output (Setup Dialog Box) 

Built-in Servers (Setup Dialog Box) 
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4.1.5.1 Proxy Settings (Setup Dialog Box) 

 

In Servers Alive, you can set up two different sets of proxy settings. You can configure the 
following settings for two proxy servers. 

Proxy Server 

Depending on your setup, you can require Servers Alive to do some or all URL type checks 
through a proxy for security purposes. You can force this behavior by specifying a server and 
port in this section. You can enter either the domain name or IP address of the server. Just 
entering information in this section of the Setup dialog box does not force all URL checks to go 
through the proxy. You must still enable the use of proxy on specific entries. 

Server Name 

Enter the name of the proxy server. 

Port 

Enter the port for the proxy server. 

Type 

Enter the type of protocol for the proxy. This setting depends on what your proxy server 
supports. 

Web Standard - This includes HTTP, or hypertext transfer protocol. 

Socks 4 - Socks 4 is a protocol for TCP proxy across firewalls. 

Socks 4a 

Socks 5 
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Relay 

Same as Internet Explorer - This setting uses the proxy server port from Internet 
Explorer. This setting does not use exceptions that you set in Internet Explorer. 

Use Proxy Authentication 

Click to enable proxy authentication. 

User Name 

Enter the user name. 

Password 

Enter the password. 

See Also 

General (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box)  

MIB Database (SNMP) (Setup Dialog Box) 
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4.1.5.2 Startup Settings (Setup Dialog Box) 

 

The Startup Settings branch of the Setup dialog box tree controls how Servers Alive gets its 
list of monitored services and what the software does with them initially. 

Load Startup Info from Registry 

Click if you plan to have Servers Alive start automatically and read in a saved list of monitored 
entries, which is required for operation as a service. In the registry, Servers Alive stores the 
various startup options and the name of the file containing information on what entries to check. 

Hostfile 

Specify where the saved file containing check information is located. This file has not been 
created yet if you are reading through this documentation for the first time, so you must refer to 
this information again later, after you have created your list of entries. 

Start Checking But Wait __ Seconds After the Start of the Program 

Click the check box to enable Servers Alive to automatically start checking when it is launched. 
Enter the number of seconds that you want Servers Alive to pause before checking. This is 
useful if Servers Alive runs as a service when the computer boots up, but you want Servers 
Alive to wait for all local programs to finish launching before starting its check cycle. 

Start Minimized 

Starts Servers Alive minimized, whether the software is launched through the Programs menu 
or as a service. 
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Only Show Pretty Name in GUI 

Shows only the pretty names in the software interface. Pretty names are labels that you assign 
to your monitored items for easy recall. 

Other Startup Options 

Cycle Unit 

Determines whether Servers Alive uses minutes or seconds as the cycle unit. This time unit 
determines how long the software waits between check cycles. You can specify settings for the 
check cycle on the Misc Settings branch of the Settings dialog box tree. 

Send Mail at Start/Stop of Checking 

Click this check box to enable Servers Alive to send mail at the beginning and ending of every 
check cycle. 

Use High Encryption for Password Storage 

Select this check box to ensure that passwords are stored with high, or AES 256-bit, encryption 
settings. 

Cache IP Addresses and ___ Expire Them Every ___ Cycles 

Ensures that Servers Alive stores the IP addresses in cache. Clear this check box to ensure 
that Servers Alive does not cache the IP addresses. 

This check box is selected by default. Thus, by default, the first time Servers Alive checks a 
host using ping, TCP, or UDP, the software resolves the name into an IP address. Each of the 
following times Servers Alive checks your host, the software uses the IP address stored in 
memory. 

Click the second check box and enter a numeric value to determine how many cycles pass 
before the IP addresses expire. 

Cache HTML Templates 

Select to generate HTML template-based output from memory, instead of from disk. This 
should be faster, but will use more memory. 

List of Public Holidays 

Enter a list of public holidays. You must use the dd-mm-yyyy format with a comma delimiter. 
For example, you can enter 12-25-2003 for December 25, 2003. 

You can use the Startup branch of the Setup tree to edit your list of public holidays. These 
public holidays can be treated as a Sunday, rather than whatever day they actually fall on, 
when Servers Alive determines whom to alert. You turn that feature on when defining a person 
with the Edit > People command. 

Registry Settings 

You can change the way tabs on dialog boxes appear by editing your registry with the following 
key: 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\tabs_look (dword) 

0 - tab dialog style 

1 - property page style like Windows Properties dialog boxes 

To reduce the amount of time that Servers Alive waits between two checks, edit the following 
registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\PerItemCycle {string} 

The default is 250 ms. Enter values starting at 10. 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 
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4.1.5.3 Misc Settings (Setup Dialog Box) 

 

Automatically Save Changes on Exit (to a File) 

Click to save changes to a file. If the Automatically Save Changes on Exit (to a File) option is 
selected, all changes made to the current entries configuration are saved automatically. If the 
option is enabled and you start a new set of entries, you are prompted for a file name when you 
exit Servers Alive. 

Load Windows Positions at Startup 

Select to open Servers Alive in the same size and position that it had when you closed the 
software. If Load Window Positions at Startup is enabled, Servers Alive restores its last 
position on the screen and also restores itself to the last known window size. 

Send Keep Alive Mails Every __ Minutes 

Enter the number of times that you want mails sent. You can request a mail from Servers Alive 
every once in awhile as proof that it is still running. 

Automatically Restart Checking After __ Minutes 

Specify how often you want Servers Alive to start checking in minutes. 

Check Times (Every X Minutes) 

Enter values in the grid to tell Servers Alive when to begin a check cycle on your list of hosts. 
The check times indicate the time that is between the end of a cycle and the start of the next 
cycle. 

For example, if you enter 30 in the 8am to 6pm column of the Weekday row, then Servers 
Alive starts a check cycle every 30 minutes from 8 in the morning until 6 in the evening Monday 
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through Friday. If you enter 0 in the grid, the software defaults to starting a check cycle every 
five minutes during the applicable time period of the column and row. 

Weekday 

Saturday 

Sunday 

Saturday 6pm to 8am means from Saturday 6pm to Sunday 8am. 

By default, the morning starts at 8h (8AM) and the evening starts at 18h (6PM). You can 
change this by adding or editing the following registry entries: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\MorningStart (dword) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\EveningStart (dword) 

Times are in 24h format. 6pm would be 18. 

You can use the Startup branch of the Setup tree to edit your list of public holidays. These 
public holidays can be treated as a Sunday, rather than whatever day they actually fall on, 
when Servers Alive determines whom to alert. You turn that feature on when defining a person 
with the Edit > People command. 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 
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4.1.5.4 Interface Settings (Setup Dialog Box) 

 

Colors Used Within the Main Interface 

For each of the following options, click the browse button to select a color that appears when 
the condition described by the option occurs. For example, you can select a red color to 
indicate when servers are down. 

Use This Color When the Entry Is UP 

Use This Color When the Entry is DOWN 

Use This Color When the Entry Is in Maintenance 

 Use This Color When the Entry Is UNAVAILABLE 

Use This Color When the Entry Is DOWN? (During SK) 

Use This Color When the Entry is UNAVAILABLE? (During SK) 

Use This Color When Checking the Entry 

Gridlines Within Interface 

Click an item in the dropdown list to display horizontal or vertical grid lines or both in the Main 
window of Servers Alive. You can also choose not to display grid lines. 

Update interface during check cycle 

Select this check box to have SA update the interface during the check cycle. This option 
increases the cycle time, and is unselected by default. 
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Scroll Interface While Checking 

(Not available if Update interface during check cycle is selected.) 

Click the check box to ensure that, while Servers Alive checks your servers, the Main window 
scrolls to display the current entry that the software is checking. When you select this check 
box, Servers Alive shows five entries at a time. 

You can change the number of entries displayed by editing the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Startup\NumberOfVisibleItems (string) 

Show Group Statistics in Tree Interface 

Click this check box to display statistics for entries in a group in the Status column of the Main 
window. The status applies only to the entries in the group—and not subgroups. 

In Color 

Displays color for group statistics. 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 

 

4.1.5.5 Custom Fields (Setup Dialog Box) 
You can create up to seven fields to hold information and then use these fields in your Visual 
Basic scripts or as variables in messages. The output for the custom fields appears as 
sa_custom_value_1, sa_custom_value_2, and so forth, in the file or database logs. 

This feature is available only in the free version and Enterprise edition of Servers Alive. 

[129] 
 

http://www.helpandmanual.com/order.html


Servers Alive 8 

 

Custom 1 

Click this check box to enter information that defines your custom field. 

Field Caption 

Type the caption that you want to use as the name or label for the field. 

Field Name in Database 

Type the name that you want to use for the field in the database table. You can use this name 
when writing a script. 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 
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4.1.5.6 Agents (Setup Dialog Box) 
A remote agent enables you to perform checks without needing to open up non-secure 
protocols in your firewall. The agent runs on the remote system, and Servers Alive connects to 
it in order to request a check from that agent. 

Background 

Prior to version 6.1, Servers Alive checks used the specific protocol that was being checked. 
This meant that network connectivity between the system running Servers Alive and the system 
being checked had to support the checked protocol. For example if you want to check if an NT 
service is running on a remote system you need Netbios access to that remote system - 
possible in a "simple" LAN but problematic with a WAN. For this reason, Woodstone introduced 
a new protocol called WOAP (WOodstone Agent Protocol). WOAP is documented protocol that 
describes the "language" used between Servers Alive and an agent. 

The free-edition of Servers Alive can work with one agent (for evaulation purposes), the 
standard edition does not support remote agents, and the Enterprise edition can work with 
unlimited agents (the base license includes two remote agents - more can be added). 

 

NB The remote agent must first be installed on the remote host - see Installing a Remote 
Agent. 

Host 

IP address of the remote server. 

Port 

The default is "20012". 
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Protocol 

Either "SSH", a fully encrypted secure SHH-like connection (recommended), or "TELNET" an 
insecure telnet-alike connection. 

Username 

The default is "woap". 

Password 

The default is "heslo". 

 

Installing a Remote Agent 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 

 

4.1.5.6.1 Installing a Remote Agent 
Servers Alive comes with remote agents for Windows and for Linux/BSD/Unix host. Once you 
have installed the remote agent, you can set it up (see Agents (Setup Dialog Box) then select it. 

NT version: 

Run the setup on the remote system. 

*NIX/BSD version: 

The Woodstone *nix/bsd agent is provided in a pre-compiled binary version for some operating 
systems, and as source code version so you can recompile if required. 

Prerequisite: XINETD or OR INETD already running 

In order to work correctly, XINETD or OR INETD must already be running and able to accept 
remote connections. (For OR INETD, substitute "inetd" for "xinetd"). 

1. First: 

emerge --digest -av xinetd (on Gentoo) 

apt-get install xinetd (on Ubuntu/Debian/...) 
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rpm -i <package-name> (exact name can be found on http://www.rpmfind.net) (on 
OpenSuse/RedHat/CentOS/Fedora/...) 

yum install xinetd (on OpenSuse/RedHat/CentOS/Fedora/...) 

2. Depending on what is exactly installed on your system add: 

zlib-devel and openssl-devel 

(can also be called libssl-dev, zlib1g, zlib1g-dev, openssl) 

3. Configure XINETD to accept remote connections: 

In /etc/xinetd.conf file, remove or remark "only_from=localhost", then restart the system. 

Installing the agent 

Precompiled: 

1. Extract the downloaded file (x represents the latest version of the file): 

tar zxf woap-1.x.tar.gz 

For Solaris: 

gunzip woap-1.x.tar.gz 

tar xf woap-1.x.tar 

2. cd woap-1.x 

Binary install: 

1. First 

./install <binary-name> ssh 

Where the binary-names are: 

bin-fedora-6-i686 

bin-debian-4.0-i686 

bin-ubuntu-6.10-i686 

bin-slackware-11-i686 

bin-mandriva-2007.0-i586 

bin-gentoo-r7-i686 

bin-freebsd-6.2-i386 

bin-openbsd-4.0-i386 

bin-netbsd-3.1-i386 

2. Recompile the source code : 

./install src ssh 
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PERL version (unencrypted!): 

.install src perl 

See Also 

Agents (Setup Dialog Box) 

 

4.1.5.7 Custom Scripts (Setup Dialog Box) 
You can define the scripts that Servers Alive can use. The settings that you can define include 
a filename, the function, and a description for that function. For each entry that you define, you 
can specify that if the output, or result of the check, must be converted using one of the script 
functions, the %e parameter, included in the check result. You can write scripts only in Visual 
Basic. 

This feature is available only in the free version and Enterprise edition of Servers Alive. 

The script is executed after the status of the entry has been set and before any of the alerts are 
fired or an output is generated. This affects the alerts when they use the When Down the 
"Extra Info Field" Should Contain option on the When tab of the Add/Edit Alert dialog box. 
See When Tab (Add/Edit Alert Dialog Box). 

 

You can use the following fields in your Visual Basic scripts: 

Fields.sa_checkdescription 

Fields.sa_ip 

Fields.sa_hostname 
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Fields.sa_prettyname 

Fields.sa_status 

Fields.sa_remark 

Fields.sa_fullpath 

 Fields.sa_roundtrip 

Fields.sa_groupID, available when you use fields.sa_ip or fields.sa_groupid in the script. 

The script accepts one parameter, which is the check result, or %e parameter. The script 
returns one parameter, which is the value of the new content of the %e parameter. 

An example of a custom script follows: 

Function HTTP_Response(x) 

     S=trim(x) 

     rcode=left(s,3) 

     select case rcode 

          case "200" 

               http_response="All is going well with the website" 

          case "404" 

               http_response="The page you're requesting 

is not available on this server" 

          case else http_response=x + " (looks like that isn't 
within my case)" + fields.sa_checkdescription 

     end select 

end function 

Filename 

Displays the filename that contains the script. Enter information in this column by clicking the 
Add or Edit button and typing the information in the Scripts dialog box. 

Function 

Displays the code functions for the script. Enter information in this column by clicking the Add 
Edit button and typing the information in the Scripts dialog box. 

Description 

Displays the description for the function. Enter information in this column by clicking the Add or 
button and typing the information in the Scripts dialog box. 

 

[135] 
 



Servers Alive 8 

Add 

Click this button to add a script to the list. 

Remove 

Click this button to remove a script from the list. 

Edit 

Click this button to edit information in the list. 

In This Section 

Scripts Dialog Box 

See Also 

General (Setup Dialog Box) 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

MIB Database (SNMP) (Setup Dialog Box) 

 

4.1.5.7.1 Scripts Dialog Box 
You can add scripts to the Setup options by clicking File > Setup and then selecting General > 
Custom Scripts in the tree. Click the Add or Edit button to display the Scripts dialog box. 

This feature is available only in the Enterprise edition of Servers Alive. 

 

File Name 

Type or click the browse button to enter the name of the file that contains the script. 

Function 

Enter the function name of the script. 
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Description 

Enter a text string that describes the script. 

See Also 

Custom Scripts (Setup Dialog Box) 

4.1.5.8 MIB Database (SNMP) (Setup Dialog Box) 
Servers Alive can parse SNMP traps using a built-in MIBs (management information base) 
database. A MIB database is a core tool for network engineers: you can query a remote server 
or other device on your network for hardware and software configurations using SNMP. This 
database is useful for monitoring and collecting data about any specific device on your network, 
if the device supports SNMP. For example, you can find out what OIDs the remote server 
supports. The SNMP trap receiver can perform OID lookups within a MIB database. And the 
SNMP check can interpret the result it receives. 

An OID is a dotted numeric string that identifies an object. Typical objects that can be identified 
using OIDs include: attributes in X.500/LDAP-based directories, certificate policies and practice 
statements, MIBS for network management, and encryption algorithms. Two objects are 
considered to be the same only if they have the exact same OID. 

MIB files are a kind of dictionary used to assemble and interpret SNMP messages. Each type of 
device on your network has its own specific MIB file. The MIB file defines the device as a set of 
managed objects or, rather, values that the SNMP manager reads or changes. The MIB file 
allows the SNMP manager to interpret trap messages from devices. 

To interpret trap messages, the SNMP manager must access the MIB file, which describes the 
format and content of the traps that the device can send. To be available for the SNMP 
manager, the MIB file for each of your equipment types needs to be installed, or compiled, on 
the SNMP manager. Because MIB files are specific to the hardware, you must have the correct 
MIB for your hardware type, model, and version number. You can get a MIB file from the 
equipment vendor. 
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In the grid, you can change the way the information is displayed. For example, you can click 
each column heading to resort the information alphabetically in either ascending or descending 
order. You can also select a column heading and drag it to a different location in the grid to 
change the order of the columns. 

Name 

Displays the name of the MIB file in the MIBs database for Servers Alive. 

Description 

Displays information about MIB file. 

You can resize the columns on the grid to see more of each column. Also, if you point the 
mouse to a description in the list, you can see the entire description in the tooltip that appears. 

Show Aliases Too 

Displays the Alias column. This can possibly slow down the software. 

Add MIB 

Allows you to import a MIB file into the Servers Alive MIBs database with the Add MIBs to the 
MIB Database dialog box. 

Remove MIB 

Select a row in the grid for a MIB file and click this button to remove the MIB file from the 
Servers Alive MIBs database. You cannot reverse this action. However, you can import the MIB 
file into the database again by clicking the Add MIB button. 
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Add Alias 

Allows you to add an alias to the MIBs database in Servers Alive. Select a row in the grid and 
click this button. When you add an alias, the new alias appears in the Alias column. 

In This Section 

Add MIBs to the MIB Database Dialog 
Box 

See Also 

Proxy Settings (Setup Dialog Box) 

Startup Settings (Setup Dialog Box) 

Misc Settings (Setup Dialog Box) 

Interface Settings (Setup Dialog Box) 

Custom Fields (Setup Dialog Box) 

Agents (Setup Dialog Box) 

Custom Scripts (Setup Dialog Box) 

4.1.5.8.1 Add MIBs to the MIB Database Dialog Box 
On the MIB Database (SNMP) dialog box, you can do the following: 

 Add MIB files to the Servers Alive MIBs database. 

Add aliases to the MIB files in the MIBs database. 

Several factors can affect importing a MIB file into the Servers Alive MIBs database. The MIB 
file format is not standardized and can be different, depending on the vendor that produced the 
MIB file. Secondly, a MIB file can sometimes depend on another MIB file. If a MIB file depends 
on another file, and the other MIB file is in the Servers Alive MIBs database, Servers Alive 
uses that MIB file in relation to the imported MIB file. The Dependency Errors tab and the 
Summary tab display errors resulting from missing dependency files when you import a MIB 
file. 
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MIBs to Add 

Click the browse button and select the MIB file that you want to add to the Servers Alive MIBs 
database. You can select files with a .mib or .txt extension. 

With the browser dialog box, you can select only one MIB file at a time. To add several MIB 
files at one time, use a wildcard * in the file name that you enter in the box. For example, you 
can enter cis*.txt to add all MIB files that begin with cis and end with .txt. 

Add 

Click to add the MIB file that you selected in the MIBs to Add box to the MIBs database. You 
must enter a name in the MIBs to Add box before clicking this button. 

The results of the import action appear on the Summary tab. For example, if the MIB file 
already exists in the Servers Alive MIBs database, a message appears on the Summary tab. 

The file name is not the MIB name. Two MIB files can have the same MIB name and exist 
under two different file names. The MIB name is stored inside the MIB file and appears in the 
list on the MIB Database (SNMP) branch of the Setup dialog box. 

You can add as many MIB files as you want without closing this dialog box. You can select 
another MIB file in the MIBs to Add box and click the Add button again. 

You can also use a wildcard to add several MIB files at once. For example, you can enter 
C:\MIBFiles\Mm*.mib to add Mm1628v2.mib, Mm1628v3.mib, and Mm1628v4.mib to the 
Servers Alive MIBs database all at once when you click the Add button. The list of all the MIB 
files that match the wildcard in that directory appear in the results of the import on the 
Summary tab. 

When you add a MIB file to the MIBs database, Servers Alive automatically creates an alias for 
the file by adding MIB to the name of the file. The software removes dashes or underscores in 
the file name. The following table shows some examples. 
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If you add this MIB file to the 
MIBs database 

Servers Alive creates this alias 

rfc1234 rfc1234mib 

rfc-1234 rfc1234mib 

rfc-1234-mib rfc1234mib 

rfc_1234-mib rfc1234mib 

Summary Tab 

Displays the results of the import when you click the Add 

Dependency Tab 

Displays the errors in dependency relationships that the software detects when you import an 
MIB file into the Servers Alive MIBs database. These errors often result when the MIB file is 
dependent on another MIB file that does not already exist in the database. You must get the 
other MIB file from the appropriate hardware vendor. 

In the grid, you can change the way the information is displayed. For example, you can click 
each column heading to resort the information alphabetically in either ascending or descending 
order. You can also select a column heading and drag it to a different location in the grid to 
change the order of the columns. 

When you add a MIB file to the database, Servers Alive tries to locate the files on which the 
MIB file depends, if any. The software looks for different versions of the file name. The following 
table shows examples. 

If a MIB file depends on The software searches for the 
dependent file in the database with 
the following names 

rfc-1234 rfc-1234, rfc1234mib 

rfc-1234-mib rfc-1234-mib, rfc1234mib 

rfc_1234_mib rfc_1234_mib, rfc1234mib 

If Servers Alive cannot find the file on which the MIB is dependent, the MIB file is not imported 
into the Servers Alive MIBs database. 

Load Errors Tab 

This tab displays errors that result from mistakes within the MIB file itself. 

Other Errors Tab 

Displays errors that result from importing the MIB file into the Servers Alive MIBs database. 

Add Alias 

Enter a string to add to the MIB file that is listed in the MIBs to Add box. In certain cases, you 
might want to create an alias of your own. For example, a file with an alias of rfc1234 might be 
referenced in other MIB files as rfc1234mib. You might want to add that alias to the database. 
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When you add an alias, the new alias appears in the Alias column of the Setup dialog box. 

To 

Click the dropdown list and select a MIB file from the Servers Alive MIBs database. 

Add 

Click this button to add the alias to the database. A MIB file can have more than one alias. 

See Also 

MIB Database (SNMP) (Setup Dialog Box) 

 

4.1.6 Built-in Servers (Setup Dialog Box) 
Servers Alive has several built-in servers to include: 

Web server 

Telnet server 

SSH server 

SNMP server 

Remote Clients Server 

You can use these to remotely determine the status of all checked items and issue basic 
management commands. 

The difference between SSH and Telnet communications are: 

Communication between a Telnet client and a Telnet server is clear text. 

Communication between an SSH client and an SSH server is encrypted. 

In This Section 

Web Server (Setup Dialog Box) 

Telnet Server (Setup Dialog Box) 

SSH Server (Setup Dialog Box) 

SNMP Trap Receiver (Setup Dialog Box) 

Remote Clients (Setup Dialog Box) 
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4.1.6.1 Web Server (Setup Dialog Box) 

 

Enable Web Server (HTTP) 

Click to enable the web server. If you enable the built-in web server, it publishes a standard 
status page on the port you designate. 

This web page cannot be altered beyond a few cosmetic changes. If you need to have a more 
detailed web page, or desire a different layout, please refer to HTML Page that the options in 
the  branch do not apply to the built-in web server. 

Web Server Port Number 

Specify the port number for the server. The default is 4310 using HTTP. 

Require Secure Channel (SSL) 

Check this option, if you would like to disable HTTP and activate HTTPS. 

Use authentication for web access (based on PEOPLE) 

For extra protection this basic authentication has been added. This uses the existing username 
and password that you give to PEOPLE. 

Previous version of Servers Alive was not able to serve the saved HTML pages. However, in 
this version it is now possible. 

You can now serve the saved HTML pages by using http://hostname:4310/name-of-the-page 
(using the default HTTP protocol and default port 4310 when using a different port or SSL, and 
with an alert for the URL) 

On http://hostname:4310/saweb you can get a basic web interface based on the “old” saweb 
add-on. 
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By default the built-in web server listens to all IPs that are configured on the system. You can 
also define the IP address to which the server should listen to via the registry entry 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WebServer\BindIP (string). If an invalid address is given, then the system will default back 
to listen to all addresses. 

Support for Virtual Directories has been added to our built-in web server, although there is 
currently no GUI for that. You can use this feature mainly for images. In most cases, you would 
only require one virtual directory. 

You will have to create the virtual directory definition within the registry using the following 
entries: 

Under HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WebServer create a new key called VirtualDirectory 

Under HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WebServer\VirtualDirectory create a new key with the name of the virtual directory (for 
example images), and under this key create a new value (string) with the name "Path" and as 
value give it the path were the virtual directory should be pointing too. (for example 
c:\files\images\). 

 

In the above regedit screenshot we have configured two virtual directories, namely "html" and 
"images". 

Enable Automatic Web Page Update 

Click to allow automatic updates to the web page. The web page causes the browser to refresh 
itself every minute for an up-to-date view of the current checked status of all items. 

Note that this web page does not include any management options and is not password 
protected. If you need this sort of functionality, you must use a third party web server. 

Registry Settings 

In some cases, you might need to adjust the HTTP output buffer to improve the speed. You can 
do this by creating the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\HTTPDaemon_OutBufferSize (string) 

The default value is 999999. 

You can force the web server to include the host name for each entry that has a pretty name by 
editing the following key: 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\http_show_host_and_prettyname (string) with a value of 1 

See Also 

Built-in Servers (Setup Dialog Box) 

Telnet Server (Setup Dialog Box) 

SSH Server (Setup Dialog Box) 

SNMP Trap Receiver (Setup Dialog Box) 

4.1.6.2 Remote Clients (Setup Dialog Box) 

 

 

On systems where desktop interaction is not possible (for example on Windows 2008  a service 
can’t have desktop interaction), you can still get the Servers Alive system tray icon by running 
the Woodstone Remote Client. This little tool will give you the moon or stop icon and will offer 
you the possibility to start the GUI of Servers Alive in order to make changes. 

For security reasons, you will have to define the IPs that can or cannot access this feature and 
what PERSON will be enabled access to this tool. This has to be done on the PERSON tab of a 
person. 
 

See Also 

 Built-in Servers (Setup Dialog Box) 
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Telnet Server (Setup Dialog Box) 

SSH Server (Setup Dialog Box) 

SNMP Trap Receiver (Setup Dialog Box) 

4.1.6.3 Telnet Server (Setup Dialog Box) 

 

For more information about security settings, see Security (Setup Dialog Box). 

Enable Telnet Server 

Click to enable a Telnet server. If you enable the Telnet server and specify a port number, you 
can interrogate Servers Alive using a Telnet client, which comes with Windows. With a Telnet 
client, you can see a list of all hosts, their status, and the last time the status changed. The list 
is ordered by status. The Telnet server supports multiple connections. 

Telnet Server Port Number 

Enter the port number of the Telnet server. The default port number is 4301. 

Maximum Number of Concurrent Connections 

Enter the maximum number of concurrent connections. 

Echo Back to Telnet Client 

Click the check box to enable Telnet character echo. By default, this feature is not turned on. 
This means that what you type might not be visible on the screen as you type it, depending on 
the client you use and how it is configured. 

You can also issue commands that modify the behavior of Servers Alive. Refer to Commands. 

In This Section 

Security (Setup Dialog Box) 

Commands List 

See Also 

Built-in Servers (Setup Dialog Box) 

Web Server (Setup Dialog Box) 

SSH Server (Setup Dialog Box) 

SNMP Trap Receiver (Setup Dialog Box) 
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4.1.6.3.1 Security (Setup Dialog Box) 
The following security settings are for Telnet and SSH servers. 

 

You can provide some security to the built-in SSH or Telnet server so that only approved 
personnel can issue administrative commands. You do this by clicking the branch of the Setup 
tree labeled Security. 

IP Address Access Restrictions 

By Default Computers will be 

Secures the SSH or Telnet server by allowing only certain IP addresses to connect. You can 
choose from two basic modes. 

Granted Access 

Permits all computers to access the server. 

Denied Access 

Restricts access to all computers. 

If you select either Granted Access or Denied Access, you can add exceptions to the rule. 
The usual procedure is to deny everyone access by default and then add in certain exceptions, 
by IP address, for known good addresses. To add an IP address range, specify an appropriate 
subnet mask. 
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Except Those Listed Below 

Lists exceptions to the computers that are denied or permitted access to the SSH or Telnet 
server, depending on the option that you selected in By Default All Computers Will Be. 

Access 

Displays whether the specific IP address is denied or permitted access to the server. 

IP Address 

Lists the IP address of each computer that is denied or permitted access to the SSH or Telnet 
server. 

Add 

Click to add an IP address to the list. 

Remove 

Select an IP address and then click Remove to delete the address from the list of exceptions. 

Edit 

Select an IP address and then click Edit to change the address. 

Password Protection 

Sets password protection, the other type of access restrictions for SSH or Telnet servers. 
Choose Password protected (Full-control) or Password Protected (Read-only). You can 
have two log-in names: one name that has full control and one that can only retrieve the status 
of checked hosts. 

If no password protection is selected, then Servers Alive uses the following security settings: 

FULL CONTROL password protected 

Username: sshuser 

Password: sshpassword 

If you use this type of authentication, remember that the Telnet protocol does not make use of 
any encryption. Any user name and password that you use goes out over the network in clear 
text and can be intercepted. Plan accordingly. Note that you can use both types of security 
simultaneously. 

Password Protected (Full-Control) 

Allows a name and password for a user who has full control. 

User Name 

Enter the name of the user with full control. 

Password 

Enter the password of the user with full control. 
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Password Protected (Read-Only) 

Allows a name and password for a user who can only retrieve the status of checked hosts. 

User Name 

Enter the name of the user with read-only privileges. 

Password 

Enter the password of the user with read-only privileges. 

In This Section 

Access Restrictions 

See Also 

 Telnet Server (Setup Dialog Box)  

Commands List 

 

4.1.6.3.1.1 Access Restrictions 

 

You can set access restrictions by entering an IP address and subnet mask for Telnet servers, 
SSH servers, or SNMP trap receivers. 

You can open this dialog box by selecting the following items in the Main Window: 

File > Setup > Tree: Built-in Servers > Telnet Server > Security > Add button 

File > Setup > Tree: Built-in Servers > SSH Server > Security > Add button 

File > Setup > Tree: Built-in Servers > SNMP Trap Receiver > Add 

See Also 

Security (Setup Dialog Box) 

4.1.6.3.2 Commands List 
You can use the following commands: 

RELEASE IP 

Internally Servers Alive converts all host names into IP addresses the first time they are used. 
This applies to the hosts that you check as well as any SMTP servers that you use. If you want 
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to release all of these IP addresses from memory while Servers Alive is running, you can do 
this with the RELEASE IP command on the Telnet interface. 

REMOVE HTML OUTPUT 

Determines that no entries have HTML output. 

START CHECKING 

Accomplishes the same action as clicking the Start button on the Main window of Servers 
Alive. 

STOP CHECKING 

Accomplishes the same action as clicking the Stop button on the Main window of Servers Alive. 

SYST 

Shows the build number of Servers Alive. 

STATUS 

Shows a list of all hosts and their current status. 

STATUS DOWN 

Shows a list of all hosts in a down state. 

STATUS MAINTENANCE 

Shows a list of all hosts in a maintenance state. 

QUIT 

Disconnects your Telnet client from the Telnet interface of Servers Alive. 

HELP 

Displays basic help on various Telnet commands. 

UPDATE 

Accomplishes the same action as clicking the Update button on the Main window of Servers 
Alive. 

MAINTENANCE x 

Sets host into maintenance mode. To get the number of the host issue a STATUS command 
and you will see the number of all hosts. 

MAINTENANCE ALL 

Sets all hosts into maintenance mode. 

ACTIVE x 

Sets host x into active mode. To get the number of the host, issue a STATUS command and 
you will see the number of all hosts. 
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ACTIVE ALL 

Activates all hosts. 

LOAD filename 

Accomplishes the same action as clicking File > Open from the Main window of Servers Alive. 

RESET PAGER 

Clears all pager queues. 

RESET DOWN COUNTERS 

Resets all down counters for all hosts. 

RESET STATISTICS 

Resets the statistics of all hosts. 

SET ALL SOUND TO NONE 

Sets all sound entries to none. 

SET ALL SOUND TO DEFAULT 

Sets all sound entries to default, used most often when you add a sound card to your computer 
after you have configured Servers Alive. 

SET ALL PRIMSMTPMESSAGE TO xyz 

Sets all primary SMTP messages to xyz. 

SET ALL ALTSMTPMESSAGE TO xyz 

Sets all alternate SMTP messages to xyz. 

ENABLE TEAM=<name of team> 

Enables the named team. 

DISABLE TEAM=<name of team> 

Disables the named team. 

INCHECKCYLE 

Indicates whether Servers Alive is in the middle of a check cycle. The command returns a 
possible yes/no response. If Servers Alive is in the middle of a check cycle, then the response 
is Yes. Otherwise, the response is No. 

MERGE <filename> 

Adds the entries from <filename> to the list of existing entries. The file must be local to the 
system running Servers Alive. 

SAVE 

Saves the entrieslist to the currently known entriesfile 
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See Also 

Telnet Server (Setup Dialog Box) 

Security (Setup Dialog Box) 

4.1.6.4 SSH Server (Setup Dialog Box) 

 

For more information about security settings, see Security (Setup Dialog Box). 

Enable SSH Server 

Click to enable a SSH server. If you enable the SSH server and specify a port number, you can 
interrogate Servers Alive with a SSH client, which comes with Windows. With a SSH client, you 
can see a list of all hosts, their status, and the last time the status changed. The list is ordered 
by status. The SSH server supports multiple connections. 

SSH Server Port Number 

Enter the port number of the SSH server. The default port number is 4322. 

Maximum Number of Concurrent Connections 

Enter the maximum number of concurrent connections. 

Echo Back to SSH Client 

Click the check box to enable SSH character echo. By default, this feature is not turned on. 
This means that what you type might not be visible on the screen as you type it, depending on 
the client you use and how it is configured. 

Commands 

See Also 

Built-in Servers (Setup Dialog Box) 

Web Server (Setup Dialog Box) 

Telnet Server (Setup Dialog Box) 

SNMP Trap Receiver (Setup Dialog Box) 
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4.1.6.5 SNMP Trap Receiver (Setup Dialog Box) 

 

For more information about security settings, see Security (Setup Dialog Box). 

Enable SNMP Trap Receiver 

Click to enable Simple Network Management Protocol (SNMP) traps. 

If you want to view the received traps in the HTML template-based output, you must use the 
<sa_receivedtraps> tag in the header or footer of the HTML file. For more information about 
creating the HTML file, see HTML Page. 

SNMP Trap Receiver Port Number 

Enter the port number of the SNMP trap receiver. The default port number is 162. 

Maximum Number of Traps to Save 

Enter the maximum number of traps to receive. 

Conversion 

Displays the following options that determine how OIDs are represented: 

Don't Convert Received OIDs to Text - Specifies that each OID that the SNMP trap 
detects remain numeric values. The OID is not converted to a text representation. 

Convert Received OIDs to Short Text - Specifies that each received OID and the result 
are converted to a short descriptive value from the MIB database. For example, if the OID is 
.1.3.6.1.2.1.2.2.1.6, the short text is as follows: 

ifPhysAddress 
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Convert Received OIDs to Long Text - Specifies that each OID and the result received 
by the trap are converted to a long text representation from the MIB database. For example, 
if the OID is .1.3.6.1.2.1.2.2.1.6, the long text value is as follows: 

.iso.org.dod.internet.mgmt.mib-2.interfaces.ifTable.ifEntry.ifPhysAddress 

If you select Convert Received OIDs to Short Text or Convert Received OIDs to 
Long Text, the software converts any received value within a MIB file to the string 
representation. 

Convert source and agent IPs to hostnames - Specifies that source and agent IPs are 
converted to the hostnames of the received SNMP traps. The information is cached for a 
maximum of 1 hour. To view the current status of the cache, use the VIEW CACHE 
command in the Servers Alive telnet/ssh interface. 

IP Address Access Restrictions 

By Default Traps from All Computers will be 

Secures the SNMP trap receiver by allowing only certain IP addresses to connect. You can 
choose from two basic modes. 

Accepted 

Permits all computers to access the SNMP receiver. 

Denied 

Restricts access to all computers. 

If you select either Granted Access or Denied Access, you can add exceptions to the rule. 
The usual procedure is to deny everyone access by default and then add in certain exceptions, 
by IP address, for known good addresses. To add an IP address range, specify an appropriate 
subnet mask. 

Except Those Listed Below 

Lists exceptions to the computers that are denied or permitted access to the SNMP Receiver, 
depending on the option that you select in By Default Traps from All Computers will be. 

Access 

Displays whether the specific IP address is denied or permitted access to the SNMP receiver. 

IP Address 

Lists the IP address of each computer that is denied or permitted access. 

Add 

Click to add an IP address to the list. 

Remove 

Select an IP address and then click Remove to delete the address from the list of exceptions. 
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Edit 

Select an IP address and then click Edit to change the address. 

View 

Clicking on the VIEW button will show you the received SNMP traps. 

 

Including the type in the message 

To include the generic and specific type of the trap in the message for a received SNMP trap, 
assign the value of "1" to the registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeType. 

Example message: 

Trap received from 199.8.7.6(172.22.150.179) with generic type 5, specific type 23 
trigger rule With .... 

Including extra parent levels when searching for OID within the MIB database 

By default,when the SNMP TRAP receiver does a lookup of a received OID, it looks for the 
actual OID. If the actual OID is not found, it then searches for the parent of the given OID. To 
extend the search up by more than one level, create the key 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\MIBdb\ParentLevelsToSearch and set the value to more than 1. 

Example: 

A trap is received with OID .1.3.6.1.4.1.232.6.2.6.8.1.0.2 

Within the mib database we find .1.3.6.1.4.1.232.6.2.6.8.1 

With the ParentLevelsToSearch set to 1 (or default) it would be translated as 

.1.3.6.1.4.1.232.6.2.6.8.1.0.2 

With the ParentLevelsToSearch set to 2 it would be translated as... 

.iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.c
pqHeTemperatureTable.cpqHeTemperatureEntry.0.2 
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...since ".1.3.6.1.4.1.232.6.2.6.8.1" is 
".iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.
cpqHeTemperatureTable.cpqHeTemperatureEntry". 

In This Section 

Trap Alerts (Setup Dialog Box) 

See Also 

Built-in Servers (Setup Dialog Box) 

Web Server (Setup Dialog Box) 

Telnet Server (Setup Dialog Box) 

SSH Server (Setup Dialog Box) 

 

4.1.6.5.1 Trap Alerts (Setup Dialog Box) 
The following settings are for SNMP trap receiver servers. 

This feature is available in the Enterprise edition and the free version of Servers Alive. 

 

Description 

Shows the alert and settings that you configure when you click the Add or Edit button. 

Add 

Adds an alert on the received SNMP traps. You can display the dialog box when you click the 
Add or What tab of the Add/Edit Alert dialog box are different, depending on the option you 
select when you click the Add button. 
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The following list shows the different options that appear on the What tab when you select an 
option: 

What Tab: Send SMTP Mail (Primary) 

What Tab: Send SMTP Mail (Alternate) 

What Tab: Send Other Mail 

What Tab: Alpha Page/SMS 

What Tab: Send Network Page (SNPP) 

What Tab: Send Network Page (SMPP) 

What Tab: Generate NotePager - PageGate Message File 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message 

What Tab: Send WinPOPUP Message 

What Tab: Send SNMP Trap 

What Tab: Sound 

The dialog box also displays the following tab: 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

Remove 

Select an item in the alert list and click this button to delete it. 

Edit 

Allows you to change settings for an alert in the list. 
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You can also filter the alerts on generic and specific types. The SNMP TRAP Receiver alert can 
now work on a part of the enterprise OID. 

For example if you enter 1.2.3.4.5.* then it will be triggered on all enterprise OIDs that start with 
1.2.3.4.5. 

Please note that only SNMPv1 traps contain an enterprise OID. 

Within these alerts, you can use some parameters (these % parameters are different compared 
to those for the other alerts) 

o        %h: name of the system running Servers Alive 

o        

o        %d: date the trap was received 

o        %m: received SNMP trap 

 %r: rule that was triggered 

o        %s: name/ip of the source of the snmp trap 

o        %a: name/ip of the agent sending the trap 
  

See Also 

SNMP Trap Receiver (Setup Dialog Box) 

5. Edit Menu 
On the Edit menu in the Main window, you can complete the following activities: 

Quickly locate an entry. 

Edit entries, to include settings for checks and alerts. 

Add new entries based on another entry. 

Find and replace various settings, such as your pager number. 

Edit teams, people, and protocols. 

The Edit menu has the following commands: 

Expand All - Displays all the entries in each group in the Main window. 

Collapse All - Shows only the top level of the groups in the Main window. 

Find - Searches for a string in the entries. 

New Entry - Creates a new entry. 

New Entry Based On . . . - Adds a new entry based on an existing entry. 
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Import Hosts - Opens a list of hosts based on a file that you select. You can save a list of 
hosts with the Save As command and then place the list of hosts on another computer and 
use it in another copy of Servers Alive. 

Entry - Select an entry in the Main window and use this command to edit the settings. 

Delete 

Delete All - Removes all hosts. 

Global Change - Makes changes in all hosts. 

Changes Wizard - Make changes to items quickly and efficiently. 

People - Allows you to add personnel. You can also enable specific protocols for receiving 
messages and schedule those protocols for each person. 

Teams - Allows you to create teams. 

Protocols - Allows you to enter settings for each type of protocol. 

In This Chapter 

Edit > Find (Find Dialog Box) 

Edit > New Entry (Entries Dialog Box) 

Edit > New Entry Based On . . . 

Edit > Entry (Entries Dialog Box) 

Edit > Import Hosts (Import Entries Dialog Box) 

Edit > Delete 

Edit > Delete All 

Edit > Global Change (Replace) (Global Changes Dialog Box) 

Edit > Changes Wizard (Global Add/Change Dialog Box) 

Edit > People (People Dialog Box) 

Edit > Teams (Teams Dialog Box) 

Edit > Protocols (Protocols Dialog Box) 

5.1 Edit > Find (Find Dialog Box) 
In a long list of hosts, you can click Edit > Find on the Main window to quickly locate a specific 
entry. 
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Find What 

Enter the pretty name of the entry and then click OK. 

Match Case 

Click this check box to ensure the search locates items that match the case, either upper case 
or lower case, of the letters that you enter in the Find What box. If you clear the check box, the 
search locates any letters that you enter, either upper case or lower case. 

5.2 Edit > New Entry (Entries Dialog Box) 
Once Servers Alive has been configured properly, you are ready to begin adding or editing 
entries. When adding or editing an entry, a dialog box appears that allows you to specify what 
host should be checked and what should be checked on that host. 

You can add new entries by clicking the Add button. You can edit entries by either selecting an 
entry and clicking the Edit button or double-clicking an entry, when the software is not in a 
check cycle. 

If you select an entry in the main window and click the Edit button, you can see the date of the 
last change and the user name who edited the entry. The information appears in the lower left 
corner of the Entries dialog box, as in the following example: 

 

If you have purchased the Standard edition, you can create up to 1000 entries. If you have 
purchased the Enterprise edition, you can create up to 5000 entries. 
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You can apply a unique schedule for each entry on the Schedule tab. 

In This Section 

General Tab (Entries Dialog Box) 

Check Tab (Entries Dialog Box) 

Alert Tab (Entries Dialog Box) 

Output Tab (Entries Dialog Box) 

Logging Tab (Entries Dialog Box) 

Schedule Tab (Entries Dialog Box) 

Custom Tab (Entries Dialog Box) 

Network Tab (Entries Dialog Box) 
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5.2.1 General Tab (Entries Dialog Box) 

 

Server Name of IP(X) Address 

Enter the name of the server or its IP address. You can enter a NetBIOS name (server) or its 
fully qualified domain name (server.domain.com). Internally Servers Alive attempts to resolve 
this name to the name's IP address on its first check cycle and then use that address from then 
on. If the software has trouble resolving a name, you might need to specify the host by IP 
address. For an IPX ping, you must enter the IPX address of the server. If you enter an IPX 
address, enter the network address, a colon <:>, and then the node address; for example: 
352FBA2B:000000000001. 

Pretty Name 

Enter the pretty name. The pretty name is used only for display purposes, such as in the 
software, Telnet client, email, HTTP/HTML output, and so forth. You should enter a descriptive 
name that instantly identifies the computer and check to you when you receive it in a page or 
email. 

Host ID 

Enter the number used to identify the host when using numeric paging and in the interchange 
format. You do not need to enter anything in this field, as it is automatically generated for you 
when you create the entry. You can change the host ID to be more meaningful to you, however. 

Depends On 

Select a server name from the list. This option displays a tool tip with the full description of the 
check. This feature is useful when the pretty name, or check description, is longer than the 
Depends On box. 
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Note: If an entry has a prettyname, then this was shown in the DEPENDS ON list on the 
ADD/EDIT entry page, without a prettyname is showed a description of the entry. By 
editing/adding the following registry value 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Dependsonwithoutprettyname (string) with value of 1 it will always show a 
description). 

Being 

Select the status of the server for when you want the check to occur. 

Group Membership 

Select the group. 

Remark 

Enter a note or remark for your reference. 

Active/Maintenance 

Click Active or Maintenance to specify how to include the entry in the check. If a host is down 
due to maintenance, you can exclude it temporarily from the list of hosts that is checked. The 
HTML report shows the host as being in maintenance. 

The fastest way to exclude the entry is in the Main window of Servers Alive. You can select the 
entry, right-click on it, and then choose Maintenance on the shortcut menu. You can also place 
a host in maintenance mode with the Telnet server. 

5.2.2 Check Tab (Entries Dialog Box) 
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After supplying the needed information for the General tab of the Entries dialog box, you must 
select what type of check to use for the entry on the Checks tab. You can choose from many 
check options. 

Only one check can be used for each entry on the Main window. If you want to perform multiple 
checks on a server, you must have separate entries for each check you want. Each check type 
is discussed in the following sections. 

The Winsock checks include any checks that make a basic connection to another computer 
over TCP/IP. This includes both TCP and UDP connections. TCP checks are used for things 
such as web and mail servers. UDP checks include things such as Radius servers, DNS 
servers, and various game servers. Servers Alive can also monitor CITRIX® Terminal Servers 
with the UDP protocol. 

When creating a check, first select the protocol that applies to the check type you want by 
selecting the appropriate item in the Check to Use list. You can select from any of the 
protocols that Servers Alive supports: 

TCP 

UDP 

DNS 

Radius 

Ping 

NT Service, Process, and Perfmon 

Diskspace 

URL (HTTP/HTTPS and RTSP/MMS) 

Database (Microsoft SQL and Oracle) 

Netware 

SNMP 

External COM 

External (Errorlevel) 

Combined Check 

While verifying that a port is open can be sufficient to monitor a service, this can also cause 
odd logging on whatever server is being checked. Some services, such as SSH, do not 
function properly when computers connect and then immediately disconnect. For this reason, 
you might see spurious warnings in the logs regarding connections from the Servers Alive 
Server. This is not a problem, but it is something you should keep in mind. 

The check process is case-sensitive. This means that a process with the name "fest" is different 
from a process with the name "Test." You can change this so that each check is case-
insensitive by editing the following registry key: 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\ProcessnameCaseInsensitive (dword) with a value of 1. 

In This Section 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.1 Check Tab: DNS Protocol Option (Entries 
Dialog Box) 

 

You can define your own protocol and the corresponding port by clicking in the Main window. 

Select the specific port or service you want to check. 

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive defines these, along 
with their default ports. 

Other 

Click this option if you want to check a service that is not on the list or is using a non-standard 
port. You must then supply the port number. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 
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Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 
Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.2 Check Tab: TCP Protocol Option (Entries 
Dialog Box) 

 

You can define your own protocol and the corresponding port by clicking Edit > Protocol in the 
Main window. 

Select the specific port or service you want to check. 

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive defines these, along 
with their default ports. 

Other 

Click this option if you want to check a service that is not on the list or is using a non-standard 
port. You must then supply the port number. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

(No Label) 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 
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Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box)  
Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.3 Check Tab: URL (RTSP/MMS) Option 
(Entries Dialog Box) 

 

Servers Alive can perform a URL (Universal Resource Locator) check based on the MMS 
(Microsoft media server) or RTSP (streaming audio) protocol. RTSP stream checking can also 
check an RTSP stream that is password protected (basic authentication). 

Select the radio button and enter information in the box. 

Servers Alive supports the MMS and RTSP protocols using only TCP, not UDP or HTTP. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 
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Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 
Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.4 Check Tab: Ping Option (Entries Dialog 
Box) 

 

IP Ping 

Click to enable the ping feature. Servers Alive can ping a host using an ICMP network frame, 
which determines if the computer and the network between the computer and the Servers Alive 
computer are functional. 

By default, a ping sends a 32-byte ICMP frame. For changing this, see 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\PingSize. 

PING check can now work with frames up to 2048 bytes and we can set the DON'T 
FRAGMENT bit. (Do take in account that a none-fragmented frame can never be larger then 
the MTU that is defined on the NIC - that is NOT a Servers Alive limit!) 

Servers Alive can also ping over the IPX protocol for Novell servers and clients using the 
Novell Netware client, which you must install separately. 

Note: This feature will be removed in the next version of Servers Alive. 

Maximum timeout for a ping check is 600s. During the check, the timeout per frame is 
calculated and has a maximum of 32s per frame—a limit of the ICMP.DLL. 

For example, if Servers Alive must send 10 frames and the timeout is set to 400, then each 
frame has a maximum timeout of 32 seconds. If the number of frames is set to 20 and the 
timeout to 400, each frame has a maximum timeout of 20 seconds. 
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A ping (IP) can generate the following error codes, which can be found in the log files: 

IP_SUCCESS = 0 

IP_BUF_TOO_SMALL = (11001) 

IP_DEST_NET_UNREACHABLE = (11002) 

IP_DEST_HOST_UNREACHABLE = (11003) 

IP_DEST_PROT_UNREACHABLE = (11004) 

IP_DEST_PORT_UNREACHABLE = (11005) 

IP_NO_RESOURCES = (11006) 

IP_BAD_OPTION = (11007) 

IP_HW_ERROR = (11008) 

IP_PACKET_TOO_BIG = (11009) 

IP_REQ_TIMED_OUT = (11010) 

IP_BAD_REQ = (11011) 

IP_BAD_ROUTE = (11012) 

IP_TTL_EXPIRED_TRANSIT = (11013) 

IP_TTL_EXPIRED_REASSEM = (11014) 

IP_PARAM_PROBLEM = (11015) 

IP_SOURCE_QUENCH = (11016) 

IP_OPTION_TOO_BIG = (11017) 

IP_BAD_DESTINATION = (11018) 

Send ___ Frames, Of Which at Least ___ % Must Respond with the Timeout 

Enter the number of frames and percentage that must respond within the timeout limit that you 
set. 

The IPX Ping and IPX Diagnostic Ping options are available if the Novell Netware client is 
installed and if the host name is entered as an IPX address. Example: 
352FBA2B:000000000001). 

Type of Service 

This is only sent if the sending OS is configured for this. See 
http://support.microsoft.com/?kbid=248611. 

An ICMP packet (ping) contains a “Type of Service” (TOS) field which you can check via 
Servers Alive. A TOS check only works over ipv4. 
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By default, the PING check can only be done over ipv4. If your system “knows” ipv6 and the 
remote system is ipv6 enabled, then you can also ping over ipv6 by checking the “Use ipv6”. 

In rare cases where the default packet size is good, you can also change this via the interface. 

IPX Ping 

Click to use socket 9086. 

IPX Diagnostic Ping 

Click to use socket 456. 

Timeout 

Enter the length of time for the timeout in seconds. 

For example, you can enter the following items: 

10 frames 

75% success rate 

As a result of these settings, Servers Alive sends 10 frames and each of them should get a 
response within 5s/10=.5s. If Servers Alive receives the response, the frames are internally 
flagged as being OK. The next frame is sent after the timeout of the previous check or when the 
previous check gets back. After the ten frames, Servers Alive calculates the percentage of 
frames that came back on time. Servers Alive checks to see if this fits the given rule, in this 
case 75%, and based on this check, indicates an OK or DOWN for the host entry. 

Info 

Displays the values of the variables as they are used in a formula. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 
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Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.5 Check Tab: Radius Protocol Option 
(Entries Dialog Box) 
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You can define your own protocol and the corresponding port by clicking Edit > Protocol 

Select the specific port or service you want to check. 

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive defines these, along 
with their default ports. 

Other 

Click this option if you want to check a service that is not on the list or is using a non-standard 
port. You must then supply the port number. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 
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Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.6 Check Tab: NT Service Option (Entries 
Dialog Box) 

 

Servers Alive can perform various checks specific to Windows NT, 2000, 2003, 2008 and 2012. 
The software can check Windows NT services on local and remote computers. Keep in mind 
that if you are running Servers Alive as a service, and want to check a service, process, or 
performance counter on a remote computer, you must specify a user name and password with 
sufficient rights to perform the check on the remote computer. 

In order for Servers Alive to perform the various checks that are specific to Windows NT, 2000, 
2003, 2008 and 2012, the software must have access to the remote server's NetBIOS ports. 
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This can be a problem if there are any intervening firewalls. Please consult with your firewall 
administrator to get the required access. 

Please note that authentication based on the settings of a PERSON (i.e.central user 
management for Windows authentication) is now possible in this version. 

 

Check 

Click this radio button and then click the browse button to open the Services Running On dialog 
box. You can then select from the list of services running on the remote computer. 

Authenticate Before Checking 

Click to enable authentication before the check starts. 

The user performing the service check needs to have at least power-user rights on the 
computer that is checked. For the process checking, you need administrator rights. This means 
that, when Servers Alive runs within the context of user_1, user_1 must have power-user or 
administrator rights on the computer that is checked. 

If user_1 does not have sufficient rights, you can specify another user name, usually in the form 
domain\username, and password of a user with power-user or administrator rights on the 
computer that is checked. 

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
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check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

The various Windows checks can return errors in the log. Some common errors follow: 

5 Access denied. 

53 The network path was not found. 

1219 Multiple connections to a server or shared resource by the same user, using more 
than one user name, are not allowed. Disconnect all previous connections to the server or 
shared resource and try again. 

1220 An attempt was made to establish a session to a network server, but there are 
already too many sessions established with that server. 

1312 A specified log on session does not exist. It might already be terminated. 

1322 No mapping between account names and security IDs was completed. 

1323 The value provided as the current password is incorrect. 

1324 The value provided contains values that are not allowed in passwords. 

1325 The value provided does not meet the length, complexity, or history requirement of 
the domain. 

1326 Unknown user name or bad password. 

1327 User account restriction. 

1328 Account logon time restriction violation. 

1329 The user is not allowed to log on to this computer. 

1330 The specified account password has expired. 

1331 The account is currently disabled. 

1722 The RPC server is unavailable. 

Usually, Servers Alive de-authenticates at the end of any check cycle that includes 
authentication. If this does not succeed, it can cause any subsequent checks to fail. To force an 
authentication disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword). Value of 1 turns this feature 
on. 

If any error code found within this comma separated list occurs during the authentication phase, 
Servers Alive still sees the authentication as being successful. This is not a guarantee that the 
check will pass. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 

The service check's authentication will by default use a connection to IPC$ in order to 
authenticated towards the remote system. In some cases this is not working correctly (due to 
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security settings on the remote system). You can now globaly change the authentication 
method used for service checks by setting the registry value 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForServiceChecks (reg_dword) to 1. 

Info 

Displays the values of the variables as they are used in a formula. 

In This Section 

Services Running On Dialog 
Box 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 5.2.2.13) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box)  

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

 

When you use an NT Service check, you can select an item to check, such as Audiosrv <=> 
Windows Audio. 

To open this dialog box, select the following items from the Main window: 
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Add button > Entries dialog box > Check tab > Check to Use list: NT Service > Browse 
button. 

 

See Also 

Check Tab: NT Service Option 
(Entries Dialog Box) 

5.2.2.7 Check Tab: UDP Protocol Option (Entries 
Dialog Box) 

 

Servers Alive supports checks for common game servers including the following: 
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Quake1, QuakeWorld Master, Quake 2, Quake 2 Master, Quake 3, 

Half-Life, Half-Life Master, 

Tribes, Tribes Master, Tribes 2, 

Unreal, Unreal Master, 

Hexen World, and Hexen 2. 

Thanks to Carl at DNA Games for providing the information needed to provide the game server 
checks. 

You can define your own protocol and the corresponding port by clicking Edit > Protocol. 

Select the specific port or service you want to check. 

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive defines these, along 
with their default ports. 

Other 

Click this option if you want to check a service that is not on the list or is using a non-standard 
port. You must then supply the port number. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 
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Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.8 Check Tab: NT Process Option (Entries 
Dialog Box) 

 

Servers Alive can perform various checks specific to Windows NT, 2000, 2003, 2008 and 2012. 
The software can check Windows NT processes on local and remote computers. To check if a 
process is running on a remote server, you must have access to the registry of that system. 
Keep in mind that, if you are running Servers Alive as a service, and want to check a service, 
process, or performance counter on a remote computer, you must specify a user name and 
password with sufficient rights to perform the check on the remote computer. 

Servers Alive can only check for Windows NT processes if Servers Alive is running on a 
computer that runs Windows NT, 2000, 2003, 2008 or 2012. 

Windows NT, 2000, 2003, 2008 and 2012 specific checks, the software must have access to 
the remote server's NetBIOS ports. This can be a problem if there are intervening firewalls. 
Please consult with your firewall administrator to get the required access, if this is the case. 

If you select NT process, you can click List the Available to get a list of the running processes 
on the remote computer. Double-click on one to select it and return to the Check tab. On the 
right side, select the check condition. Servers Alive can alert you when less than, or at least x 
number of, the specified processes are running. This is commonly used to alert when the Dr. 
Watson process is running (indicating an error). 

Please note that authentication based on the settings of a PERSON (i.e.central user 
management for Windows authentication) is now possible in this version. 

Check 

Click this radio button and then click the browse button to open the Processes Running On 
dialog box. You can then select from the list of services running on the remote computer. 

And Alert When ____ ____ Instances Are Running 

Enter the condition and number of instances to perform the check. 
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Authenticate Before Checking 

Click to enable authentication before the check process starts. 

The user performing the service check needs to have at least power user or administrator 
rights on the computer that is checked. If you do not have sufficient rights, you can specify 
another user name, usually in the form <domain name>\<user name>, and password of a user 
with power user or administrator rights on the computer that is checked. 

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

The various Windows checks can return errors in the log. Some common errors follow: 

5 Access denied. 

53 The network path was not found. 

1219 Multiple connections to a server or shared resource by the same user, using more 
than one user name, are not allowed. Disconnect all previous connections to the server or 
shared resource and try again. 

1220 An attempt was made to establish a session to a network server, but there are 
already too many sessions established with that server. 

1312 A specified log on session does not exist. It might already be terminated. 
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1322 No mapping between account names and security IDs was completed. 

1323 The value provided as the current password is incorrect. 

1324 The value provided contains values that are not allowed in passwords. 

1325 The value provided does not meet the length, complexity, or history requirement of 
the domain. 

1326 Unknown user name or bad password. 

1327 User account restriction. 

1328 Account logon time restriction violation. 

1329 The user is not allowed to log on to this computer. 

1330 The specified account password has expired. 

1331 The account is currently disabled. 

1722 The RPC server is unavailable. 

Usually, Servers Alive de-authenticates at the end of any check cycle that includes 
authentication. If this does not succeed, it can cause any subsequent checks to fail. To force an 
authentication disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword). Value of 1 turns this feature 
on. 

If any error code found within this comma separated list occurs during the authentication phase, 
Servers Alive still sees the authentication as being successful. This is not a guarantee that the 
check will pass. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 

The process check's authentication will by default use a connection to IPC$ in order to 
authenticated towards the remote system. In some cases this is not working correctly (due to 
security settings on the remote system). You can now globaly change the authentication 
method used for process checks by setting the registry value 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForProcessChecks (reg_dword) to 1 

Info 

Displays the values of the variables as they are used in a formula. 

In This Section 

Processes Running On Dialog 
Box 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 
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Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

When you use an NT Process check, you can select an item to check such as Idle, System, or 
Winlogon. 

The Processes Running On dialog box, when using authentication to check for a list of 
services, uses the timeout that you enter on the Check tab of the Entries dialog box. The 
software displays any authentication errors. 

To open this dialog box, select the following items from the Main window: 

Add button > Entries dialog box > Check tab > Check to Use list: NT Process > Browse 
button. 
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See Also 

Check Tab: NT Process Option 
(Entries Dialog Box) 

5.2.2.9 Check Tab: NT Perfmon Option (Entries 
Dialog Box) 

 

Servers Alive can perform various checks specific to Windows NT , 2000, and 2003. It can 
check NT performance monitor (perfmon) counters on local and remote computers. If you are 
running Servers Alive as a service, and want to check a service, process, or performance 
counter on a remote computer, you must specify a user name and password with sufficient 
rights to perform the check on the remote computer. 

In order for Servers Alive to perform the various Windows NT, 2000, and 2003 specific checks, 
the software must have access to the remote server's NetBIOS ports. This can be a problem if 
there are any intervening firewalls. Please consult with your firewall administrator to get the 
required access, if this is the case. 
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The software can check to see if the result of a check: 

Is less than a value, 

Is greater than a value, 

Is equal to a value, 

Is different from (<>) a value, 

Contains a result of a formula that is false. 

 

Please note that authentication based on the settings of a PERSON (i.e.central user 
management for Windows authentication) is now possible in this version. 

 

Check ________ 

Click this radio button and then click the browse button to open the Select Counter dialog box. 
You can then select from the list of services running on the remote computer. 

And Alert When 

Select one of the operators from the list. 

This option Means this 

< Is less than a value. 

= Is equal to a value. 

> Is greater than a value. 

<> Is different from (<>) a value. 

Formula Contains a result of a formula that is 
false. 

When you select Formula from the list, you can use the following parameters to check the 
result of a formula: 

sa_currentresult = the result of the get operation. 

sa_previousresult 

sa_currenttimeinms = the current time in milliseconds. 

sa_previoustimeinms = the time of the previous get operation in milliseconds. 

You can create formulas using these parameters and have Servers Alive give a down when the 
result of the formula is false. For example, you can check the number of errors that occur in a 
network interface with the following formula: 

(sa currentresult - sa_previousresult) / ((sa_currenttimeinms - sa_previoustimeinms) / 1000) < 5 
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The example formula gives a down if there are five or more errors per second that were added 
between the last two cycles of this entry. 

Authenticate Before Checking 

Click to enable authentication before the check starts. 

The user performing the service check needs to have at least power-user rights on the 
computer that is checked. For the process checking you need administrator rights. This means 
that, when Servers Alive runs within the context of user_1, user_1 must have power-user or 
administrator rights on the computer that is checked. 

If user_1 does not have sufficient rights, you can specify another user name, usually in the form 
domain\username, and password of a user with power-user or administrator rights on the 
computer that is checked. 

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

Registry Entries 

The perfmon check sometimes fails or gives unexpected values due to timing issues with the 
performance counters retrieval DLL. By default the timeout is set to 1000ms. You can change 
the timeout by creating the following registry entry and giving it a value between 1 and 10000 
(milliseconds). Remember the value is in ms and the default is already 1000, so you should 
make the change with numbers higher than 1000. 
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\PerfmonTimings (string) 

The various Windows checks can return errors in the log. Some common errors follow: 

5 Access denied. 

53 The network path was not found. 

1219 Multiple connections to a server or shared resource by the same user, using more 
than one user name, are not allowed. Disconnect all previous connections to the server or 
shared resource and try again. 

1220 An attempt was made to establish a session to a network server, but there are 
already too many sessions established with that server. 

1312 A specified log on session does not exist. It might already be terminated. 

1322 No mapping between account names and security IDs was completed. 

1323 The value provided as the current password is incorrect. 

1324 The value provided contains values that are not allowed in passwords. 

1325 The value provided does not meet the length, complexity, or history requirement of 
the domain. 

1326 Unknown user name or bad password. 

1327 User account restriction. 

1328 Account logon time restriction violation. 

1329 The user is not allowed to log on to this computer. 

1330 The specified account password has expired. 

1331 The account is currently disabled. 

1722 The RPC server is unavailable. 

Usually, Servers Alive de-authenticates at the end of any check cycle that includes 
authentication. If this does not succeed, it can cause any subsequent checks to fail. To force an 
authentication disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword). Value of 1 turns this feature 
on. 

If any error code found within this comma separated list occurs during the authentication phase, 
Servers Alive still sees the authentication as being successful. This is not a guarantee that the 
check will pass. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 
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Info 

Displays the values of the variables as they are used in a formula. 

In This Section 

Select Counter Dialog Box 

 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box)  

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

When you use an NT perfmon check, you can select the performance object, counter, and 
instance to use in the check. For example, you can check .NET CLR Exceptions, # of Exceps 
Thrown, _Global_. 

To open this dialog box, select the following items from the Main window: 

Add button > Entries dialog box > Check tablist: NT Perfmon > Browse button. 
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See Also 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

5.2.2.10 Check Tab: Diskspace Option (Entries 
Dialog Box) 

 

Check 

Enter the item to check. Servers Alive can check to ensure enough disk space exists on a 
specific Windows network share. The name of the resource must be given as \\server\share. 

And Alarm When Less Than ____ _____ 

Enter the conditions for performing the check. Servers Alive sends you an alarm when the free 
space is less than x. You must also select the units: Bytes, Kilobytes (KB), Megabytes (MB), 
Gigabytes (GB), Terabytes (TB), or Percentage. 
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For example, if you want an alarm when less than 25 kb of the diskspace is available, you 
should type 25 in the box and select Kilobytes in the list. If you want an alarm when less than 
5% of the disk space is available, then enter 5 in the text box and select Percentage in the list. 

Authenticate Before Checking 

Click to enable authentication before the check starts. 

The user performing the service check needs to have at least power-user rights on the 
computer that is checked. For the process checking you need administrator rights. This means 
that, when Servers Alive runs within the context of user_1, user_1 must have power-user or 
administrator rights on the computer that is checked. 

If user_1 does not have sufficient rights, you can specify another user name, usually in the form 
domain\username, and password of a user with power-user or administrator rights on the 
computer that is checked. 

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

The exact byte value of KB/MB/GB/TB can be changed in the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\kb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\mb (string value) 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\gb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\tb (string value) 

By default, Servers Alive selects the next available drive letter to connect with when performing 
a disk space check. You can force Servers Alive to use a specific one if you choose. 

HKLM\SOFTWARE\DBU Consulting\Servers Alive\StartUp\ForcedDriveLetter (string value) 

When performing a disk space check, the %e parameter contains the actual free space on the 
share that is checked. If the compare value is given in MB, the %e parameter is also in MB. 
However, if the compare value is given as a percentage, the %e is in bytes. You can now 
control how %e is returned when checking by a percentage by editing this registry value: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\DiskSpace\PercentageMeasure (string) 

Possible values: KB, MB, GB, TB, %. The default value is MB. 

Please note that authentication based on the settings of a PERSON (i.e.central user 
management for Windows authentication) is now possible in this version. 

 See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 
Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 
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Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.11 Check Tab: URL (HTTP/HTTPS) Option 
(Entries Dialog Box) 

 

Servers Alive can perform a URL (Universal Resource Locater) check based on the HTTP 
(web) and HTTPS (secure web) protocol. 

With "no proxy" selected, this also works on an ipv6 website (as long as ipv6 is installed on the 
system running Servers Alive). Servers Alive first queries the DNS to get the hostname's IPv6 
IP address, or failing that, an IPv4 IP address. 

Servers Alive treats as bad responses those web pages where the content length given in the 
header exceeds that of the returned page. For changing this, see below. 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AcceptIncompleteResponses. 

To use the URL check, you should have a temp directory with write access to it. To 
accommodate this requirement, the URL (HTTP/HTTPS) check creates a file in the same 
directory that you installed Servers Alive. The file is named _temp_for_url.tmp. 

In the first box of the check, you should enter a URL for the web page, as in the following 
examples: 

http://www.mydomain.com/sub-dir/page.html 

https://www.mydomain.com/sub-dir/page.html 
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If you add the yyyy-mm-dd parameter to the string for the URL, the parameter is translated. For 
example, the following string 

http://www.domain.com/Log/{yyyy-mm-dd}.html 

Becomes the following: 

http://www.domain.com/Log/2005-03-23.html 

You can use the following values for the date and time, surrounded by { and }: 

dd day 

mm short month (01) 

yy short year (02) 

Mmmm long month (January) 

yyyy long year (2002) 

The default URL check will check for a status code (within the received header) of 200, and 
once that is received it will continue with the other checking options of the URL check. 
However, in some cases, it might be important to just check for a different status code. This can 
be done by selecting the “status code” option and entering the required status code. 

In some cases the web page you are checking, only returns a number (could be a temperature 
for example). With the FORUMA check box you can check if this is within a specific range. For 
example: sa_currentresult>10 and sa_currentresult<50. 

For both the HTTP and the HTTPS check, Servers Alive can connect to the remote server 
using a proxy server. This proxy server is defined in the Proxy branch of the Setup 

You can enter the conditional settings to perform the check. 

You can select Get or  in the dropdown list to implement a check with either a get or a post 
action. 

You can also select Head in the dropdown list to check for a string in the header of the received 
web page, according to the conditionals that you enter in the next boxes. 

For both the HTTP and the HTTPS check, Servers Alive can also check whether the content of 
the retrieved page is correct or not. To use this functionality, you must use the Should contain 
or Shouldn't contain option in combination with a word or sentence that should or should not 
be in the retrieved web page. 
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The following list shows the results for different options: 

And if you select this 
option 

 And this 
option 

 You get this result 

Should Contain   All of These 
Words 

  Each of the words should be in the page to 
get an up reading. 

Should Contain   Any of These 
Words 

  At least one of the words should be in the 
page to get an up reading. 

Should Contain   This Exact 
Phrase 

  This phrase, with the exact words in the 
exact order, must be in the page to get an 
up reading. 

Should Not Contain   All of These 
Words 

  If all of the indicated words are in the page, 
a down reading results. 

Should Not Contain   Any of These 
Words 

  If any of the words appear in the page, a 
down reading results. 

Should Not Contain   This Exact 
Phrase 

  If the exact words appear in the page in the 
exact order, a down reading results. 

CRC   Perform a Cyclic Redundancy Check. This is useful to ensure 
the integrity of data transmission or that a file or data is un 
modified. 

A new algorithm significantly boosts the performance of the CRC check. 

You can also select This Exact Phrase, All of These Words, or Any of These Words to 
determine conditions for the sentence or phrase that you use to check the content of the page. 
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This list appears if you select Should Contain or Shouldn't Contain in the previous list. Use 
the hex code {0x0a} to add line feeds to the string, for when the expected information is spread 
on several lines. 

In the content check string, you can have a value that is based on the current date. To do this, 
add a string that is surrounded by { and } and contains some of the following keywords: 

dd day 

mm short month (01) 

yy short year (02) 

Mmmm long month (January) 

yyyy long year (2002) 

For example, "{dd-mm-yy}" translates to "22-01-02", and "{dd Mmmm yyyy}" would translate to 
"22 January 2002". 

In the dropdown list, if you select Site SSL Certificate or CA's SSL Certificate, you can 
implement client certificates for the check. You can then enter the number of days to check that 
the certificate is valid. 

Data to Post 

Appears when you select Post in the list box. You can enter the data that needs to be posted in 
the following format: 

VAR1=value1&VAR2=value2 

CRC on binary file 

Appears when you select CRC in the dropdown list. Perform a CRC check on a binary file, 
ignoring the absence of the <BODY and </BODY> tags. If left unselected, a CRC on a binary 
file returns an up as long as the page exists. If the requested file does not exist, you get a 
down. 

Reset CRC after Each Check 

Appears when you select CRC in the dropdown list. This check box ensures that the CRC 
feature is reset after each check cycle. 

Still Valid for ___ Days 

Appears when you select Site SSL Certificate or CA's SSL Certificate in the dropdown list. 
Enter the number of days for the software to check that the certificates, that you get through the 
given URL, are still valid. This option does not implement client-side certification. 

You can load a KEYfile and a CERTfile for the individual HTTP(S) check. You have to edit the 
entries file for it however. 

#SSLKEYFILE=c:\directory\keyfile.ext#SSLKEYPWD=password#SSLCERTFILE=c:\directory\c
ertfile.ext#SSLCERTPWD=password# 

If you're using a PFX file, the SSLKEYFILE and SSLCERTFILE parameter must point to the 
same file, and both the SSLKEYPWD and SSLCERTPWD must be the same. 
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Password Protected Page 

Click to enable a page that is protected by a password. 

Username 

Enter the user name. 

Password 

Enter the password. 

No Proxy 

Click to disable proxy authentication. Click the check box when you have a direct connection to 
the Internet to retrieve a web page. This is required for an ipv6 website. However, some 
companies or Internet service providers force people to use a proxy server. In these cases, you 
must define the proxy server settings by clicking File > Setup and then click the General 
branch of the tree and select the Proxy branch. You can now use these settings within the 
HTTP/HTTPS checks. 

HTTP Version to Use 

Select the version of HTTP that Servers Alive uses to complete a check. You can select either 
Version 1.0 or 1.1. Many servers use Version 1.1. However, for compatibility, the default setting 
HTTP 1.0 is recommended. 

Don't ignore bad certificates 

Respond to certificate errors. The default is to ignore these. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message in the output log or message displays T if you click 
this check box. If the check box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 
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Info 

Displays the values of the variables as they are used in a formula. 

Registry Settings 

By default, the software interprets a space as a word separator. To change this, enter the 
following registry setting: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URL_Word_Separator (string) 

Servers Alive performs the check in a case-sensitive way when you click Should Contain in 
the previous list. This can be changed by adding or editing the following registry value: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URLContentInsensitive (dword) 

1 = case insensitive 

0 = case sensitive (default) 

A CRC (checksum) check of a URL (HTTP/HTTPS) check retrieves the web page and 
calculates a CRC on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. 

The CRC check can automatically reset the CRC after each cycle. An altered page generates 
only one down cycle and the next up again. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartTAG (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndTAG (string) 

You can still exclude some parts too between those two tags, as they are often used for 
changing data like a date or time. 

All text in between the following tags is not used for the CRC calculation: 

<!--- SA Ignore --> <!--- SA Resume --> 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartIgnoreTAG (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndIgnoreTAG (string) 

You can log all communication during an HTTP/HTTPS check to a file so that you can debug 
the process. Edit the following registry entries: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTP (dword) 

Enter a value of 1 to enable this feature. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTPFIle (string) 
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Enter the path and name of the file log. 

Servers Alive treats as bad responses those web pages where the content length given in the 
header exceeds that of the returned page. For changing this, see 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AcceptIncompleteResponses. 

Editing the Entries File 

Usually, Servers Alive uses one set of UserAgent/SecurityFlag/AdditonalHeaders for all URL 
(HTTP/HTTPS) checks. However, if for some reason you want to change them for one or more 
entries, you can do this by opening and editing the entries file directly. 

An example without additional parameters is: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CON=#AUTH=F#USR=#P
WD=#PRX=F#COO=F#"#ADPA=""#TIME=10#SK=F# 

An example with additional parameters is: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CON=#AUTH=F#USR=#P
WD=#PRX=F#COO= 

This is a CORRECT example. 

Within the "string," you get a #ADPA="; all information after that, until the next ", is for additional 
parameters. Currently you can use several additional parameters: 

USERAGENT 

HTTPSECURITYFLAGS 

ADDITIONALHEADERS 

ACCEPTLANGUAGE 

SSLCERTSUBJECT 

SSLCERTSTORE 

SSLKEYPWD 

SSLKEYEPWD 

SSLCERTFILE 

SSLCERTPWD 

SSLCERTEPWD 

An example that uses two of the parameters is: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CON=#AUTH=F#USR=#P
WD=#PRX=F#COO=F#"#ADPA="#USERAGENT=NSPlayer/7.1.0.3055#ACCEPTLANGUAG
E=en-us#ADDITIONALHEADERS=Accept-Encoding: gzip, 
deflate#"#TIME=10#SK=F# 

The {0d}{0a} is needed if you want to send several different additional headers. 
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This is an updated example. 
#TYPE=U#PARA="#URL=http://www.woodstone.nu#CCO=CON#CON=#AUTH=F#USR=#PW
D=#PRX=F#COO 

You can also specify SSLCERTSTORE and SSLCERTSUBJECT so that Servers Alive 
presents a client-side certificate to the server when making the connection. 

For example, within the host file for a URL check, you get the following example of a simple 
URL check of http://www.woodstone.nu without contains or authentication and a simple GET: 

#TYPE=U#PARA="#URL=http://www.woodstone.nu#CCO=CON#CON=#AUTH=F#USR=#
PWD=#PRX=F#COO=F#CRS=F#HCT=GET#HDT=#"#ADPA=""#TIME=5#SK=F#SEV=emerge
ncy# 

If you want a different user agent for this specific check than what Servers Alive would usually 
implement, then you can change it with the following example: 

#TYPE=U#PARA="#URL=http://www.woodstone.nu#CCO=CON#CON=#AUTH=F#USR=#PW
D=#PRX=F#COO=F#CRS=F#HCT=GET#HDT=#"#ADPA="#USERAGENT=A new 
useragent#"#TIME=5#SK=F#SEV=emergency# 

In the example, instead of "#ADPA=""#, you get the following: 

"#ADPA="USERAGENT=A New useragent#"# 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 
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Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.12 Check Tab: Database (Microsoft SQL) 
Option (Entries Dialog Box) 

 

Servers Alive can check the availability of a Microsoft SQL Server database. To perform this 
check, the software uses the SMO object which must be installed separately. They can be 
found within the SQL Server PowerPack; you will need both the 
ENU\x86\SharedManagementObjects.msi and the ENU\x86\SQLSysClrTypes.msi files to be 
installed. 

When you want to check a Microsoft SQL database, you must provide the name of the 
database, the user name, and the password that is used to connect to the database. The SQL 
server name is the host name. If you have both multiple clients installed, you can select which 
client Servers Alive should use. 

The SQL SMO-based check will work with SQL versions 2000SP4 and more recent (tested up 
to SQL2014/SQL-Azure). 

SQL Server 

Click to use SQL Server. These options are available only if you have the Microsoft SQL SMO 
libraries installed on your computer. 
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Database 

Enter the name of the database. 

Username 

Enter the username to connect to the database. 

Password 

Enter the password to connect to the database. 

Timeout 

Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the 
checkbox is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 
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Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.13 Check Tab: Database (Oracle) Option 
(Entries Dialog Box) 

 

Servers Alive works only with Oracle by Oracle Corporation and not any other brand. 

Servers Alive can check the availability of an Oracle database. To do this, the software uses 
the Oracle OLE object, which is part of the Oracle client. Servers Alive supports Oracle 7, 
Oracle 8, 8g, 8i, 9i, and 10g clients. With Oracle 9i and 10g, you must install the Oracle 
Windows Interface included with Oracle. In most cases, a full installation of the Oracle client is 
needed. When you want to check an Oracle database, you must provide the name of the 
database, the user name, and the password that are used to connect to the database. 

Oracle Server 

Click to use an Oracle server. These options are not available unless you have installed the 
Oracle OLE (object linking and embedding) libraries. 
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Database 

Enter the name of the database that you want to connect to. 

 

Username 

Enter the user name to connect to the database. The database name is a name that is defined 
within the TNSNames.ora file. For more information on how to configure entries in the 
TNSNames.ora file, please consult your Oracle documentation. 

Password 

Enter the password to connect to the database. 

Test 

Click to perform a test check based on the information that you have entered in this dialog box. 
The result displays on the dialog box. This is convenient when you want to ensure that a check 
that you create works. 

Timeout 

Enter the length of time for the timeout in seconds. This option appears only when you select 
an entry in the main window and click Edit. 

Info 

Displays the values of the variables as they are used in a formula. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 
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Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

 

5.2.2.14 Check Tab: SNMP Option (Entries Dialog 
Box) 

 

Servers Alive can check the status of a device or host with the Simple Network Management 
Protocol (SNMP). The software checks if the value of a certain OID is one of the following: 

Is less than a value, 

Is greater than a value, 

Is equal to a value, 

Is different from (<>) a value, 

Contains a value, 

Does not contain a value, 
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If the result of a formula is true or false. 

Servers Alive can, within one check, retry several times to get an answer from the host. 

To get a list of valid OIDs for your SNMP-enabled devices, you should contact the vendor of the 
device. They can give you an MIB file that contains all the OIDs for the device. 

An OID is a dotted numeric string that identifies an object. Typical objects that can be identified 
using OIDs include: attributes in X.500/LDAP-based directories, certificate policies and practice 
statements, MIBS for network management, and encryption algorithms. Two objects are 
considered to be the same only if they have the exact same OID. 

Check ___ And Alert When the Result _____ _________ 

Enter the host name or object identifier (OID) that you want to check. Examples are the 
following: 

-1.3.6.1.2.1.1.1.0 

1.3.6.1.2.1.1.3.0 

To check special characters, enter the appropriate hexadecimal value in the Check box and 
then select one of the following items in the dropdown list for And Alert When the Result: 

This option Means this 

Is < than Is less than a value. 

Is > than Is greater than a value. 

Is=to Is equal to a value. 

Is <> than Is different from (<>) a value. 

Contains Contains a value. 

Doesn't Contain Does not contain a value. 

Formula Contains a result of a formula that is false. 

When you select Formula from the list, you can use the following parameters to check the 
result of a formula: 

sa_currentresult = the result of the get operation. 

sa_previousresult = the result of the previous get operation. 

sa_currenttimeinms = the current time in milliseconds. 

sa_previoustimeinms = the time of the previous get operation in milliseconds. 

You can create formulas using these parameters and have Servers Alive give a down when the 
result of the formula is false. For example, you can check the number of errors that occur in a 
network interface with the following formula: 

(sa currentresult - sa_previousresult) / ((sa_currenttimeinms - sa_previoustimeinms) / 1000) < 5 
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The example formula gives a down if there are five or more errors per second that were added 
between the last two cycles of this entry. 

To create a second rule that works with the first rule, click the check box that immediately 
follows the boxes for the first rule and enter conditionals. For example, you can create a check 
that sends a message when the OID < 45 or OID > 60 or alert when the OID > 45 and OID > 
60. 

Test It 

Click to perform a test check based on the information that you have entered in this dialog box. 
The result displays on the dialog box. 

Community String 

Enter the appropriate community string for the server. You must enter the community string for 
the SNMP check for authentication purposes. An SNMPv1 community string serves as a 
password. By default, on most SNMP systems, this is PUBLIC; however, the community string 
can be different on your systems. 

SNMP Version 

Allows you to select the version of SNMP. If you select SNMPv3, you can click the Set 
Authentication button and enter the user name, password, and type of authentication in the 
SNMPv3 Authentication Parameters dialog box. 

Set Authentication 

Click this button to enter settings for SNMP version 3 when you click the SNMPv3 option on the 
SNMP Version list. 

Advanced 

Click this button to enter settings for an SNMP SET. The SNMP GET check can do an SNMP 
SET before performing the SNMP GET. You can enter values on the Advanced Settings for 
SNMP Checks dialog box. 

SNMP Port 

Enter the SNMP port number. The default standard port number is 161. However, for security 
purposes, you can enter a different, non-standard port number. 

The dropdown list determines whether the results of the SNMP check are converted to a text 
representation. This determines how information is displayed in the MIBs database. 

Don't Convert Received Result to Text - Specifies that the result of the check remains a 
numeric value. 

Convert Received Result to Text - Determines if the result of the SNMP check is 
converted to text. For example, .1.3.6.1.2.1.2.2.1.7 is the following: 

ifAdminStatus 

1 means up. 

2 means down. 
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3 means testing. 

Convert Received Result to HEX Representation - Changes the received result to a 
hexadecimal value. Each character is replaced by the appropriate two-byte hexadecimal 
value, representing the ASCII text value of the character. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 300 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> displays T if you click this check box. If the check box is clear, <sa_inverted> 
displays F. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and you have clicked the 
check box, the software rechecks the host at the end of the check cycle to verify that the host is 
down. This feature is useful if you have slow links or computers with slow responses. 

 

SNMPv3 Authentication Parameters 
Dialog Box 

Advanced Settings for SNMP Checks 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box)  

Check Tab: NT Perfmon Option (Entries Dialog Box)  

Check Tab: Diskspace Option (Entries Dialog Box)  

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries 
Dialog Box) 
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Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box)  

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box)  

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.14.1 SNMPv3 Authentication Parameters Dialog 
Box 

 

User Name 

Enter the user name for the SNMP device. 

Password 

Enter the password for the SNMP device. 

Authentication 

Select the type of authentication for the device: HMAC-MDS-96 or HMAC-SHA-96. 

Priv. Password 

Enter the authentication password. 

See Also 

Check Tab: SNMP Option (Entries Dialog Box) 

Advanced Settings for SNMP Checks 

5.2.2.14.2 Advanced Settings for SNMP Checks 
This dialog box allows you to enter settings for an SNMP SET. The SNMP GET check can do 
an SNMP SET before performing the SNMP GET. You can enter values for up to three SET 
processes. 
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You can use SNMP versions 1 and 2 to perform an SNMP SET before a GET. You cannot 
perform the SET with SNMP version 3. 

 

Do These SNMP SETs Before Doing the SNMP GET 

Click this check box to enable this feature. You can enter values in this dialog box only when 
you click this check box. 

OID 

Enter the object identifier (OID) that you want to check. 

Value 

Enter the value for the object. 

Community 

Enter the community string. The default value is "public." You must enter the community string 
for the SNMP check for authentication purposes. An SNMPv1 community string serves as a 
password. By default, on most SNMP systems, this is PUBLIC; however, the community string 
can be different on your systems. 

SNMP Version 

Click the version that you want to use to perform the SET before the GET from the dropdown 
list. You can select SNMP Version 1 or Version 2. You cannot perform a SET before the GET 
using SNMP Version 3. 

See Also 

Check Tab: SNMP Option (Entries Dialog Box) 

SNMPv3 Authentication Parameters Dialog Box 
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5.2.2.15 Check Tab: Hyper-V (Entries Dialog Box) 

It's important to select the correct version of Hyper-V else the check won't work. 

The check will give an UP (without invert) if the parameter matches the criteria you're giving. 

 
  
See Also 

  

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 
Check Tab: TCP Protocol Option (Entries Dialog Box) 
Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 
Check Tab: Ping Option (Entries Dialog Box) 
Check Tab: Radius Protocol Option (Entries Dialog Box) 
Check Tab: NT Service Option (Entries Dialog Box) 
Check Tab: UDP Protocol Option (Entries Dialog Box) 
Check Tab: NT Process Option (Entries Dialog Box) 
Check Tab: NT Perfmon Option (Entries Dialog Box) 
Check Tab: Diskspace Option (Entries Dialog Box) 
Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 
Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 
Check Tab: Database (Oracle) Option (Entries Dialog Box) 
Check Tab: SNMP Option (Entries Dialog Box) 
Check Tab: External COM Option (Entries Dialog Box) 
Check Tab: External (Errorlevel) Option (Entries Dialog Box) 
Check Tab: Remote Agent Check (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.16 Check Tab: VMWare (Entries Dialog Box) 

The check will give an UP (without invert) if the parameter matches the criteria you're giving. 

Should works with ESXi5.0 and more recent. 

This feature is available only in the Enterprise edition. This feature is also available in the Free 
version for evaluation purposes. 

 
  
See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 
Check Tab: TCP Protocol Option (Entries Dialog Box) 
Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 
Check Tab: Ping Option (Entries Dialog Box) 
Check Tab: Radius Protocol Option (Entries Dialog Box) 
Check Tab: NT Service Option (Entries Dialog Box) 
Check Tab: UDP Protocol Option (Entries Dialog Box) 
Check Tab: NT Process Option (Entries Dialog Box) 
Check Tab: NT Perfmon Option (Entries Dialog Box) 
Check Tab: Diskspace Option (Entries Dialog Box) 
Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 
Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 
Check Tab: Database (Oracle) Option (Entries Dialog Box) 
Check Tab: SNMP Option (Entries Dialog Box) 
Check Tab: External COM Option (Entries Dialog Box) 
Check Tab: External (Errorlevel) Option (Entries Dialog Box) 
Check Tab: Remote Agent Check (Entries Dialog Box) 
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Check Tab: Hyper-V (Entries Dialog Box) 

5.2.2.17 Check Tab: Netware Option (Entries 
Dialog Box) 

 

Servers Alive works only with Novell Netware Client, and not the Microsoft Netware client. 

Servers Alive can check several parameters on your Netware server. For these checks, the 
software uses the Novell Netware client. If this client is not installed, the Netware check options 
are not available. 

Servers Alive can check: 

The number of active connections on the Netware server. 

The CPU usage of the Netware server. 

The number of mounted volumes. 

You can configure Servers Alive to send an alarm to you when the returned number is less than 
(<), greater than (>), equal to (=), or different from (<>) a base-value. 

The Netware checking only gives a valid result when you are currently connected to the 
Netware server you are checking. 

You can now configure Servers Alive to use Netware Version 5 volume checks by setting the 
following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\ServersAlive\StartUp\NetwareVolumev5 (string) to 1. 

Alarm When ____ is _____ Than _______ 

Enter the conditional settings for the check. 

Timeout 
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Enter the length of time for the timeout in seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

 Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

 Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
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Check Tab: VMWare (Entries Dialog Box) 

5.2.2.18 Check Tab: External COM Option (Entries 
Dialog Box) 

 

Configure 

Click the Configure button to change the parameters. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 600 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

Info 
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Displays the values of the variables as they are used in a formula. 

COM links 

External Check Samples: COM-based 
Checks 

COM ODBC (ODBC Query Addon) 

Remote DF COM (*NIX Diskspace Check) 

Remote PS COM (*NIX Process Check) 

FileSize Check 

SMTP2POP3 COM (Mailflow Check) 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog 
Box) 

Check Tab: TCP Protocol Option (Entries Dialog 
Box) 

Check Tab: URL (RTSP/MMS) Option (Entries 
Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries 
Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog 
Box) 

Check Tab: NT Process Option (Entries Dialog 
Box) 

Check Tab: NT Perfmon Option (Entries Dialog 
Box) 

Check Tab: Diskspace Option (Entries Dialog 
Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries 
Dialog Box) 

Check Tab: Database (Microsoft SQL) Option 
(Entries Dialog Box)  

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries 
Dialog Box) 

Check Tab: Remote Agent Check (Entries 
Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.2.19 Check Tab: External (Errorlevel) Option 
(Entries Dialog Box) 

 

Servers Alive has many built-in check types, but Servers Alive cannot support all possible 
check types. To extend the functionality of Servers Alive, you can use the External (Errorlevel) 
check option. With an external check, Servers Alive uses an external application to perform an 
action and, based on the returned errorlevel, flags the host entry as being up or down. 

Within the command line that Servers Alive must execute for this external check, you can use 
variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 
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%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).If you want to test an external check that you wrote without the use of 
Servers Alive, you can use checkerrorlevel.exe. This small tool is installed by the Servers 
Alive Setup program in the Servers Alive directory. It runs your application and displays the 
error level your application returns. 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

For more information about checkerrorlevel.exe, see External Checks. 

Alarm When the Errorlevel Returned By 

Enter the conditional settings for the check. 

Kill the External Application When Not Stopped in Time 

Shuts down the external application after the timeout has expired. If the external application has 
not returned an errorlevel to Servers Alive within the given timeout, Servers Alive flags the host 
entry as down. The external application continues to run. Servers Alive can, in such a situation, 
kill, or shut down, the external application after the timeout has expired. 

Timeout 

Enter the length of time for the timeout in seconds. The maximum timeout is 600 seconds. 

Info 

Displays the values of the variables as they are used in a formula. This option appears only 
when you select an entry in the main window and click Edit. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

<sa_inverted> in the output log or message displays T if you click this check box. If the check 
box is clear, <sa_inverted> displays F. 
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Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box)) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog 
Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: Remote Agent Check (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

External 

External Checks: Error Level) 

5.2.2.20 Check Tab: Remote Agent Check (Entries 
Dialog Box) 
A remote agent enables you to perform checks without needing to open up unsecure protocols 
in your firewall (see Agents (Setup Dialog Box). 

The check involves Servers Alive contacting the remote agent (based on the setup settings) 
with a list of parameters as specified in this screen and requesting a check. The remote agent 
returns an OK/NOT-OK and some text-information regarding the result. 
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Select the agent name from the dropdown. 

For setting up a remote agent, see Agents (Setup Dialog Box). 

Click Configure to configure the check. This queries the remote agent for possible check types. 
Select one and supply parameters as prompted. 

Timeout 

Enter the length of time for the timeout in seconds. 

Invert Status 

Click this check box to reverse the status at the end of the check; for example, the status would 
be reversed from up to down or from down to up. The inversion does not occur until the end of 
the check. All checks up to the point proceed as usual. The check box is clear by default. 

Second Knock 

Enables second knock. If the software detects a host as down during a check cycle and you 
have clicked the Second Knock check box, the software rechecks the host at the end of the 
check cycle to verify that the host is down. This feature is useful if you have slow links or 
computers with slow responses. 

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

Check Tab: URL (RTSP/MMS) Option (Entries Dialog Box) 

Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 
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Check Tab: NT Service Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 

5.2.2.21 Check Tab: Combined Check 
This combined or complex check allows you to combine the result of several other check 
entries of Servers Alive. 

 

[224] 
 



Servers Alive 8 

  

See Also 

Check Tab (Entries Dialog Box) 

Check Tab: DNS Protocol Option (Entries Dialog Box) 

Check Tab: TCP Protocol Option (Entries Dialog Box) 

 Check Tab: Ping Option (Entries Dialog Box) 

Check Tab: Radius Protocol Option (Entries Dialog Box) 

Check Tab: UDP Protocol Option (Entries Dialog Box) 

Check Tab: NT Process Option (Entries Dialog Box) 

Check Tab: NT Perfmon Option (Entries Dialog Box) 

Check Tab: Diskspace Option (Entries Dialog Box) 

Check Tab: URL (HTTP/HTTPS) Option (Entries Dialog Box) 

Check Tab: Database (Microsoft SQL) Option (Entries Dialog Box) 

Check Tab: Database (Oracle) Option (Entries Dialog Box) 

Check Tab: SNMP Option (Entries Dialog Box) 

Check Tab: Netware Option (Entries Dialog Box) 

Check Tab: External COM Option (Entries Dialog Box) 

Check Tab: External (Errorlevel) Option (Entries Dialog Box) 

Check Tab: Hyper-V (Entries Dialog Box) 
Check Tab: VMWare (Entries Dialog Box) 
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5.2.3 Alert Tab (Entries Dialog Box) 

 

Servers Alive supports a rich variety of alerting mechanisms. It supports various email alerting 
options, numeric and alphanumeric paging, audible alerts, and more. You can even write your 
own custom alerting software or use built-in Windows messaging to send popup alerts. Servers 
Alive is also capable of taking remedial action when it determines that a server is down, by 
executing scripts that you create. Finally, Servers Alive allows you to easily collect alerting 
events in a central logging server by use of the standard syslog logging mechanism available 
on UNIX® and Windows servers, with third-party software. 

You can select an alert and click one of the arrow buttons to the right of the list to change the 
order of alerts. This moves the alert up or down one line in the list order. 

Use the following buttons to add, edit, or delete alert settings: 

Add 

Edit 

Delete 

When you select a type of alert, such as SNPP or Numeric Page, you can set the schedule for 
Servers Alive to send each type of alert on the Schedule tab of the Add/Edit Alert 

If you select an option that sends a page, Servers Alive queues multiple pages, but sends only 
one page at a time. So if there are three pages in the queue, Servers Alive connects to the 
paging company for the first page, sends the page, and disconnects from the paging company. 
The software then re-connects to the paging company, sends the second page, and 
disconnects, and so forth. 
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Registry Settings 

 

D – Drive Space 

E – External check 

F – Perfmon 

I – UDP 

M – SNMP 

N – Netware 

O –Oracle 

P – Ping 

Q – MS-SQL 

R – Process 

S – Windows Service 

U – URL 

X – IPX Ping 

W – Winsock port (TCP) 

Under each of the single letter keys, you can find numbered string values. Each one of these 
represents a particular status keyword, as follows: 

1 – down 

2 – possibly down 

3 – unavailable 

4 – maintenance 

5 – up 

6 – unchecked 

7 – possibly unavailable 

If you want to allow Servers Alive to use "-" and "+," instead of "down" and "up" for all pings, 
you must set the following registry entries: 

HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status\P\1 = "-" (string) 

HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status\P\5 = "+" (string) 
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In This Section 

Add/Edit Alert Dialog Box 

5.2.3.1 Add/Edit Alert Dialog Box 

 

You can display this dialog box when you click the Add or Edit button on the Alert tab of the 
Entries dialog box. The options of the  tab of the Add/Edit Alert dialog box are different, 
depending on the option you select when you click the Add button on the Entries dialog box. 

When you add an entry, you can enable the individual alert entry in the Main window by 
clicking the check box that appears next to the entry. You can disable the alert entry by 
clearing the check box. 

The following list shows the different options that appear on the What tab when you select an 
option: 

What Tab: Send SMTP Mail (Primary) 

What Tab: Send SMTP Mail (Alternate) 

What Tab: Send Other Mail 

What Tab: Alpha Page/SMS 

What Tab: Send Network Page (SNPP) 

What Tab: Send Network Page (SMPP) 
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What Tab: Generate NotePager - PageGate Message File 

What Tab: Numeric Page 

What Tab: Execute Command 

What Tab: Sound 

What Tab: Send HTTP(S) GET/POST 

You can select the next four items when you click the Add button and select the Instant 
Message menu. 

What Tab: Send MSN Message 

What Tab: Send XMPP Jabber Message 

What Tab: Send WinPOPUP Message 

What Tab: Send SNMP Trap 

What Tab: Do an SNMP SET 

The dialog box also displays the following tabs: 

Schedule Tab (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

You can open the following tab when you click File > Setup and select Built-in Servers > 
SNMP Trap Receiver in the tree. You can then click the Add button to add an alert and set 
options on the Trap Alert tab. 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

In This Section 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert 
Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

See Also 

Alert Tab (Entries 
Dialog Box) 
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What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.1.1 What Tab: Send SMTP Mail (Primary) 
Add/Edit Alert Dialog Box 
 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 
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SMTP (Simple Mail Transfer Protocol) alerting is probably the most common alerting. SMTP is 
used to send email messages to you when the software detects a down condition. You should 
use this as a minimum level of reporting. The SMTP option is enabled only if you configure the 
global SMTP options from the SMTP branch of the Setup dialog box. 

You can give a primary and an alternate list of recipients for each host. If the message must be 
sent to several email addresses, you can separate them with a comma; for example: 

user1@company.com,user2@company.com. 

You must provide the global SMTP settings for both primary and alternate SMTP entries in the 
SMTP branch of the Setup dialog box before you can enter any individual host settings. 

Servers Alive can send direct mail. Based on the TO part of the mail, Servers Alive queries for 
the MX record and contacts the first server that is on the list to send mail. The computer 
running Servers Alive must access the Internet on port 25, or, rather, access SMTP servers on 
the Internet. The computer must also perform DNS queries to get the MX records. 

WHAT 
Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

Using 
Allows you to set conditionals for the message that the alert sends. 

To 
Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts branch 
of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 
Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Subject 
Enter the information that you want to appear in the Subject line of the alert message. 

Message (Body) 
Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 
%p for the pretty name. 
%s for the status. 
%t for the last check time. 
%d for the date. 

[231] 
 



Servers Alive 8 

%u for the unique ID of the host. 
%w for the IP address of the host that the software checks, if known. If the IP address is 
ot known, the host name is used. 
• %c for the complete host/check description. 
%e for extra information. For a URL check, this could contain "404 Not Found" as the 
error message. 
%a for additional information. For a ping check, this is the round trip time. 
%i for hostID; used for numeric paging. 
%z for the status change time. 
%y for the status change date. 
%r for a remark. 
{0d} for chr(13) for a carriage return. 
{0a} for chr(10) for a line feed. 
{09} for a TAB 
%o (letter o) for a description of the actual check 

You can set a different priority on the mail if the alert is for a DOWN or an UP. 

Registry Settings 
You can add a custom footer message to all messages sent by Servers Alive. To do this, add 
or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string) 

To remove the date/time from the mails, you must add or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail(dword) value 1 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send ICQ Message (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 
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What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 
What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
 

5.2.3.1.1.1 Select a Team to Add Dialog Box 
You can add a person to appear as the recipient of an alert. 
To open this dialog box, click the following path in the Main window: 

Add button > Entries dialog box > Alert tab > Add button > An option on the list > Add/Edit 
Alert dialog box > Add> Team 

 
This feature is available when you select one of the following options on the Add button: 

Send SMTP Mail (Primary) 
Send SMTP Mail (Alternate) 
Alpha Page/SMS 
Send Network Page (SNPP) 
Send Network Page (SMPP) 
Numeric Page 
Instant Message > Send MSN Message 
Send WinPopup Message 

 

See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

Select a Person to Add Dialog Box 

5.2.3.1.1.2 Select a Person to Add Dialog Box 
You can add a person to appear as the recipient of an alert. 
To open this dialog box, click the following path in the Main window: 

Add button > Entries dialog box > Alert tab > Add button > An option on the list > 
Add/Edit Alert dialog box > Add> Person 

[233] 
 



Servers Alive 8 

 
This feature is available when you select one of the following options on the Add button: 

Send SMTP Mail (Primary) 
Send SMTP Mail (Alternate) 
Alpha Page/SMS 
Send Network Page (SNPP) 
Send Network Page (SMPP) 
Numeric Page 
Instant Message > Send MSN Message 
Send WinPopup Message 

 

See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

Select a Team to Add Dialog Box 

 

5.2.3.1.2 What Tab: Send Other Mail (Add/Edit Alert 
Dialog Box) 
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To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

Using 

Allows you to set conditionals for the message that the alert sends. 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 

%p for the pretty name 

%s for the status. 

%t for the last check time. 

%d for the date. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. 

%c for the complete host/check description. 

%e for extra information. For a URL check, this could contain "404 Not Found" as the error 
message. 

%a for additional information. For a ping check, this is the round trip time. 

%i for hostID; used for numeric paging. 

%z for the status change time. 

%z for the status change date. 

%r for a remark. 

{0d} for chr(13) for a carriage return. 

{0a} for chr(10) for a line feed. 

{09} for a TAB 

%o (letter o) for a description of the actual check 
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See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
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5.2.3.1.3 What Tab: Send SMTP Mail (Alternate) 
(Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

SMTP (Simple Mail Transfer Protocol) alerting is probably the most common alerting used. 
SMTP is used to send email messages to you when the software detects a down condition. You 
should use this as a minimum level of reporting. The SMTP option is enabled only if you 
configure the global SMTP options from the SMTP branch of the Setup dialog box. 

You can give a primary and an alternate list of recipients for each host. If the message must be 
sent to several email addresses, you can separate them with a comma; for example: 
user1@company.com,user2@company.com. 

Note that you must provide the global SMTP settings for both primary and alternate SMTP 
entries in the SMTP branch of the Setup dialog box before you can enter any individual host 
settings. 

Servers Alive can send direct mail. Based on the TO part of the mail, Servers Alive queries for 
the MX record and contacts the first server that is on the list to send mail. The computer 
running Servers Alive must access the Internet on port 25, or, rather, access SMTP servers on 
the Internet. The computer must also perform DNS queries, to get the MX records. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 
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Using 

Allows you to set conditionals for the message that the alert sends. 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts 
branch of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

 

Enter the information that you want to appear in the Subject line of the alert message. 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 

%p for the pretty name. 

%s for the status. 

%t for the last check time. 

%d for the date. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. 

%c for the complete host/check description. 

%e for extra information. For a URL check, this could contain "404 Not Found" as the error 
message. 

%a for additional information. For a ping check, this is the round trip time. 

%i for hostID; used for numeric paging. 

%z for the status change time. 
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%y for the status change date. 

{0d} for chr(13) for a carriage return. 

{0a} for chr(10) for a line feed. 

{09} for a TAB 

%o (letter o) for a description of the actual check 

You can set a different priority on the mail if the alert is for a DOWN or an UP. 

Registry Settings 

You can add a custom footer message to all messages sent by Servers Alive. To do this, add 
or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string) 

To remove the date/time from the mails, you must add or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) value 1 

With certain versions of the IPHLPAPI.DLL file, you must specify the DNS servers to use when 
querying for the MX records in the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use (string) 

If you do not specify the DNS servers, Servers Alive attempts to determine which DNS servers 
to use. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 
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What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

 Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

 

5.2.3.1.4 What Tab: Alpha Page/SMS (Add/Edit Alert 
Dialog Box) 
 

 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

One paging option is alphanumeric paging or SMS messaging, which involves sending a text-
based message to a cell phone or paging device. In order to send a message to your pager or 
cell phone, Servers Alive needs the phone number, or PIN number, of the device. You must 
also specify the message that Servers Alive sends to the device. 

WHAT 
Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 
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Using 
Allows you to set conditionals for the message that the alert sends. 

 
To 
Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts branch 
of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 
Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message (Body) 
Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

• %h for the host name. 

• %p for the pretty name. 

• %s for the status. 

• %t for the last check time. 

• %d for the date. 

• %u for the unique ID of the host. 

• %w for the IP address of the host that the software checks, if known. If the IP address 
is not known, the host name is used. 

• %c for the complete host/check description. 

• %e for extra information. For a URL check, this could contain "404 Not Found" as the 
error message. 

• %a for additional information. For a ping check, this is the round trip time. 
• %i for hostID; used for numeric paging. 

• %z for the status change time. 

• %y for the status change date. 

• %r for a remark. 

• {0d} for chr(13) for a carriage return. 

• {0a} for chr(10) for a line feed. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 
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What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 
What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
  

5.2.3.1.5 What Tab: Send Network Page (SNPP) 
(Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

If sending an SNPP alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. 
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WHAT 

Add or Edit button on the  tab. 

To Pager ID 

Enter the pager ID that you want the alert message sent to. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Team to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain parameters. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 
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{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
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5.2.3.1.6 What Tab: Send Network Page (SMPP) 
(Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

If sending an SMPP alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

To Pager ID 

Enter the pager ID that you want the alert message sent to. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 
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%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 
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What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.1.7 What Tab: Generic NotePager-PageGate 
Message File (Add/Edit Alert Dialog Box) 
To use NotePager and the protocols that it supports, including SNPP, WCTP, and SMTP, you 
must install the NotePager product from PageGate at the NotePager web site. 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 
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To 

Enter the e-mail address for the message recipient. 

Message (body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 

%o (letter o) gives a description of the actual check. 

See Also 

[248] 
 



Servers Alive 8 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
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5.2.3.1.8 What Tab: Numeric Page (Add/Edit Alert 
Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

Paging is another common alerting method. This important alerting option allows you to receive 
numeric or alphanumeric pages whenever a server is down. Before you can turn this option on 
for any entries, you must have first configured paging in the Setup dialog box. 

Because numeric paging is not based on a real protocol, paging is not a 100% reliable solution. 
Numeric paging uses the settings that are defined in the Numeric Paging branch of the Setup 
tree. The message that is sent to the pager is the host ID, which you can define for each 
individual host. You can also have Servers Alive send an up or down code. You can turn this on 
in the Numeric Paging branch of the Setup tree. 

WHAT 

Displays the type of alert that you selected by clicking the or Edit button on the Alert tab.. 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup Main window and select the Alerts branch of the Setup 
tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 
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Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 

%p for the pretty name. 

%s for the status. 

%t for the last check time. 

%d for the date. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. 

 %c for the complete host/check description. 

%e for extra information. For a URL check, this could contain "404 Not Found" as the error 
message. 

%a for additional information. For a ping check, this is the round trip time. 

%i for hostID; used for numeric paging. 

%z for the status change time. 

%y for the status change date. 

%r for a remark. 

 {0d} for chr(13) for a carriage return. 

{0a} for chr(10) for a line feed. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 
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What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

 

5.2.3.1.9 What Tab: Execute Command (Add/Edit Alert 
Dialog Box) 
What Tab: Execute Command (Add/Edit Alert Dialog Box) 
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To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

With the Execute Command option, you can configure Servers Alive to execute the command 
of your choice whenever the check status is down. You can enter several different types of 
commands: 

A normal command: this can be a BAT or EXE file. You must include the full path to the 
BAT or EXE. 

Restart of a Windows service, even if you are not checking an NT service. You can specify 
a user name and password to use to restart this NT service in the boxes provided. 

Internal commands forcing the entry into Active or Maintenance mode up to an optional 
time limit. 

Reboot a Windows computer. You can specify a user name and password to use to reboot 
the Windows computer. 

Command execute via an SSH connection. 

Servers Alive records in the log that a reboot has been successful as long as the 
software has been able to send the reboot command successfully. Servers Alive does 
not verify that the computer actually rebooted correctly. If part of the operating system 
does not respond correctly, the system cannot reboot despite receiving a reboot 
command. 

Send a WOL (Wake on LAN™ - Magic Packet™ ) 

Advanced Micro Devices (AMD™) first produced Magic Packet technology. The same 
technology from a joint venture by Intel® and IBM™ is called Wake on LAN (WOL). This 
technology allows you to remotely wake up a computer that is turned off or operating on 
low power on a network. You must have WOL capable hardware, although most 
hardware supports it. Your BIOS must support WOL and it must be enabled. WOL is 
usually disabled by default for security. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

Next, in the list box, select the type of command that you want to use. In order to use the 
Reboot and Restart Service options, Servers Alive must have sufficient rights, in the form of a 
user name and password, and access to the NetBIOS ports of the remote computer. If a firewall 
exists between Servers Alive and the remote server, please contact your firewall administrator 
for assistance. 

You can create an alert by stopping a service. In the dropdown list, click (Re)start NT/Win2K 
Service and then click the  check box. 

You can also send a WOL alert to a specific MAC address when you click Send a WOL (Wake 
on LAN - Magic Packet). If the system runs within the same segment as the system that runs 
Servers Alive, you do not need to enter additional information. 

Normal Command 
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When you select Normal Command in the list box, you get the following options. 

Command 

Enter the command that you want to execute. When entering the command, you must pass in 
various pieces of information to the command you are executing that identify what has broken. 
You can use variables in your command. They are replaced with the associated information 
before the command is issued. 

Browse 

Click the button to select a file. 

You can use the following variables. 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

{09} for a TAB. 
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%o (letter o) gives a description of the actual check. 

(Re)start NT/Win2K Service 

When you select (Re)start NT/Win2K Service in the list box, the following options appear. 

 

Server 

Enter the name of the server. 

 

Service 

Enter the name of the service. 

Stop First 

Click to stop the command before sending the alert. 

Only Stop (Don't Start) 

Click to create an alert by stopping a service. 

Authenticate Before Checking (NT Based Authentication) 

User Name 

Enter the user name for the alert. 

Password 

Enter the password for the alert. 

Reboot NT/Win2K Server 

The following options appear when you click Reboot NT/Win2K Server in the list. 
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Server 

Enter the name of the server. 

Shutdown Only (No Restart) 

Click this check box to ensure that the computer does not boot back up after it is shut down. 

Authenticate Before Checking (NT Based Authentication) 

Enter the user name and password for the alert. 

 

Internal Servers Alive Command 

The following options appear when you click Internal Servers Alive Command in the list. 

 

Command 
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Do one of the following: 

Select Set Entry to Maintenance or Set Entry to Active to set the alert to active or 
maintenance mode. 

Select Set Group to Maintenance or Set Group to Active to set the group to active or 
maintenance mode. 

Entry UID 

Enter the UID of the host entry. This box is available only when you click the Set Entry to 
Maintenance or Set Entry to Active options in the Command list. You can get the UID by 
selecting an entry on the tree in the Main window and right-clicking. 

Until 

Click the check box and enter a date and time. The alert lasts until the specific time and date 
that you enter. This option is available only when you click the Set Entry to Maintenance 
option in the Command list. 

If you do not enter a date, yet enter a time that occurs before the current hour, the alert lasts 
until the time on the next day. If you enter a time that occurs after the current hour, the alert 
lasts until the time you specify on the current day. 

Group UID 

Enter the UID of the host entry. This box is available only when you click the  or Set Group to 
Active options in the Command list. You can get the group UID by selecting an entry on the 
tree in the Main window and right-clicking. 

 

WOL (Wake on LAN - Magic Packet) 

When you select WOL (Wake on LAN - Magic Packet) in the list box, the following options 
appear. 

 

MAC Address 
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Enter the MAC address of the system to send the alert to. 

If the system that receives the WOL packet runs in the same segment as the system that runs 
Servers Alive, you do not need to enter information in the following boxes. However, if the 
system is on a different segment, you must enter the following information. 

IP Address 

Enter the IP address of the system that receives the WOL packet. 

Subnet Mask 

Enter the subnet mask of the system that receives the WOL packet. 

Execute Command via SSH - SSH Alert 

When you select Execute Command via SSH - SSH Alert in the list box, the following options 
appear. 

 

 

This alert allows you to connect to an SSH server and execute a command. You can access 
this option via the EXECUTE COMMAND alert type. 

Enter the connection info (Host, Port, User Name and Password) and select the correct SSH 
protocol type. 

In most cases, Protocol “SSH auto” should work fine. In the Command field, enter the 
command we should execute once the connection is established. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 
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What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.1.10 What Tab: Sound (Add/Edit Alert Dialog 
Box) 
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To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add Edit button on the Alert tab. 

Sound to Hear 

Enter the file name for the sound. You can click the browse button to select a WAV file on the 
computer. 

Test It 

Click to test the alert and sound. 

Beep Via Speaker 

Select this to allow the system beep to alert you. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

 What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
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5.2.3.1.11 What Tab: HTTP(S) GET/POST (Add/Edit 
Alert Dialog Box) 

 

Servers Alive can perform a URL (Universal Resource Locator) alert based on HTTPS (secure 
web) protocol with the post method. Servers Alive can connect to the remote server using a 
proxy server. This proxy server is defined in the Proxy branch of the Setup dialog box. 

To access this dialog box, click the Add button on the AlertEntries dialog box. The same 
options on the What tab appear when you create or edit an executive alert on the Setup dialog 
box. 

URL 

Enter the web address, or URL, to post the data, as in the following examples: 

http://www.mydomain.com/sub-dir/page.html 

https://www.mydomain.com/sub-dir/page.html 

On the dropdown list next to the URL box, you can click Get or Post to implement a check with 
either a get or a post action. 

Data to Post 

Enter the data that needs to be posted in the following format: 

VAR1=value1&VAR2=value2 

Post in the previous dropdown list. 

Password Protected Page 

Click to enable a page that is protected by a password. 

Username 

Enter the user name. 
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Password 

Enter the password. 

Proxy to Use 

Select No Proxy to disable proxy authentication. Select No Proxy when you have a direct 
connection to the Internet to retrieve a web page. Some companies or Internet services require 
a proxy server. In these cases, you must define the proxy server settings by clicking File > 
Setup and then clicking the General tree and selecting the Proxy branch. You can now use 
these settings within the alert by selecting it from the Proxy to Use list. 

You can add a wait at the end of each HTTP POST/GET alert by adding or editing the registry 
key: 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\HTTPAlertWaitAtEnd (string) 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

  

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

 What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

[262] 
 

http://www.helpandmanual.com/order.html


Servers Alive 8 

5.2.3.1.12 What Tab: Send Tweet (Twitter alert) 

 

The tweet can be sent to a default recipient (as defined in the setup). If the default recipient 
changes, then the  alert will also change to the new recipient. 

You can also send twitter alerts to a particular person (or a specific account), in which case, the 
twitter settings of that person will be used. 

The content of the tweet can be a default message (as defined in the setup) or any custom 
message that you would like to send. A tweet can also contain geographical coordinates via the 
“Longitude” and “Latitude” fields. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 
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What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.1.13 What Tab: Send MSN Message (Add/Edit 
Alert Dialog Box) 
Note: This feature will be removed in the next version of Servers Alive. 

To access this dialog box, click the Add button on the AlertEntries dialog box and then click 
Instant Message > Send MSN MessageWhat tab appear when you create or edit an 
executive alert on the Setup dialog box. 

 

If sending an MSN alert by LAN fails, Servers Alive can send the alert through a DUN 
connection. 

WHAT 

Add or Edit button on the Alert tab 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts 
branch of the Setup tree. 

[264] 
 



Servers Alive 8 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

You can also add an MSN contact with the Select an MSN Contact to Add dialog box  

When you click the Add button and select MSN Contact, the dialog box might take a minute to 
appear as the software is logging on to MSN to retrieve a list of contacts. 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 

%p for the pretty name. 

%s for the status. 

%t for the last check time. 

%d for the date. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. 

%c for the complete host/check description. 

%e for extra information. For a URL check, this could contain "404 Not Found" as the error 
message. 

%a for additional information. For a ping check, this is the round trip time. 

%i for hostID; used for numeric paging. 

%z for the status change time. 
%y for the status change date. 

%r for a remark. 

{0d} for chr(13) for a carriage return. 

{0a} for chr(10) for a line feed. 

In This Section See Also 
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Select an MSN Contact to Add 

What Tab: Send XMPP/Jabber 
Message 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) 
(Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert 
Dialog Box) 

What Tab: Send SMTP Mail (Alternate) 
(Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert 
Dialog Box) 

What Tab: Send Network Page (SNPP) 
(Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) 
(Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate 
Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert 
Dialog Box) 

What Tab: Execute Command (Add/Edit 
Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog 
Box) 

What Tab: HTTP(S) GET/POST (Add/Edit 
Alert Dialog Box) 

What Tab: Send WinPOPUP Message 
(Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert 
Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert 
Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 
5.2.3.1.17) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert 
Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert 
Dialog Box) 
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5.2.3.1.13.1 Select an MSN Contact to Add 
You can add an MSN contact. 

 

See Also 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send XMPP/Jabber Message 

5.2.3.1.13.2 What Tab: Send XMPP/Jabber Message 
Add button on the tab of the Entries dialog box and then click Instant Message > Send 
XMPP/Jabber Message. The same options on the What tab appear when you create or edit 
an executive alert on the Setup dialog box. 

 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
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an IP or email address, click the Setup button on the Main window and select the Alerts branch 
of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the error 
message. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. %t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is not 
known, the host name is used. 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

See Also 
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What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

Select an MSN Contact to Add 

5.2.3.1.14 What Tab: Send WinPOPUP Message 
(Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts 
branch of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message 
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Enter the message that you want to receive as an alert. You must specify the message that 
Servers Alive sends. You can use the variables listed below to help you create informative 
messages. The message and subject can contain variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 
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What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

 

5.2.3.1.15 What Tab: Send SNMP Trap (Add/Edit Alert 
Dialog Box) 
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To access this dialog box, click the  button on the Alert tab of the Entries dialog box. The 
same options on the What tab appear when you create or edit an executive alert on the Setup 
dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

Object OID 

Enter the object ID. 

Object Value 

Enter the value for the object. 

Use the IP of the entry as Agent IP 

Click to use the entry host name as the sender IP. If the host name is not an IP address, 
Servers Alive uses the default IP that is defined when you set options on the the Setup dialog 
box. You can also configure Serves Alive! to resolve the host name to an IP address when you 
set the following registry entry to 1: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\ResolveHost (dword) 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

 What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 
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Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

 

5.2.3.1.16 What Tab: SLACK (Add/Edit Alert Dialog 
Box) 

 

WHAT 

Add or Edit button on the Alert tab 

Send To 

Enter the information that you want to appear in the Send To line of the alert message. You can 
select either the Default option or the Channel option. 

Message 

Enter the message that you want for the alert. You can select either the Default option or the 
Other option. 
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5.2.3.1.17 What Tab: Do an SNMP SET (Add/Edit Alert 
Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the Entries What tab 
appear when you create or edit an executive alert on the Setup dialog box. 

 

WHAT 

Displays the type of alert that you selected by clicking the Add or button on the Alert tab. 

Host 

Enter the name of the remote host. 

Object OID 

Enter the object ID. 

Object Value 

Enter the value for the object. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 
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What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.1.18 Hyper-V Alert (Add/Edit Alert Dialog Box) 
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Hostname 

The name of the VMWare host. 

Username 

The user name associated with the VM host. 

Password 

The password associated with the VM host. 

Domain 

The domain where the VM host is located. 

OS 

The operating system of the VM host. 

VM Name 

The name of the VM host. 

Action 

The action to be performed to the VM host. 

 

See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 
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What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

 

5.2.3.1.19 VMWare Alert (Add/Edit Alert Dialog Box) 

 

Hostname 

The name of the VMWare host. 

Username 

The user name associated with the VM host. 

Password 
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The password associated with the VM host. 

VM Name 

The name of the VM host. 

Action 

The action to be performed to the VM host. 

 

See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 
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5.2.3.1.20 Trap Alert Tab (Add/Edit Alert Dialog Box) 
Servers Alive can check the status of a device or host with the Simple Network Management 
Protocol (SNMP). The software checks if the value of a certain OID is one of the following: 

Is less than a value, 

Is greater than a value, 

 Is equal to a value, 

Is different from (<>) a value, 

Contains a value, 

Does not contain a value, 

 •If the result of a formula is true or false 

Servers Alive can, within one check, retry several times to get an answer from the host. 

To get a list of valid OIDs for your SNMP-enabled devices, you should contact the vendor of the 
device. They can give you an MIB file that contains all the OIDs for the device. 

You can open this tab when you click File > Setup and select Built-in Servers > SNMP Trap 
Receiver in the tree. You can then click the Add button to add an alert and set options on the 
Trap Alert tab. 

 

Name 
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Enter the name that identifies the alert. 

AgentIP 

Specify the IP address of the SNMP agent. 

SourceIP 

Enter the source IP address. 

Enterprise OID 

Enter the OID of the enterprise that you want to receive specific traps from. An enterprise OID 
uniquely identifies the institution from all other institutions. 

Community 

Enter the appropriate community string for the server. You must enter the community string for 
the SNMP check for authentication purposes. An SNMPv1 community string serves as a 
password. By default, on most SNMP systems, this is PUBLIC; however, the community string 
can be different on your systems. 

OID 

Enter the OID or object identifier. An OID is a dotted numeric string that identifies an object. 
Typical objects that can be identified using OIDs include: attributes in X.500/LDAP-based 
directories, certificate policies and practice statements, MIBS for network management, and 
encryption algorithms. Two objects are considered to be the same only if they have the exact 
same OID. 

If you want to use a formula, click the check box and select an item from the list. 

This option Means this 

Is < than Is less than a value. 

Is > than Is greater than a value. 

Is = to Is equal to a value. 

Is <> than Is different from (<>) a value. 

Contains Contains a value. 

Doesn't Contain Does not contain a value. 

Formula Contains a result of a formula that is false. 

You can then enter conditional values in the next box. For example, you can create a check 
that sends a message when the OID < 45 or OID > 60 or alert when the OID > 45 and OID > 
60. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 
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What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 
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5.2.3.2 When Tab (Add/Edit Alert Dialog Box) 

 

Select one of the following options to determine when Servers Alive sends the alert message. 
The alert message can be in the form of a mail message, starting a service, playing a sound, 
and so forth. You can select options that send messages when the server status changes or 
when a host is down with certain conditions. 

When __ Times Down 

Enter a number to indicate that Servers Alive sends the alert message when the server is down 
the number of times that you specify. 

When __ Times Down and Then Every ____ Down Cycles 

Specify to send the alert when the server is down a certain number of times and all the 
subsequent cycles that the server is down. 

Every __ Down Cycles 

Enter a value to indicate an alert is sent the number of the cycle that the server is down. For 
example, if you enter 3, Servers Alive sends an alert message on the third, sixth, ninth, and so 
forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles that the server is not operating. 

Always 
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Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If you choose to receive 
an email when the host is down N times, but also want a message when the server comes back 
up, you must select the And When Back Up Too option. For example, if you enter 3 and the 
server is back up on the third cycle, you receive an alert message. If the server comes back up 
after two cycles, you don't receive an alert message for the down or up cycle. 

Stop Alerting After __ Cycles 

Enter a number to stop sending alert messages when the server has been up a certain number 
of cycles that you specify. 

When Down the "Extra Info Field" Should Contain 

Used to filter specific errors when the host is down. This box corresponds to the %e parameter. 
You should enter information that the Extra Info field for the output log displays or does not 
display when the host is down, depending on whether you select Should Contain or Should 
Not Contain. This gives you more specific information about what happened. 

For example, if the URL check fails with a 404 error or because the string you are looking for is 
not on the page, Servers Alive reads this as a down condition. However, you might want to 
send an alert with more specific information than an alert indicating a general down condition. 
When you enter a specific condition that corresponds to the e% parameter in this box and 
select Should Contain, Servers Alive compares this to the existing %e field. When the 
information in the box matches the existing %e field, Servers Alive sends an alert. 

For a URL (HTTP/HTTPS) check, if the response code of the web server is not a 200 code, this 
option checks the actual content of the received page. This results in more specific error 
messages. 

Ignore alert on a public holiday 

Select to ignore the alert on a public holiday, as defined in Startup Settings (Setup Dialog Box) 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 
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What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

Schedule Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.3.3 Schedule Tab (Add/Edit Alert Dialog Box) 
This feature is available in the Enterprise edition. This feature is also available in the free 
version for evaluation purposes. 

On the Schedule tab, for each alert that you set for the entry, you can set times for Servers 
Alive to send the alert. For example, for your new entry, you might want to schedule Servers 
Alive to send paging alerts only between 5 p.m. and 6 a.m. 
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Use Alert Schedule 

Click this check box to allow Servers Alive to send alerts according to the schedule that you set 
on this tab. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than this. Click and drag the pointer to select the hours you 
want to change and then click the  or Don't Alert buttons. The blocks change color to signify 
the changed status. 

Alert 

Click this button after you have selected a time period on the grid. This button allows Servers 
Alive to send alerts during the time period that you selected. 

Don't Alert 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive to not send alerts during the time period that you selected. 

See Also 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 
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What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 

What Tab: Hyper-V Alert (Add/Edit Alert Dialog Box) 

What Tab: VMWare Alert (Add/Edit Alert Dialog Box) 

5.2.4 Output Tab (Entries Dialog Box) 
The OutputSetup button and then click the Output tree. When you select the HTML Page > 
Default Page Add button, this creates new HTML pages for output. On the Output tab, you 
can select those pages when you click the Add button to add to the list. 
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Include on the Following HTML Pages 

Records the output on the HTML pages that you specify. 

Add 

Click to add an HTML page. 

Delete 

Select a page and click this button to remove it. 

In This Section 

Add HTML Page Dialog Box 

5.2.4.1 Add HTML Page Dialog Box 

 

Select the HTML page from the list and click OK. The dropdown list displays the HTML pages 
that you add when you click the Setup button and then click the Output tree. HTML Page > 
Default Page branch and click the Add button, the new pages you create appear on this dialog 
box. 

See Also 
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Output Tab (Entries Dialog Box) 

 

5.2.5 Logging Tab (Entries Dialog Box) 
Logging Tab (Entries Dialog Box) 

RRDTools logging for check results is available only for the following checks: 

Diskspace 

SNMP 

NT Perfmon 

External (errorlevel) 

 

If you want to collect all of the up/down events that Servers Alive detects into a centralized 
logging server, you can use the settings on this tab. Syslog is a standard method of sending 
alerts to an alerting server. Free server implementations exist for both Windows and UNIX 
platforms. 

For a Windows based syslog server, we recommend Kiwi Syslog Daemon, available from the 
KiwiSyslog web site. 

RRD 

Roundtrip Logging 

Select this option to enable roundtrip logging with RRDTools. 

[288] 
 

http://www.kiwisyslog.com/


Servers Alive 8 

For more information, click RRD Tools (Round Robin Database) (Setup Dialog Box). 

Check Result Logging 

Click this check box to enable result logging. 

Generate Create Script 

Click to generate a .bat file that creates the databases for all the entries. You can review and 
edit the .bat file before executing it by entering your changes on the RRD Create Parameters 
dialog box. 

Generate Graph Script 

Click to generate a script that creates the graphs of data in the databases. You must run the 
.bat file to create the graphs. Servers Alive prompts you to review or edit the contents of the 
.bat file in Notepad. Servers Alive does not actually create the graphs directly. 

The graphs are in .gif or .png format. You can include these graphs in web pages. 

Log on to Syslog Server 

Click to activate logging to the syslog server. 

Facility 

Enter the appropriate facility to use when logging to a Syslog server. For most, the Kern facility 
should be fine. If not, check with your Syslog server documentation to determine the best 
setting. 

Message 

Enter the message for the log. You must enter the message that Servers Alive records in the 
log. This message can use variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 
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%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

See Also 

Edit > New Entry (Entries Dialog Box) 

General Tab (Entries Dialog Box) 

Output Tab (Entries Dialog Box) 

Schedule Tab (Entries Dialog Box) 

Custom Tab (Entries Dialog Box) 

5.2.6 Schedule Tab (Entries Dialog Box) 
You can apply a unique schedule for each host entry on the Schedule tab. 
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Many servers have a designated period of time during the week when they are unavailable. 
These are generally times for scheduled maintenance or backups. Instead of manually 
changing each host into maintenance mode every time the host needs to go into maintenance 
services, you can set up a schedule to tell Servers Alive when it should start and stop checking 
a host. You do this with the Schedule tab. 
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Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than this. Click and drag the pointer to select the hours you 
want to change and then click the Check or Don't check buttons. The blocks change color to 
signify the changed status. 

Alternatively, use the From/To fields (see below). 

Check 

Click this button after you have selected a time period on the grid. This button allows Servers 
Alive to check a host during the time period that you selected. 

Don't Check 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive to not check a host during the time period that you selected. 

From/To 

Optional selector for specifying times. Wday Wend selects weekends. 

 

Use Schedule Profile 

Instead of having to enter a schedule for each entry, you can create a profile for several 
schedules and apply them to your entries. This option is only available for the ENTERPRISE 
edition of Servers. 

 

When to Check (Priority) 
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Select an option on the list if the entry represents a server that does not need checking as often 
as the others and you want Servers Alive to check the host only periodically. Select an item on 
the list to check the host every cycle or once out of a certain number of cycles. For example, 
you can select 1 out of Every 2 Cycles. 

Ignore Priority When Down 

Click the check box to check a host on every check cycle when the host is down, until it is back 
up. 

Start Cycle 

Select a number of 1-500 to indicate the start cycle. This ensures that Servers Alive does not 
check the entry on the first cycle, but rather on the cycle that you select. For example, if you 
select 2, Servers Alive checks only on the second cycle. 

See Also 

Edit > New Entry (Entries Dialog Box) 

General Tab (Entries Dialog Box) 

Check Tab (Entries Dialog Box) 

Alert Tab (Entries Dialog Box) 

Output Tab (Entries Dialog Box) 

Custom Tab (Entries Dialog Box) 

Network Tab (Entries Dialog Box) 

5.2.7 Custom Tab (Entries Dialog Box) 
This feature is available only in the Enterprise edition and free version of Servers Alive. 

Create custom fields by clicking File > Setup > General > Custom Fields. 

Select a custom script by clicking 
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The output for the custom fields appears as sa_custom_value_1, sa_custom_value_2, and so 
forth, in the output logs. 

Custom 1 

Displays the first custom field that you create on the Setup dialog box. 

Convert Check Response Using 

File > Setup and select files in the Custom Scripts branch of the General tree. If you do not 
select files in Custom Scripts, no options appear on the Convert Check Response Using list. 

 

See Also 

Edit > New Entry (Entries Dialog Box) 

General Tab (Entries Dialog Box) 

Check Tab (Entries Dialog Box) 

Alert Tab (Entries Dialog Box) 

Output Tab (Entries Dialog Box) 

Logging Tab (Entries Dialog Box) 

Schedule Tab (Entries Dialog Box) 

Network Tab (Entries Dialog Box) 

[294] 
 



Servers Alive 8 

5.2.8 Network Tab (Entries Dialog Box) 
Adds a route to the check. You can also set options to remove the route after the check cycle. 
This is useful if you want to test redundant systems. 

This feature is available only in the Enterprise edition. This feature is also available in the Free 
version for evaluation purposes. 

 

Add Route Before Doing this Check 

Adds a network route to the check. 

 

Destination 

Enter the network destination of the route. The box automatically displays the TCP/IP address 
of the server name or IP address that you enter on the General tab. 

Subnet Mask 

Enter the subnet mask associated with the network destination. 

A route is visible to the entire system--not just to Servers Alive. You should use a subnet mask 
that is restrictive, such as the default subnet mask of 255.255.255.255. 

Gateway 

Enter the gateway address, or forwarding IP address over which the set of addresses defined 
by the network destination and subnet mask can be reached. For local subnet routes, the 
gateway is the IP address assigned to the interface that is attached to the subnet. For remote 
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subnet routes, or routes that are available across one or more routers, the gateway address is 
an IP address that can be directly reached and that is assigned to a neighboring router. 

Metric 

Enter an integer ranging from 1 through 9999 that indicates an integer cost metric for the route. 
The route is used when choosing among several routes that most closely match the destination 
address of a packet being forwarded. 

Interface 

Select the interface over which the destination can be reached. 

Delete Route after Check 

Removes the route after the check cycle is complete. 

Continue Check even if Add Route Fails 

Allows the check cycle to continue, even if the route settings fail. 

Connect Via 

Select an item from the list to select how you want to connect. Click the Configure button to 
change settings for the item that you selected. 

By default, Servers Alive connects to the host using the normal LAN connection (__LAN__). 
Additionally, Servers Alive can create a dial-up network (DUN) connection to an external 
network before completing the check. After the check, Servers Alive disconnects from the 
external network. If you have created dial-up network connections on your computer, those 
connections appear on the Connect Via dropdown list. 

The DUN feature is available only if a dial-up network connection is installed on the computer 
running Servers Alive. See the online Help for Windows for more information on how to create 
a dial-up network connection. To use this feature effectively, Servers Alive must make the 
connection completely unattended. For that reason, you must configure the dial-up entry to 
save passwords. 

 

Configure 

Click to configure the item that you select in the Connect Via list. If you select a DUN 
connection, you can configure the DUN properties by entering the user name, password, and 
domain. 

Keep Connection Active 

Click the check box to keep the connection active after the check is completed. 

Until 

Click this check box to enter a date and time. The box defaults to the current date and time; 
however, you can enter a different value. For example, you can enter the following: 

12/18/2006 6:56:55 AM 

This option is available only if you click Maintenance in the previous dropdown list. 
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See Also 

Edit > New Entry (Entries Dialog Box) 

General Tab (Entries Dialog Box) 

Check Tab (Entries Dialog Box) 

Alert Tab (Entries Dialog Box) 

Output Tab (Entries Dialog Box) 

Logging Tab (Entries Dialog Box) 

Schedule Tab (Entries Dialog Box) 

Custom Tab (Entries Dialog Box) 

 

5.3 Edit > New Entry Based On . . . 
You can create entries based on a template with the New Entry Based On command on the 
Edit menu. You can use this command to create similar entries, based on an entry that already 
exists. For example, if you have many web servers, you can create an entry to check one web 
server and then use this option to quickly create similar checks for the others. 

To use this option, first select an entry on the Main window. Then either press CTRL-D or 
select Edit > New Entry Based On. When the dialog box appears, change the host and other 
information as needed. 

The new entry preserves the hostID of the original. For changing this, see 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\CopyRemovesHostID (string). 

5.4 Edit > Entry (Entries Dialog Box) 
Select an entry in the Main window and then click Edit > Entry to change the settings of a 
specific host. You can change the settings on the Entries dialog box. 

5.5 Edit > Import Hosts  (Import Entries 
Dialog Box) 
You can click Edit > Import Hosts to open a host entry. This is useful if you want to quickly 
create new host entries based on an existing set of entries. The file that you import should be in 
the following format: 

<name>, <pretty_name>, <remark> 
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The <name> field is required. The <pretty_name> and <remark> fields are optional. In the 
previous example, the column delimiter is a comma. You can use a tab, comma, space, or 
semicolon as the column delimiter. 

If the file that you import contains @KEEP@ as the prettyname, the imported entries use the 
prettyname of the template entry. 

If the imported file contains @SMART@ as the prettyname, the imported entries use the 
prettyname of the template entry and the current unique host name for the entry. 

 

File to Import 

Enter the name of the file for the host that you want to import. Click the browse button to select 
a file on your computer. 

First Row is Header 

Click the check box if the file that you are importing has a header row. 

Delimiter 

Select the delimiter that is used to separate columns in the file that you are importing. 

Tab 

Select if the import file contains tab characters that separate the columns. 

Space 

Select if the import file contains spaces that separate the columns. 

Semicolon 
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Select if the import file contains semicolons that separate the columns. 

Comma 

Select if the import file contains commas that separate the columns. 

None 

Select if the import file does not have a delimiter. 

Template Entries 

Displays a list of the entries on the computer that you can use as a template. If an entry has a 
check mark by it in the Main window, the entry does not appear on this list 

Find 

Enter a host name in the box and click the Find button to find a host in the Template Entries 
list. 

Find Next 

Click the button to find the host name again. 

Import 

Click this button to complete the import. 

5.6 Edit > Delete 
You have two options for deleting hosts. You can delete them on a host-by-host basis, or, for 
more extreme circumstances, delete all hosts at once. 

Setup dialog box. 

First re-open the default host list and verify that all hosts are still listed. Then select Save to 
verify that your copy is available the next time Servers Alive loads. 

Woodstone bvba recommends that you back up your entry listing on a regular basis. To do 
this, click File > Save As. 

5.7 Edit > Delete All 
You can delete all hosts at once. 

You must confirm your decision to prevent accidents. If you accidentally delete all your entries, 
do not close Servers Alive, as it might have been configured to automatically save any changes 
in the Setup dialog box. 

First re-open the default host list and verify that all hosts are still listed. Then select Save to 
verify that your copy is available the next time Servers Alive loads. 

Woodstone bvba recommends that you back up your entry listing on a regular basis. To do 
this, click File > Save As. 
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5.8 Edit > Global Change (Replace) 
(Global Changes Dialog Box) 

 

Occasionally, you must make entry revisions on a global level. For example, you might want to 
change your paging provider or need to send all primary SMTP messages to a new address. To 
do this, click Edit > Global Change (Replace) to make the changes. 

Before making global changes, you might want to stop the current check cycle and make a 
backup of your current listing with File > Save As. 

Change 

Select the parameter that you want to change: 

Primary SMTP Message 

Alternate SMTP Message 

Primary SMTP: Send Mail to... 

Alternate SMTP: Send Mail to... 

Ignore Priority When Down... 

Pager message 

NT service check password 

NT process check password 

Alpha pager number 

Syslog message 

NT performance check password 

NT service check username 

NT process check username 

NT performance check username 

Alpha paging enabled 
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Numeric pager number 

Primary SMTP subject 

Alternate SMTP subject 

Disk space check username 

Disk space check password 

Numeric pager number 

To 

Enter the new value for the parameter that you selected in the Change list. 

Start 

Click when you are ready to make changes. 

5.9 Edit > Changes Wizard (Global 
Add/Change Dialog Box) 
You can search and change the following settings for all or specified host entries when you 
click Edit > Changes Wizard: 

Checking schedule 

Community string 

Custom fields 

HostID 

Hostname 

Logging to the system log server 

Password 

Priority 

Remark 

Systems log message 

Timeout values 

Use authentication 

User name 

You can change settings for host entries in a certain group or entries that use a certain protocol 
for checks, such as TCP, UDP, and so forth. 
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After you click Edit > Changes Wizard, you set the item you want to change on the What tab 
of the dialog box. You then specify which host entries you want to change on the Select Entries 
tab. Clicking the Go button starts the changes. A message appears on the dialog box when the 
changes are complete. 

In This Section 

What Tab (Global Add/Change Dialog Box) 

Select Entries Tab (Global Add/Change Dialog Box) 

5.9.1 What Tab (Global Add/Change Dialog 
Box) 

 

You can search and change settings for all or specified host entries when you click Edit > 
Changes Wizard. 

Change 

Select one of the following: 

Username 

Password 

Priority 

Use Authentication 

Ignore Priority When Down 

Community String 

Checking Schedule 

Syslog Message 

Logging to the Syslog Server 

Remark 

Hostname 
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HostID 

The item you select is changed in the host entries. You select the criteria for the host entries on 
the Select Entries tab. 

To 

Enter the string or Boolean value for the item you selected in the  box. If you select 
UsernamePassword, you can enter a string in the To box. 

Priority, you can change the priority of an entry for a cycle in the Change box. 

If you have selected a Boolean value in the Change box, such as Use Authentication, Ignore 
Priority When Down, or Enable Logging to Syslog Server, you can selector False. 

If you select Checking Schedule in the box, you can enter a schedule to apply to the host 
entries. 

After you set the item you want to change on the What tab, click the Select Entries tab. On the 
Select Entries tab, you can change settings for host entries in a certain group or entries that 
use a certain protocol for checks, such as TCP, UDP, and so forth. 

See Also 

Edit > Changes Wizard (Global Add/Change Dialog Box) 

Select Entries Tab (Global Add/Change Dialog Box) 

 

5.9.2 Select Entries Tab (Global Add/Change 
Dialog Box) 

 

After you set the criteria to change on the What tab you can specify which host entries you want 
to apply the changes to on the Select Entries tab. 

All 

Select one of the following: 

Entries - Applies the changes to all host entries listed in Servers Alive. 
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Entries with Check Type - Applies the changes to host entries that use check types with 
a certain protocol, such as TCP, UDP, and so forth. After you click this option, you can 
select the protocol in the dropdown list. 

Entries Member of - Applies the changes to host entries in the group that you click in the 
dropdown list, such as Firewalls, Webservers, or groups that you created. 

After you set the criteria for the host entries, click the Go button. A message appears on the 
dialog box when the changes are complete. 

See Also 

Edit > Changes Wizard (Global Add/Change Dialog Box) 

What Tab (Global Add/Change Dialog Box) 

 

5.10 Edit > People (People Dialog Box) 

 

If you click Edit > People, you can open the People dialog box and add people and configure 
settings for SMTP, paging, and MSN messages for each person. In the Enterprise edition of 
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Servers Alive, you can also set up a specific schedule for each person to receive alert 
messages on the On Call tab 

.Select Person 

Enter the name of the person to create message settings for. 

In This Section 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

5.10.1 Person Tab (People Dialog Box) 
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You can enter alert and message settings for each person that you add to Servers Alive. For an 
example of how to use people and teams, refer to People and Teams Example. 

Add 

Click to add people to the Select Person list with the Add dialog box. 

Delete 

Select a person in the Select Person list and click Delete to remove them. 

Name 

Displays the name of the person that you chose in the Select Person list. You can change the 
name. 

The name cannot have a comma <,> or semi-colon <;>. If you use a comma or semi-colon, 
Servers Alive removes it. 

 

 

Person is Active 

Click to activate the person's settings. 

Remarks 

Enter information, such as notes, that you want to remember for that person's entry. 

A Public Holiday Should Be Considered as a Sunday 

Click to ensure that holidays are treated as a day off in the messaging settings. 

NTUserID 

Enter the Microsoft NT user ID for the person. This ID is used for WInPopup alerts. For 
Windows based checks (perfmon, service, process, and disk space) the authentication can be 
based on a person, therefore we will use NTUserID and Password for the real authentication. 

If your saWeb see Webservers uses authentication, then you will have to enable or disable a 
person for access to this via the “allow saWeb Access” option. 

Twitter alerts can be sent to a person and this is based on the “Twitter Account” given in the 
person's information screen. 

PersonID 

Displays the internal ID of the person. This is useful if you are trying to track the cause of a 
problem with schedules and so forth. 

In This Section 

Add Dialog Box 

See Also 

Edit > People (People Dialog Box) 

SMTP Tab (People Dialog Box) 
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Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

5.10.1.1 Add Dialog Box 
The Add dialog box allows you to add several items, such as HTML pages, teams, or people, 
to a list on the previous dialog box. Type the name of the item that you want to add and click 
OK. 

 

The name cannot have a comma <,> or semi-colon <;>. If you use a comma or semi-colon, 
Servers Alive removes it. 

See Also 

Person Tab (People Dialog Box) 
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5.10.2 SMTP Tab (People Dialog Box) 

 

 

Enable SMTP Mail for This Person 

Click this option to allow the software to send messages to the selected person. 

Send SMTP Mail To __________ Using the Green Schedule 

Enter the email address that you want to use for the green schedule on the grid. 

Send SMTP Mail To __________ Using the Blue Schedule 

Enter the email address that you want to use for the blue schedule on the grid. 

Send SMTP Mail To __________ Using the Yellow Schedule 

Enter the email address that you want to use for the yellow schedule on the grid. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
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period that you want to change and then click one of the Send or Don't Send buttons. The 
blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green Send button, an alert that 
occurs at that time is sent to the address entered in Send SMTP Mail To __________ Using 
the Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

5.10.3 Pager Tab (People Dialog Box) 
The pager settings that you enter on the Pager People dialog box are used for numeric, alpha, 
SMPP, and SNPP paging. 
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Enable Paging for This Person 

Click this option to allow the software to send pager messages to the selected person. 

Page Him/Her At __________ Using the Green Schedule 

Enter a number. 

Page Him/Her At __________ Using the Blue Schedule 

Enter a number. 

Page Him/Her At __________ Using the Yellow Schedule 

Enter a number. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
period that you want to change and then click one of the Send or Don't Send buttons. The 
blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 
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Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green button, an alert that 
occurs at that time is sent to the number entered in Page Him/Her At __________ Using the 
Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

5.10.4 MSN Tab (People Dialog Box) 
Note: This feature will be removed in the next version of Servers Alive. 
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Enable MSN for This Person 

Click this option to allow the software to send messages to the selected person. 

MSN Him/Her At __________ Using the Green Schedule 

Enter an MSN address. 

MSN Him/Her At __________ Using the Blue Schedule 

Enter an MSN address. 

MSN Him/Her At __________ Using the Yellow Schedule 

Enter an MSN address. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
period that you want to change and then click one of the Send or Don't Send buttons. The 
blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 
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Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green Send button, an alert that 
occurs at that time is sent to the address entered in MSN Him/Her __________ Using the 
Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

[313] 
 



Servers Alive 8 

5.10.5 XMPP Tab (People Dialog Box) 

 

Enable XMPP for this Person 

Click this option to allow the software to send messages to the selected person. 

XMPP Him/Her At __________ Using the Green Schedule 

Enter an XMPP address. 

XMPP Him/Her At __________ Using the Blue Schedule 

Enter an XMPP address. 

XMPP Him/Her At __________ Using the Yellow Schedule 

Enter an XMPP address. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
period that you want to change and then click one of the Send or Don't Send buttons. The 
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blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green Send button, an alert that 
occurs at that time is sent to the address entered in AIM Him/Her __________ Using the 
Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

5.10.6 On Call Tab (People Dialog Box) 
This feature is available only in the Enterprise edition and free version of Servers Alive. This 
feature is not available in the Standard edition. 
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To copy and paste schedules between people, use CTRL-C and CTRL-P. 

Use On Call Schedule 

Click to enable this feature for the person that you selected on the Person tab. 

When you schedule times for an individual to be on call, that person receives alert messages at 
the addresses that you specify on the SMTP,  MSN, or  tabs. 

If this feature is enabled, yet the schedule for this person shows that they are not on call, the 
individual does not receive alert messages. 

To change the months that are displayed on the dialog box, drag the slider bar to the left or 
right. 

On Call 

Enters times that a person is on call. To specify that a person is on call and receives alert 
messages, drag the mouse pointer over the dates that you want and click the On Call button. 

Not On Call 

Specifies that a person is not on call. To ensure that a person does not receive alert messages 
during a specific time, click the Not On Call button. 
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Today 

Click this button to change the calendar display to the current date. 

Registry Settings 

You can set an additional parameter in the Windows registry. To set the first day of the week for 
the schedule on the On Call 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\OnCall_start_day (dword) 

1 = Sunday, 2 = Monday, 3 = Tuesday, 4 = Wednesday, 5 = Thursday, 6 = Friday, 7 = Saturday 

Any value below 1 or above 7 defaults to 1, or Sunday. 

See Also 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

5.10.7 Remote Control Tool 
It's possible to configure Servers Alive via the Remote Client tool.  When running this on a 
remote system it will give you the known moon/stop icon.  When running it on the same system 
as the Servers Alive service it will not only give you the system tray icon but also the possibility 
to open the interface (in none-checking mode). 

Some configuration steps are needed. 

Within the setup you need to enable the option and allow the port/IP. 
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You will also need a user that is allowed to run the Remote Client tool, this has to be done via 
the EDIT-PEOPLE menu option. 
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Within the Remote Client itself you will need to configure the login settings. 

 

See Also 

Remote Clients (Setup Dialog Box) 
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5.11 Edit > Teams (Teams Dialog Box) 

 

Servers Alive has an option for companies that use large technical teams to handle their 
support. You can use team alerting to send alerts to multiple people based on schedules for 
each individual. This way, you can tell Servers Alive what people are responsible for various 
servers and let the software alert the team as appropriate based on the people's schedule of 
availability. 

To use team alerting, you must set up person and team entries that define who should be 
alerted and when. To do this, click Edit > People and Edit > Teams. 

You must first add the people that you want with the  command. 

You can use both team and people definitions in your alerting. When setting up an entry, you 
can use either a team or person entry on the and Paging alert settings. To do this, click the 
Add or Edit button on the Main window and, on the Alert tab, click the Add button to select 
one of the SMTP or paging options. For an example of how to use people and teams, refer to 
People and Teams Example. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Team 

Displays the internal ID of the team. This is useful if you are trying to track the cause of a 
problem with schedules and so forth. 
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Select Team 

Enter the name of the team. 

Add 

Click to add people to the Select Team list. 

Delete 

Select a name in the Select Team list and click Delete to remove the team. 

Name 

Displays the name of the team that you chose in the Select Team list. You can change the 
name. 

The name cannot have a comma <,> or semi-colon <;>. If you use a comma or semi-colon, 
Servers Alive removes it. 

Active Team? 

Click to activate the team's settings. 

Remarks 

Enter information, such as notes, that you want to remember for that team's entry. 

People 

Displays people that you can add to the team. 

Members of the Team 

Click the arrow buttons to add or remove people from the team. 

In This Section 

People and Teams Example. 

5.11.1 People and Teams Example 
Suppose your company has four people who are responsible for your servers. These four 
people are named Jack, Bob, Susan, and Kathy. During the day, when all four are at the office, 
you want them all to receive any alert, but the four need some time when they are not on call. 
After looking at their schedules, you determine that each one of them can take a weeknight. 

For the weekend, you decide to pair Jack and Kathy and Bob and Susan into sub-teams. Jack 
and Kathy handle Friday night and Saturday. Bob and Susan handle Sunday and Monday 
morning before the office opens. When you designate two people to receive weekend pages, 
they can travel on weekends if necessary. In order to allow Jack and Kathy to not receive any 
pages Saturday night, they go off call at 11PM that night. 
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Bob: All Business Hours, Monday Night, Saturday 11PM - Monday 8AM 

Jack: All Business Hours, Tuesday Night, Friday 5PM - Saturday 11PM 

Kathy: All Business Hours, Wednesday Night, Friday 5PM - Saturday 11PM 

Susan: All Business Hours, Thursday Night, Saturday 11PM - Monday 8AM 

To set this up, you would first go to the Edit menu and select People. On the Person tab, you 
must create entries for all four people. Click the Add button on the right and enter each 
person's name. 

You cannot enter capital letters. 

After you have added each person, go back to each one and check the Person is Active box. 
This means that they can be paged or emailed. If a person goes on vacation, you can remove 
the check mark later. One consideration with setting up a person's schedule is in how Servers 
Alive deals with public holidays and alerting. By default, a public holiday is not treated 
differently than any other day. You can configure Servers Alive to treat public holidays as a 
Sunday by checking the A public Holiday Should be Considered as a Sunday check box. 
This means that if a holiday falls on a Tuesday, you can designate Servers Alive to check 
everyone's Sunday schedule instead of his or her Tuesday schedule to determine whom to 
alert. You can change the list of holidays by clicking File > Setup and then clicking General > 
Startup in the Setup tree. See Startup Settings for more information. 
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Next you must set up each person's email and pager schedule. Select Bob and then select the 
SMTP tab. 

First, you should check the Enable SMTP Mail for this Person 

First, you set the weekdays. Bob is on call Monday night, but he is off call Tuesday, 
Wednesday, and Thursday nights. Select each night that Bob is off call and click the Don't 
Send button to turn them off. 

You can now set Bob's weekend schedule. Bob goes off-call on Friday at 5 PM, so go to the 
row labeled Friday and select everything from Friday 5 PM on, and then click the Don't Send 
button. Bob stays off call until 11 PM Saturday night, so select the entire row labeled Saturday, 
up to 11 PM. Then click the Don't Send button. Bob's schedule is now set, and he will not 
receive emails during the time period that he is off call. Your screen should look like the 
following: 

 

Now that you've seen how to set up one person, you can do similar schedules for the other 
three people. 

The final step is to add all four people to a team. You can create teams with whatever 
combination of the four you need, depending on what they were responsible for. You might 
include some of them in a team called "Web" that dealt with your web servers and others in a 
team that dealt with your network, and so forth. By setting everyone up in a team, you can add 
a team name to the alerting section of a host entry and then modify the team when necessary. 
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To add all four people to a team, click Edit > Teams. To create a team, you must click the Add 
button and give the team a name. Finally, at the bottom of the dialog box, you select all the 
team members. In this example in which you are creating one team, you select all four people. 

5.12 Edit > Protocols (Protocols Dialog 
Box) 

 

You can create settings for each protocol under a unique name: 

TCP 

UDP 

DNS Query 

Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the tree under the specific 
protocol that you selected. You can now click the new branch of the tree to create specific 
settings for the name that you created. 

In This Section 

TCP (Protocols Dialog Box) 

UDP (Protocols Dialog Box) 

DNS Query (Protocols Dialog Box) 

Radius (Protocols Dialog Box) 

An example 
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5.12.1 TCP (Protocols Dialog Box) 

 

You can create settings for each protocol under a unique name: 

TCP 

UDP 

DNS Query 

Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the tree under the specific 
protocol that you selected. You can now click the new branch of the tree to create specific 
settings for the name that you created. 

When you click a branch of the tree under TCP, the following options appear. The entries 
depend on the name in the tree that you have selected, such as FTP, Gopher, or a name that 
you created. 
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Protocol Name 

Displays the name of the protocol settings. 

Clone 

Duplicates the settings. Click the button to copy the settings and enter a name for the new 
group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

In any of the following fields, you can enter a non-printable character by typing the 
hexadecimal version of that character. The correct syntax is \xab where ab is a two-digit 
hexadecimal representation of the character. For example, you can type the following: 

for char(255) or a ÿ 

\x0d for char(13) or a colon 

Packet to Receive on Connect 

Enter the packet the protocol settings can receive. 
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On the Internet, the network breaks messages into parts of a certain size in bytes called 
packets. Each packet carries the information that moves the packet to its destination: the 
sender's IP address, the receiver's IP address, information that tells the network how many 
packets this email message has been broken into, and the number of this particular packet. The 
packets carry the data in the protocols that the Internet uses: Transmission Control 
Protocol/Internet Protocol (TCP/IP). Each packet contains part of the body of your message. A 
typical packet contains perhaps 1,000 or 1,500 bytes. 

Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive on Connect. 

Equal 

Click this and enter the item in Packet to Receive on Connect. 

Packet to Send on Connect 

Enter the packet the protocol settings can send. 

Packet to Receive as Response 

Enter the packet the protocol settings can receive as a response. 

Anything 

Allows the computer to receive any packets. 

Contains 

Packet to Receive as Response. 

Equal 

Click this and enter the item in Packet to Receive as Response. 

Packet to Send when Disconnecting 

Enter the packet the protocol settings can send when disconnecting. 

Linger 

Click this check box to ensure the connection is active until all the data is sent. 

 

See Also 

UDP (Protocols Dialog Box) 

DNS Query (Protocols Dialog Box) 

Radius (Protocols Dialog Box) 
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An example 

5.12.2 UDP (Protocols Dialog Box) 

 

You can create settings for each protocol under a unique name: 

TCP 

UDP 

DNS Query 

Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the tree under the specific 
protocol that you selected. You can now click the new branch of the tree to create specific 
settings for the name that you created. 

When you click a branch of the tree under TCP, the following options appear. The entries 
depend on the name in the tree that you have selected, such as Half Life or a name that you 
created. 
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Protocol Name 

Displays the name of the protocol settings. 

Clone 

Duplicates the settings. Click the button to copy the settings and enter a name for the new 
group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Receiving Port 

Select an option in the dropdown list to receive the data back on another port other than the 
default port. The initial communication is client (client_port) to server (server_port) in which the 
client_port is a random port above 1024; the connection sends data back from the server 
(server_port) to the client (client_port). 

You can now receive the data back to port +1, port -1, the same port (client port), or the same 
port (server port). 

Same port (client port) - Result comes back from the server on the client port. 

Port +1 - Result comes back from the server on the server port +1. For example, if you set 
the client port as 67 and select Port +1 in the dropdown list, the result comes back on the 
client port 68, being server port +1. 
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Port -1 - Result comes back from the server on the server port -1. For example, if you set 
the client port as 67 and select Port -1 in the dropdown list, the result comes back on the 
client port 66, being server port -1. 

Same port (server port) - Result comes back from the server on the server port. 

Description 

Displays a description for the protocol settings. 

In any of the following fields, you can enter a non-printable character by typing the 
hexadecimal version of that character. The correct syntax is \xab where ab is a two-digit 
hexadecimal representation of the character. For example, you can type the following: 

\xff for char(255) or a ÿ 

\x0d for char(13) or a colon 

Packet to Receive on Connect 

Enter the packet the protocol settings can receive. 

On the Internet, the network breaks messages into parts of a certain size in bytes called 
packets. Each packet carries the information that moves the packet to its destination: the 
sender's IP address, the receiver's IP address, information that tells the network how many 
packets this email message has been broken into, and the number of this particular packet. The 
packets carry the data in the protocols that the Internet uses: Transmission Control 
Protocol/Internet Protocol (TCP/IP). Each packet contains part of the body of your message. A 
typical packet contains perhaps 1,000 or 1,500 bytes. 

Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive on Connect. 

Equal 

Click this and enter the item in Packet to Receive on Connect. 

Packet to Send on Connect 

Enter the packet the protocol settings can send. 

Packet to Receive as Response 

Enter the packet the protocol settings can receive as a response. 

Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive as Response. 
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Equal 

Click this and enter the item in Packet to Receive as Response. 

Packet to Send when Disconnecting 

Enter the packet the protocol settings can send when disconnecting. 

See Also 

Edit > Protocols (Protocols Dialog Box) 

TCP (Protocols Dialog Box) 

DNS Query (Protocols Dialog Box) 

Radius (Protocols Dialog Box) 

An example 

5.12.3 DNS Query (Protocols Dialog Box) 

 

You can create settings for each protocol under a unique name: 

TCP 

UDP 

DNS Query 

Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the tree under the specific 
protocol that you selected. You can now click the new branch of the tree to create specific 
settings for the name that you created. 
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When you click a branch of the tree under DNS, the following options appear. The entries 
depend on the name in the tree that you have selected, such as Default DNS IPv4 Query or a 
name that you created. 

 

Protocol Name 

Displays the name of the protocol settings. 

Clone 

Duplicates the settings. Click the button to copy the settings and enter a name for the new 
group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Type of Record to be Checked 

Select the type of record from the list: 

Select this 
option: 

To check this type of record: 

A Host address. 
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The A-record is the most basic type of DNS 
record. A- records change domain names such as 
"www.yourdomain.com" into IP addresses, such 
as 23.123.40.53. A-records function like hosts 
files - a straightforward domain name to IP 
address mapping. A-records are primarily used 
for computers that share resources on a network. 

NS Authoritative name server. 

NS-records identify DNS servers responsible for a 
zone. An NS-record identifies the name of a DNS 
server, not the IP address. 

CName Domain name aliases. 

CNAME-records can be used to give a single 
computer multiple names, or aliases, for each 
function that the server performs, such as web 
server, ftp server, and so forth. CNAME-records 
are also used when a computer or service needs 
renaming. 

SOA Start of authority. 

The process returns "Server authority for domain" 
if the server that you are checking is the authority 
for the domain that you enter in the Host or 
Domain to Query for box. Otherwise, when you 
select the SOA option, the process returns 
"Server not authority for domain." 

Each zone contains exactly one SOA-record that 
contains the zone properties, such as the 
following: 

Name of primary DNS server 

Mailbox of responsible person 

Serial number 

Refresh interval 

Retry interval, 

Expire interval. 

WKS Well known services. 

WKS-records list the well known services, such 
as TELNET, FTP, or SMTP, that a host provides 
on a specific IP protocol, such as TCP or UDP. 

The Well Known Services (WKS)-record lists the 
Well Known Services a host provides on a 
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particular IP protocol. The common protocols are 
TCP and UDP. 

PTR Domain name pointer. 

PTR-records map IP addresses to domain 
names. These records are considered the 
opposite of A-records. A PTR-record's name is 
the IP address written in backward order with "in-
addr.arpa." appended to the end. 

HINFO Host information. An HINFO-record indicates the 
host server type of CPU and operating system. 
This information can be used by application 
protocols such as FTP. 

MINFO Mailbox records. 

Most Internet mail servers only support MX-
records. Only use this option if you have specific 
requirements for this type of record. 

MX Mail exchange. 

MX-records identify mail server(s) responsible for 
a domain name. When sending an e-mail to 
johnsmith@domain.com, your mail server must 
find the MX-record for domain.com to see which 
mail server handles mail for domain.com. The 
mail server then looks up the A-record for the mail 
server to connect to that IP address. 

AAAA Absolute IPv6 host address. See the following 
description for A6-records. 

  IPv6 host address. 

IPv6 is the future replacement for the current IP 
address system, IPv4. IPv4 addresses are 32-bits 
long and support a limited number of addresses. 
Not every system supports IPv6. IPv6 addresses 
are 128-bits long and are written hexadecimal 
numbers. 

An A6-record is used to specify the IPv6 address, 
or part of the IPv6 address, for a host. A6-records 
expand the functionality of A and AAAA-records 
by adding support for aggregation and 
renumbering. 

  Location of service. 

The process returns the server host name for the 
domain that you specify in the Host or Domain to 
Query for box. SRV-records are often used with 
different directory servers such as Lightweight 
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Directory Access Protocol (LDAP) and Windows 
2000 directory services. SRV-records can also be 
used for advanced load balancing and to specify 
specific ports for services. 

Test 

Click to test the settings. 

Host or Domain to Query for 

Enter the URL or name of the domain or host for the check. 

Result Should _____ 

Select from Be Anything, Contain, Exactly Be, or Not Contain. Enter the text that should 
result. 

If you select Be Anything, you do not need to enter a string in the box. 

If you select Contain, the query finds any of the string that you enter in the box. 

If you select Exactly Be, the query finds the exact string that you enter. To use this with DNS 
Round Robin results, select Ignore order received IPs. 

If you select Not Contain, the query finds anything that does not contain the string you enter. 
This option is useful if you want to check whether a host is listed in a spam blocking database, 
such as SpamCop. For example, in the Host or Domain to Query for box, you can enter 
4.3.2.1.bl.spamcop.net. In the Result Should list, you can then click Not Contain and enter 
127.0.0 in the box. This checks to see if a host with an IP address of 1.2.3.4 is within the spam 
blocking database. 

See Also 

Edit > Protocols (Protocols Dialog Box) 

TCP (Protocols Dialog Box) 

UDP (Protocols Dialog Box) 

Radius (Protocols Dialog Box) 

An example 
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5.12.4 Radius (Protocols Dialog Box) 

 

You can create settings for each protocol under a unique name: 

TCP 

UDP 

DNS Query 

Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the tree under the specific 
protocol that you selected. You can now click the new branch of the tree to create specific 
settings for the name that you created. 

When you click a branch of the tree under TCP, the following options appear. The entries 
depend on the name in the tree that you have selected, such as Default Radius Check or a 
name that you created. 
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Protocol Name 

Displays the name of the protocol settings. 

Clone 

Duplicates the settings. Click the button to copy the settings and enter a name for the new 
group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Username 

Enter the user name. 

Password 

Enter the password. 

Shared Secret 

Enter the appropriate shared secret. A shared secret is a text string that serves as a password 
between: 

A Radius client and Radius server. 
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A Radius client and a Radius proxy. 

A Radius proxy and a Radius server. 

See Also 

Edit > Protocols (Protocols Dialog Box) 

TCP (Protocols Dialog Box) 

UDP (Protocols Dialog Box) 

DNS Query (Protocols Dialog Box) 

An example 

5.12.5 An example 
First, you need to get a clear view of how the protocol you want to check works. It's best to use 
the network monitor for this. 

Some examples of network monitor tools: Free, Ethereal (http://www.ethereal.com): and 
Microsoft, included with SMS andNT/Win2000/Win2003 server Netmon. 

Once you have your network monitor running, capture the start and the end of a session of a 
tool that uses the protocol you want to create/check with Servers Alive. 

An example of such a capture: 

CLIENT connects to SERVER 

<- 220 mailserver.domain.com ESMTP Mail Service version 1.1.1.1 
ready at Wed, 7 Jan 2004 13:25:53 +0100<0D><0A> 

-> HELO client.domain.com<0D><0A> 

<- 250 mailserver.domain.com Helo [172.22.150.209]<0D><0A> .. 

-> QUIT<0D><0A> 

<- 221 2.0.0 mailserver.domain.com Service closing transmissionn 
channel.<0D><0A> 

Now what are you going to monitor? Servers Alive can connect to this remote system and 
check if it gets a correct return back from the system. 

From within Servers Alive do CTRL-P. This opens the PROTOCOL builder screen: 

[338] 
 



Servers Alive 8 

 

Create a new TCP (for the above example) protocol and name it myTCPProtocol. 

Then, within the tree structure at the left of the screen, navigate to TCP-myTCPProtocol: 

 

Enter the default port for this new protocol. In our example that is 25. You can also enter a 
description for this protocol. This description will be shown within the add/edit entries screen 
when select the my TCP Protocol check: 
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Now for the protocol itself. As you can see from the trace we get from the server 220 
mailserver.domain.com ESMTP Mail Service version 1.1.1.1 ready at Wed, 7 Jan 2004 
13:25:53 +0100<0D><0A> when connecting to it's 25 port. 

 

Within the Packet to receive on connect 

Once Servers Alive connects to the port and gest the correct string back, we want it to close the 
connection correctly, by sending the correct close command. This should be set within the field 
labeled "Packet to send when disconnecting". In our example that would be QUIT\x0D\x0A 

\x0D The character with asci value 13 (hex 0D) 
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\xOA The character with ascii value 10 (hex 0A)) 

Click OK to add it to the protocol definitions. Now you can test your newly create protocol 
definition by creating a new check entry that uses your newly created protocol definition. 

 

See Also 

Edit > Protocols (Protocols Dialog Box) 

TCP (Protocols Dialog Box) 

UDP (Protocols Dialog Box) 

DNS Query (Protocols Dialog Box) 

Radius (Protocols Dialog Box) 

6. Register, View, and Help Menus 
You can complete the following actions from the Register, View, and Help menus: 

Register the product. If you have already registered, you cannot see this menu. 

Show and hide various components of the Main window. 

Access online Help and the Servers Alive web site. 

In This Chapter 

Register Menu 
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View Menu 

Help Menu 

 

6.1 Register Menu 

 

This menu appears only in the unregistered version of Servers Alive. Use this command to 
register Servers Alive when you receive your email containing the appropriate information. 

Name 

Enter your name. 

Company 

Enter the name of your company. This entry is optional. 

Registration Code 

Enter the registration code that you received in email from Servers Alive. 

Buy Now 

Click this button to purchase Servers Alive at the Servers Alive web site. 

See Also 

Register, View, and Help Menus 

View Menu 

Help Menu 

6.2 View Menu 
You can use the View menu to hide or show the following: 

Host ID Column 

Last Checktime Column 

Roundtrip Column 
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Response Column 

Status Column 

Pretty Name Column 

Host Name Column 

Check Description Column 

Priority Column 

Total Cycles 

Up Cycles 

Down Cycles 

Status Icons within Tree 

Hide/Show Status Frame 

The status frame is right below the menu bar. It shows how many entries were up, down, and 
in maintenance during the last check cycle. 

Hide/Show EDIT Buttons 

The edit buttons are below the entry list (Add, Edit, Delete, Setup, About, Exit). 

See Also 

Register, View, and Help Menus 

Register Menu 

Help Menu 

6.3 Help Menu 
Use this menu to access online Help or go to the Servers Alive web site. 

If you click Help > About, you can see information about Servers Alive. On the box under the 
OK button, a button called Upgrade appears, if you have the Standard edition of Servers Alive. 
If you click this button, the Registration dialog box appears, allowing you to enter the 
registration code. If you are running the non-registered version, also known as freeware, or 
Enterprise edition, you cannot see this button. 

To get additional information about a dialog box or command, select the menu command and 
press F1on the keyboard. Or, you can open a dialog box and press F1. 

See Also 

Register, View, and Help Menus 
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Register Menu 

View Menu 

7. External Checks: Error Level 
One of the most convenient options available in Servers Alive is the ability to write your own 
custom checks and have them included in the check cycle. These checks can do any task that 
you are capable of programming, and many people in the Servers Alive community have made 
external checks that are available for you to use. Woodstone bvba has also provided external 
checks for you to use. 

To use Servers Alive to write external checks, see External (Errorlevel). 

Writing External Checks 

External checks can be written in any language. They can be compiled programs, interpreted 
scripts, or a simple batch file. There are only a few requirements for an external check. The 
external check must not rely on user input, and it must return an errorlevel to Servers Alive. 
Servers Alive uses the returned error level to determine if the check succeeded or failed. 
 
Woodstone bvba Supplied Checks 

Woodstone bvba has supplied example external checks. They are located in a subdirectory of 
the Servers Alive install directory called \External. In that directory you can find the executable 
for each check, and a small text file that describes the check. Following is a short description of 
each check. Please read the associated text file for more details. 

CheckODBC - Checks an ODBC data source. It will attempt to connect to a data source with 
parameters you give to it. It does not attempt to read or write any data from the data source. 

Countfiles - Connects to a path you supply, such as a network share, and returns an errorlevel 
equal to the number of files/directories that match your pattern criteria. The pattern is a 
standard file name wildcard pattern (such as *.*, *.log, or text?.txt). 

SATelnet - Automates connecting to a TCP port, reading data, and passing in commands. This 
is ideal for checks where you need to connect to the Telnet port of a remote computer, log in, 
issue some commands, and evaluate the result. For information on the many options available 
in this external check, please read the associated text file. 

SMTP2POP3 - Provides a more detailed check of a mail server than checking to see if the 
SMTP and POP3 ports are open. This application, when properly configured, sends an email 
through the SMTP server, and then collects that same email through the same or a different 
POP3 server. This verifies that the entire mail delivery process is functioning. 

External Checking Without Using Servers Alive 

If you want to test an external check that you wrote without the use of Servers Alive, you can 
use Checkerrorlevel.exe. This small tool is installed by the Servers Alive setup program in the 
Servers Alive directory. It runs your application and shows you the errorlevel that your 
application returns. 
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Command to Execute 

Enter the command. 

Max Wait Time 

Enter the amount of time to wait until the command executes. 

Kill After Max Time Elapsed? 

Click this check box if you want the check stopped after the maximum time. 

8. External Check Samples: COM-
based Checks 
You can install the Servers Alive external check samples by downloading them from the 
Servers Alive web site. 

The external check samples include the following COM-based checks: 

COM ODBC, also referred to as ODBC Query Addon (comodbc.dll). 

Remote DF COM, also referred to as *NIX Diskspace Check (comnixdsk.dll). 

Remote PS COM, also referred to as *NIX Process Check (comnixpro.dll). 

FileSize check (comfilesize.dll). 

Notes Check, also referred to as NotesDB Check (comnotesdb.dll). 

SMTP2POP3 COM, also referred to as Mailflow Check (comsmtp2pop3.dll). 

After you download the external check sample, browse to the directory where you downloaded 
the sample and double-click the .exe file to install the sample. The sample automatically installs 
to the appropriate directory \salive. 
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Once you have installed the sample, you can take the following steps to use it. 

1. Open Servers Alive. 

2. Create an existing entry by clicking the Add button and entering the appropriate settings 
on the General tab. 

3. On the Check tab, select External COM in the Check To Use list. 

4. In the list below Check To Use, select the COM sample that you want to use, such as 
one of the following entries: 

ODBC Query Addon 

*NIX Diskspace Check 

*NIX Process Check 

FileSize Check 

Mailflow Check 

NotesDB Check 

5. Click the Configure button to enter the appropriate settings for each check. 

In This Chapter 

Remote DF COM (*NIX Diskspace Check) 

FileSize Check 

Remote PS COM (*NIX Process Check) 

Notes Check (NotesDB Check) 

SMTP2POP3 COM (Mailflow Check) 

COM ODBC (ODBC Query Addon) 

8.1 Remote DF COM (*NIX Diskspace 
Check) 
The Remote DF COM addon monitors disk space on a remote system hard drives. Some of the 
operating systems include UNIX, Linux, and BSD. The addon uses an encrypted SSH 
connection to the remote system. You must have SSH access to the remote system. 

If the addon does not work correctly with your current variation of *NIX, please contact 
Woodstone support. We can assist you in adding support for your variation of *NIX. 

To activate this COM check, add an entry and, on the Check tab of the Add/Edit Entry 
External COM in the Check to Use list. You can then select Remote DF COM on the 
dropdown list and click the Configure button to specify the settings on the following dialog box. 
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Hostname 

Enter the name of the server you are checking. 

Protocol 

Select the SSH protocol: SSH1, SSH2, or Auto. 

Port 

Enter the port number to use for the check. The default is 22. 

Username 

Enter the user name for the server that you are checking. 

Password 

Enter the password for the account. 

Key File 

Enter the path to the SSL key file. The key file contains the client-side SSL certificates. The file 
extension is .kdb. You must copy the SSL key file to the directory on your local system. You 
can get the key file from the LDAP server. 

Key Type 

Select the key type based on the type of authentication: RSA or DSA. RSA supports SSH1 and 
SSH 2 protocols. DSA supports only SSH 2. RSA is recommended because it is more secure 
than RSA. However, some SSH servers support only DSA. If you choose DSA, you should not 
use the same key to authenticate with more than one server. 

OS 
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Select the operating system for the server. Some of the available operating systems include the 
following: Linux, BSD, Solaris, Sun OS (before 5.0), and more. 

Block Size 

Specify the file size, or block size, in 256, 512, 1024,2048 bytes. Larger block sizes make the 
files easier to read. 

End of Line 

Select the type of character at the end of each line: CR, or carriage return, LF, line feed, or 
CRLF, both carriage return and line feed. 

Check ___ And Alert When Less Than ___ ____ Are Free 

Set the conditionals for Servers Alive to alert you when a certain number of specific processes 
are running. To specify the process, click the browse button to connect to the SSH server. You 
can then enter a specific number and specify the unit in bytes, kilobytes, megabytes, gigabytes, 
terabytes, or a percentage. For example, you can enter 1 gigabyte. The check alerts you when 
a specific number in units is free. 

Timeout 

Displays the maximum time in seconds that Remote DF COM should wait before a check. 
Timeout indicates the amount of time Servers Alive waits to receive a command from another 
system. You can set this value on the Check tab of the Entries dialog box. 

See Also 

External Check Samples: COM-based Checks 

FileSize Check 

Remote PS COM (*NIX Process Check) 

Notes Check (NotesDB Check) 

SMTP2POP3 COM (Mailflow Check) 

COM ODBC (ODBC Query Addon) 

8.2 FileSize Check 
The FileSize Check addon monitors the size of a file on a remote server. 

To activate this COM check, add an entry and, on the of the Add/Edit Entry dialog box, select 
External COM in the Check to Use list. You can then select FileSize Check on the dropdown 
list and click the Configure button to specify the settings on the following dialog box. 
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Check ____ and Alarm When It's ____ Than ____ ____ 

Enter the name of the file that you want to check. The name of the file must be in the following 
format: 

\\<server name>\<directory>\<filename>. 

For example, you can enter the following path: 

\\server\share\directory\subdirectory\file.ext 

You must then specify whether the software sends an alarm when the file is bigger or smaller 
than the size you specify. You can enter the number of bytes, kilobytes, megabytes, gigabytes, 
or terabytes. 

Authenticate Before Checking (NT Based Authentication) 

Click to ensure the software authenticates with the server using user name and password that 
you specify. This occurs before the software executes the command. This authentication is 
based on Windows NT. 

The user performing the service check needs to have at least power user or administrator 
rights on the computer that is checked. If you do not have sufficient rights, you can specify 
another user name, usually in the form <domain name>\<user name>, and password of a user 
with power user or administrator rights on the computer that is checked. 

User Name 

Enter the user name as <domain name>\<user name>. 

Password 

Enter the password for the account. 

Timeout 

Displays the maximum time in seconds that FileSize Check should wait before a check. 
Timeout indicates the amount of time Servers Alive waits to receive a command from another 
system. You can set this value on the Check tab of the Entries dialog box. 
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See Also 

External Check Samples: COM-based Checks 

Remote DF COM (*NIX Diskspace Check) 

Remote PS COM (*NIX Process Check) 

Notes Check (NotesDB Check) 

SMTP2POP3 COM (Mailflow Check) 

8.3 Remote PS COM (*NIX Process Check) 
The Remote PS COM addon monitors processes on a remote system. Some of these systems 
can include UNIX, Linux, or BSD. The addon uses an encrypted SSH connection to the remote 
system. 

To activate this COM check, add an entry to Servers Alive and, on the Check tab of the 
Add/Edit Entry dialog box, select External COM in the Check to Use list. You can then select 
Remote PS COM on the dropdown list and click the Configure button to specify the settings on 
the following dialog box. 

 

Hostname 

Enter the name of the server that you want to check. 

Protocol 

Select the SSH protocol: SSH1, SSH2, or Auto. 

Port 

Enter the port number to use for the check. The default is 22. 
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User Name 

Enter the user name for logging in to the server. 

Password 

Enter the password for logging in to the server. 

Key File 

Enter the path and name of the SSL key file. The key file contains the client-side SSL 
certificates. The file extension is .kdb. You must copy the SSL key file to the directory on your 
local system. You can get the key file from the LDAP server. 

Key Type 

Select the key type based on the type of authentication:  or DSA. RSA supports SSH1 and SSH 
2 protocols. DSA supports only SSH 2. RSA is recommended because it is more secure than 
RSA. However, some SSH servers support only DSA. If you choose DSA, you should not use 
the same key to authenticate with more than one server. 

OS 

Select the operating system for the server: Linux, BSD, Solaris, or HP UX. 

Column 

Specifies the number of the column in which to check data: 1 through 15. 

End of Line 

Select what type of character at the end of each line: CR, or carriage return, LF, line feed, or 
CRLF, both carriage return and line feed. 

Alert When ___ ____ Instances of ___ Are Running  

Set the conditionals for Servers Alive to alert you when a certain number of specific processes 
are running. You can select At leastLess than and then specify up to 15 instances of the 
process. To specify the process, click the browse button to connect to the SSH server. 

Add Wait Command 

Click this check box to implement a wait command. The wait command ensures that every 
command is executed one after the other. 

Timeout 

Displays the maximum time in seconds that Remote PS COM should wait before a check. 
Timeout indicates the amount of time Servers Alive waits to receive a command from another 
system. You can set this value on the Check tab of the Entries dialog box. 

See Also 

Remote DF COM (*NIX Diskspace Check) 

FileSize Check 
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Notes Check (NotesDB Check) 

SMTP2POP3 COM (Mailflow Check) 

COM ODBC (ODBC Query Addon) 

8.4 Notes Check (NotesDB Check) 
The Notes™ Check addon reports whether a Lotus Notes®/Domino™ database is available or 
not. Lotus Notes databases can serve as the center of your daily communication. You can have 
your email, calendar, to do list, contacts, and more items, in one convenient spot. 

A Notes client must be installed on the computer that is running Servers Alive and the Notes 
Check addon. The Notes client must be running with a valid user ID and password on the 
system. The addon uses the user ID, or client ID/certificate, of the person using the Notes 
client. Thus, the user running Servers Alive must have rights to the directory where the user ID 
is stored. 

If you get an error indicating "ActiveX object can't be created", then, at the MS-DOS prompt, 
browse to the directory where NLSXBE.DLL is located. At the prompt, type REGSVR32 
NLSXBE.DLL and press Enter on the keyboard. 

To activate this COM check, add an entry and, on the Check tab of thedialog box, select 
External COM in the Check to Use list. You can then select Notes Check on the dropdown list 
and click the Configure button to specify the settings on the following dialog box. 

 

Server 

Enter the name of the server you are checking. 

Password 

Enter the password for the user account. 

Database 

Enter the name of the database. 
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Timeout 

Displays the maximum time in seconds that Notes Check should wait before a check. Timeout 
indicates the amount of time Servers Alive waits to receive a command from another system. 
You can set this value on the of the Entries dialog box. 

See Also 

External Check Samples: COM-based Checks 

Remote DF COM (*NIX Diskspace Check) 

FileSize Check 

Remote PS COM (*NIX Process Check) 

SMTP2POP3 COM (Mailflow Check) 

COM ODBC (ODBC Query Addon) 

8.5 SMTP2POP3 COM (Mailflow Check) 
The SMTP2POP3 COM addon uses only basic authentication. The addon sends an email using 
the SMTP protocol to a mail server. The addon then attempts to collect that same email using 
POP3 from a server, although not necessarily the same server. The addon can then verify that 
the mail server and mail flow are functioning properly. 

The SMTP2POP3 COM addon works within two cycles. If operating in SMTP and POP3 mode, 
on the first cycle, cycle_N, the software sends an email using SMTP and completes one of the 
following actions: 

On the next cycle, cycle_N+1, the software tries to retrieve the email using POP3. 

If sending the email fails in the first cycle, cycle_N, the software tries to send another email 
on the next cycle, cycle_N+1. 

If operating in SMTP mode, the software tries to send an email. 

If operating in POP3 mode, the software tries to retrieve an email sent using SMTPPOP3 COM. 

To activate this COM check, add an entry and, on the Check tab of the Add/Edit Entry dialog 
box, select External COM in the Check to Use list. You can then click SMTP2POP3 on the 
dropdown list and click the Configure button to specify the settings on the following dialog box. 
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SMTP Settings 

Host 

Enter the mail host as a NetBIOS name, DNS name or IP address; for example, HERMES, 
mail.domain.com, or 123.45.67.89. 

Port 

Enter the port number. The default port number is 25. 

The User Name and Password are needed only if the SMTP server requires authentication 
when you send an email. 

SSL/TLS Enabled 

Click this check box to implement SSL (Secure Sockets Layer) or, it successor, TLS (Transport 
Layer Security) encryption. This feature provides a secure, authenticated SMTP connection. 
Some routers or firewalls might not support an SSL connection. If you encounter difficulties, 
clear this check box. 
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User Name 

Enter the user name. 

Password 

Enter the password for the SMTP server. 

Email From 

Enter a name or a fully-qualified domain name; for example, serversalive@company.com. Your 
entries depend on the way your SMTP server is configured; most SMTP servers require a 
FROM name that looks like a valid email address, such as salive@domain.com. If you have 
trouble, please contact your mail server administrator for the appropriate settings. 

Email To 

Enter the email address to which the message should be delivered, such as 
person@company.com. 

Retries 

Enter the number of times to try sending the message, up to three retries. 

POP3 Settings 

Host 

Enter the mail host as a NetBIOS name, DNS name or IP address; for example, HERMES, 
mail.domain.com, or 123.45.67.89. 

Port 

Enter the port number. The default port number is 110. You must set the port of the POP3 
server correctly because the port number is different for SSL security. By default, POP3 uses 
port 110 and POP3 with SSL uses port 995. 

SSL Enabled 

Click this check box to implement Secure Sockets Layer (SSL) encryption for the POP3 mail 
server. 

User Name 

Enter the user name for the POP3 server. 

Password 

Enter the password for the account. 

Email From 

Enter a name or a fully-qualified domain name; for example, serversalive@company.com. Your 
entries depend on the way your POP3 server is configured; most POP3 servers require a 
FROM name that looks like a valid email address, such as salive@domain.com. If you have 
trouble, please contact your mail server administrator for the appropriate settings. 
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Email To 

Enter the email address to which the message should be delivered, such as 
person@company.com. 

Retries 

Enter the number of times to try sending the message, up to three retries. 

Only Delete SMTP2POP3 Messages 

Click this box to delete only SMTP2POP3 messages. Otherwise, all messages are deleted. 

Operating Mode 

Select whether to use SMTP, POP3, or both protocols. 

Don't Use X-Sender 

Click this check box if you encounter difficulties with the mail. X-sender headers provide a way 
to authenticate the origin of an email. The SMTP2POP3Com add-on uses the X-sender header 
to determine whether SMTP2POP3COM sent the mail that the software is trying to retrieve. 
Some systems strip the header, causing the add-on to not work correctly. 

Timeout 

Displays the maximum time in seconds that SMTP2POP3 should wait before a check. Timeout 
indicates the amount of time Servers Alive waits to receive a command from another system. 
You can set this value on the Check tab of the dialog box. 

See Also 

External Check Samples: COM-based Checks 

Remote DF COM (*NIX Diskspace Check) 

FileSize Check 

Remote PS COM (*NIX Process Check) 

Notes Check (NotesDB Check) 

COM ODBC (ODBC Query Addon) 

8.6 COM ODBC (ODBC Query Addon) 
The ODBC Database Monitoring addon monitors database connectivity and accessibility using 
local data sources and SQL queries. The addon verifies that your databases are functioning 
and responding correctly. 

To activate this COM check, add an entry to Servers Alive and, on the Check tab of the 
Add/Edit Entry dialog box, select External COM in the Check to Use list. You can then select 
COM ODBC on the dropdown list and click the Configure button to specify the settings on the 
following dialog box. 
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ODBC Data Source 

Enter the connection string for the Open Database Connectivity (ODBC) database. Click the 
browse button to open the Create Database Connection String dialog box and select a data 
source. 

SQL Query 

Enter the query in standard SQL syntax. 

The First Field of the First Returned Row Should 

Enter the value that matches the conditional criteria for the first field of the first row that is 
returned from the query. 

See Also 

External Check Samples: COM-based Checks 

Remote DF COM (*NIX Diskspace Check) 

Remote PS COM (*NIX Process Check) 

Notes Check (NotesDB Check) 

SMTP2POP3 COM (Mailflow Check) 

9. Registry Keys 
This section contains a snapshot of all the registry values you can modify for Servers Alive. 
However, serious problems might occur if you modify the registry incorrectly. Therefore, make 
sure that you edit registry values only if you know how to do this. For added protection, back up 
the registry before you modify it. Then, you can restore the registry if a problem occurs. For 
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more information about how to back up and restore the registry, please refer to article number 
322756 in the Microsoft Knowledge Base. 

Note: Servers Alive stores all Registry values for 32 bit systems under the location 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\DBU Consulting\Servers Alive\ 
and for 64 bit systems under the location HKEY_LOCAL_MACHINE\SOFTWARE\DBU 
Consulting\Servers Alive\. 
 
By default, the software asks you to confirm if you want to drag and drop an entry on the Main 
window. To turn this off, you must add the registry key and then assign a value of 1. 
 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndIgnoreTAG (string) 

A CRC check of a URL (HTTP/HTTPS) check retrieves the web page and calculates a CRC 
(checksum) on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. In 
between those two tags you can still exclude some parts too, as they are often used for 
changing data like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndTAG (string) 

A CRC (checksum) check of a URL (HTTP/HTTPS) check retrieves the web page and 
calculates a CRC on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those tags too, as they are often used for changing data 
like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartIgnoreTAG (string) 

A CRC check of a URL (HTTP/HTTPS) check retrieves the web page and calculates a CRC 
(checksum) on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those two tags, as they are often used for changing data 
like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartTAG (string) 

A CRC (checksum) check of a URL (HTTP/HTTPS) check retrieves the web page and 
calculates a CRC on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those two tags, as they are often used for changing data 
like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\gb (string value) 

The exact byte value of kb/mb/gb/tb can be changed in the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\kb (string value) 
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The exact byte value of KB/MB/GB/TB can be changed in the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\mb (string value) 

The exact byte value of KB/MB/GB/TB can be changed in the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\DiskSpace\PercentageMeasure (string) 

Possible values: KB, MB, GB, TB, %. The default value is MB. When performing a disk space 
check, the %e parameter contains the actual free space on the share that is checked. If the 
compare value is given in MB, the %e parameter is also in MB. However, if the compare value 
is given as a percentage, the %e is in bytes. You can now control how %e is returned when 
checking by a percentage by editing this registry value. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\tb (string value) 

The exact byte value of KB/MB/GB/TB can be changed in the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) 

If ExcludeDateTimeInMail is 1, the generated SMTP mailings do not include the last line (Mail 
generated by ... date/time). To remove the date/time from the mails, you must add or edit the 
registry entry. You can use 1 or 0. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\ 

The default page uses HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\Servers Alive\HTMLPage\ as the root for its registry keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\CheckTypeSortOrder (string) 

The default is WIPXSRDUQONME. If you choose to use the sort=check option in the sa_report 
tag, you can specify a custom priority for the various check types. You edit the registry entry 
and supply a string that lists the order of importance for all checks. Winsock TCP (W) - Winsock 
UDP (I) - PING (P) - IPX Ping (X) - NT Service (S) - NT process (R) - Disk space (D) - URL (U) 
- SQL server (Q) - Oracle (O) - Netware (N) - SNMP (M) - External (E). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStart 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStop 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownIcon (string) 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this 
you must add or edit the registry values. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\HostColumn (string) 

You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\Includedownstats (dword) 

If you want to see the number of times a host has been down since the last log filename 
change in the saved HTML file, you must add or edit the registry key. You can add a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\IncludeIcons (dword) 

When this value is 1, the icons are substituted for the normal words. Servers Alive can replace 
the words UP - DOWN - ... in the HTML page by icons. To do this you must add or edit the 
registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStart 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStop 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceIcon (string) 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\PlaceOfCheckTime (dword) 

0 is below the table, 1 is above the table. Servers Alive displays the last check time just before 
or just after the table with the hosts. This can be configured by adding or editing the registry 
key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\SmallStatusColumn (string) 

You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\StatusColumn (string) 

You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableBackground (string) 
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To change the background color of the table of the generated HTML page, you must add or edit 
the registry key. Example: "#FF0000" or "Red". By default, Servers Alive generates <TABLE 
BORDER="1"> as beginning of the table with the entry's statuses. Using the previous table 
background property gives you the option to specify <TABLEBGCOLOR="tablebackground">. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableProperties (string) 

By adding or editing the registry value, you are now able to specify <TABLE 
BGCOLOR="tablebackground" tableproperties>. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStart 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStop 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableIcon (string) 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStart 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStop 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedIcon (string) 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStart 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStop 

For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpIcon (string) 

Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ 

A web page with a display name of WebServers uses 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ as the root for its registry keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\http_show_host_and_prettyname (string) 

You can force the web server to include the host name for each entry that has a pretty name by 
editing the key. You can use a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\KeepAliveSound (string) 

Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\KeepAlivewithSound (dword) 

Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\StartSound (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\StopSound (string) 

Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\CloseEachTime (dword) 

If you want to safeguard the Servers Alive logs against missing data due to power failures or 
critical operating system errors, you can request that Servers Alive close the log file each time 
the software writes to the log file by editing the registry entry. A value of 1 forces Servers Alive 
to close the log file each time the software writes to the log file. This value changes the default 
action. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\db_DateFormat 

You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 
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You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\HTTPBytesinLog (string) 

You can set registry entries for saving a retrieved web page in the log file. When performing a 
URL check with a "contains" clause, Servers Alive saves 150 bytes (by default) of the retrieved 
web page in the log file. You can change how much is saved or changed by adding or editing 
the registry entry. A value of -1 means the full web page. Use this with care because your log 
file will grow very fast. A value of 0 defaults back to 150 bytes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\MIBdb\ParentLevelsToSearch (string) 

By default,when the SNMP TRAP receiver does a lookup of a received OID, it looks for the 
actual OID. If the actual OID is not found, it then searches for the parent of the given OID. To 
extend the search up by more than one level, create the key 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\MIBdb\ParentLevelsToSearch and set the value to more than 1. 

Example: 

A trap is received with OID .1.3.6.1.4.1.232.6.2.6.8.1.0.2 

Within the mib database we find .1.3.6.1.4.1.232.6.2.6.8.1 

With the ParentLevelsToSearch set to 1 (or default) it would be translated as... 

With the ParentLevelsToSearch set to 2 it would be translated as... 

.iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.c
pqHeTemperatureTable.cpqHeTemperatureEntry.0.2 

...since ".1.3.6.1.4.1.232.6.2.6.8.1" is 
".iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.
cpqHeTemperatureTable.cpqHeTemperatureEntry". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\DoubleMessage (dword) 

Note that, in some rare cases, the SMS message must be sent twice before it is received. To 
enable this feature, you must add or edit the registry entry. You can use a value of 1 or 0. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxMessageSize (string) 

Most SMS providers limit the number of characters within a message. Servers Alive provides a 
default limit of 160 characters. Enter a number to define the maximum size of the message. 160 
characters is the default if you do not edit this registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxRedials 

By default, the SMS feature tries to send the message twice, using one re-dial. You can change 
the number of re-dials to a maximum of ten re- dials by editing the registry entry. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\SplitLongMessage (string) 

Most SMS providers limit the number of characters within a message. Servers Alive provides a 
default limit of 160 characters. If you enter a value of 1, Servers Alive splits messages that 
exceed the number of characters that you enter in the MaxMessageSize registry entry. If you 
enter a value of 0, Servers Alive truncates the message at the number of characters that you 
enter in the MaxMessageSize entry. Any characters after that point are not sent. 

The size in bytes of the ICMP frame sent by a ping. The default is 32 bytes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType 

Specify type of proxy authentication for when the default Automatic selection is not 100% 
effective: 

Set to Effect 

0 None (will be internally converted to 1) 

1 Automatic (default)* 

2 Basic 

3 NTLM4 (Digest) 

*"Automatic" is the default setting. The first frame is sent without authentication information. 
Then, based on the response from the proxy server (407 frame), the system sends the needed 
authentication. 

See also HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType_2. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType_2 

Specify type of proxy authentication for when the default Automatic selection is not 100% 
effective: 

Set to Effect 

0 None (will be internally converted to 1) 

1 Automatic (default)* 

2 Basic 

3 NTLM4 (Digest) 

*"Automatic" is the default setting. The first frame is sent without authentication information. 
Then, based on the response from the proxy server (407 frame), the system sends the needed 
authentication. 

See also HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\RRD\pause_for_debug (string) 

Set to 1 to add a PAUSE command to the BAT file that does the RRD update. This make it 
possible to see the output of the RRDTool command. 

For debug purposes ONLY. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\RRD\UseLocalTime (dword) 

By default, the RRDTools logging is completed in UTC (GMT) time. You can change the 
logging time to the local time by editing the Windows registry with the key. You can enter 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use (string) 

With certain versions of the IPHLPAPI.DLL file, you must specify the DNS servers to use when 
querying for the MX records in the registry key. If you do not specify the DNS servers, Servers 
Alive attempts to determine which DNS servers to use. 

You can enter the DNS server to use in case Servers Alive cannot detect the other DNS 
servers. Or, you can enter a value in this registry entry to specify a different DNS server than 
the server defined within the operating system. With certain versions of the IPHLPAPI.DLL file, 
you must specify the DNS servers to use when querying for the MX records in the registry key. 
If you do not specify the DNS servers, Servers Alive attempts to determine which DNS servers 
to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_max_size (string) 

You can limit the size of the body text for SMTP messages by editing the registry entry. This 
value does not count the size of the additional footers or the main section. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateFooter (string) 

You can use the keys to add custom footers to any SMTP mail Servers Alive sends. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateHELO (string) 

The HELO/EHLO command is used to identify the client sender to the SMTP server. The 
sending server identifies itself and the receiving server accepts any given name, per request. 
EHLO is the Enhanced SMTP (ESMTP) version of HELO. To create or edit an HELO/EHLO 
command, you can edit the registry entry. A value of 0 uses the name of the SMTP server as 
defined in the Setup dialog box for the HELO/EHLO command. A value of 1 uses the name of 
the system that runs Servers Alive for the HELO/EHLO command. A value of 2 uses the 
domain name of the system running Servers Alive for the HELO/EHLO command. If no domain 
name is defined, Servers Alive uses NO.DOMAIN.NAME for the command. A value of 3 uses 
machinename.Domainname; for the HELO/EHLO command. If no domain name is defined, 
Servers Alive uses machinename.NO.DOMAIN.NAME. A value of 4 uses the IP address of the 
system running Servers Alive for the command. A value of 5, the default, uses the 
machinename.domainname for the command. If no domain name is added, Servers Alive uses 
the IP address for the command. If no numeric value is used, Servers Alive uses whatever 
string is defined for the HELO/EHLO command. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateSMTPPort (string) 

You can specify an alternate port, although not 25, for the primary and alternate SMTP server 
by modifying the keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateXHeader (string) 

You can use the keys to add custom headers to any SMTP mail Servers Alive sends. 

You can specify a custom date and time format for the customer headers and footers in SMTP 
mail: {cdate} custom date format. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string) 

You can add a custom footer message to all messages sent by Servers Alive. To do this, add 
or edit the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomTimeFormat (string) 

You can specify a custom date and time format for the customer headers and footers in SMTP 
mail: {ctime} custom time format. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\KeepAliveTo (string) 

By default, the keep-alive mailings are sent to the default primary Mailto parameter. This can be 
altered with the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\pingtimeout (dword) 

Before sending a mail, Servers Alive pings the SMTP server to see if it is responding. You can 
use the SMTP\PingTimeout parameter to determine the amount of time Servers Alive should 
wait for a response (max. 32 sec). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use (string) 

Send Direct check box, with certain versions of the IPHLPAPI.DLL file, you must specify the 
DNS servers to use when querying for the MX records in the registry key. If you do not specify 
the DNS servers, Servers Alive attempts to determine which DNS servers to use. If the first 
DNS server does not respond correctly, the software uses the second DNS server, if specified, 
to get the MX record for the recipient domain. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use_2 (string) 

You can enter the DNS server to use in case Servers Alive cannot detect the other DNS 
servers. Or, you can enter a value in this registry entry to specify a different DNS server than 
the server defined within the operating system. With certain versions of the IPHLPAPI.DLL file, 
you must specify the DNS servers to use when querying for the MX records in the registry key. 
If you do not specify the DNS servers, Servers Alive attempts to determine which DNS servers 
to use. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_max_size (string) 

You can limit the size of the body text for SMTP messages by editing the registry entry. This 
value does not count the size of the additional footers or the main section. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryFooter (string) 

You can use the keys to add custom footers to any SMTP mail Servers Alive sends. You can 
use the variables in the PrimaryFooter entry: {time} hh:mm:ss format; {date} dd:mm:yy format; 
{sdate} dd:mm:yy format; {stime} hh:mm format; {saversion} Servers Alive version number; {0d} 
Carriage return character; {0a} New line character; {25} Colon. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryHELO (string) 

The HELO/EHLO command is used to identify the client sender to the SMTP server. The 
sending server identifies itself and the receiving server accepts any given name, per request. 
EHLO is the Enhanced SMTP (ESMTP) version of HELO. To create or edit an HELO/EHLO 
command, you can edit the registry entry. A value of 0 uses the name of the SMTP server as 
defined in the Setup dialog box for the HELO/EHLO command. A value of 1 uses the name of 
the system that runs Servers Alive for the HELO/EHLO command. A value of 2 uses the 
domain name of the system running Servers Alive for the HELO/EHLO command. If no domain 
name is defined, Servers Alive uses NO.DOMAIN.NAME for the command. A value of 3 uses 
machinename.Domainname; for the HELO/EHLO command. If no domain name is defined, 
Servers Alive uses machinename.NO.DOMAIN.NAME. A value of 4 uses the IP address of the 
system running Servers Alive for the command. A value of 5, the default, uses the 
machinename.domainname for the command. If no domain name is added, Servers Alive uses 
the IP address for the command. If no numeric value is used, Servers Alive uses whatever 
string is defined for the HELO/EHLO command. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimarySMTPPort (string) 

You can specify an alternate port, although not 25, for the primary and alternate SMTP server 
by modifying the keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string) 

You can use the keys to add custom headers to any SMTP mail Servers Alive sends: 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword) 

If SMTP/ResolveAtStart equals 1, then Servers Alive attempts to resolve the SMTP, and 
alternate SMTP, server name to its IP address when Servers Alive starts and uses that from 
then on. You can enter 1 or 0. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\timeout (dword) 

Another parameter called SMTP\Timeout controls how long Servers Alive waits for the SMTP 
server to respond. The default is 15 seconds, and the maximum is 60 seconds. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\Localhost (string) 
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Specifies the SNMP trap sender's adapter IP. Otherwise the default adapter is used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\Localhost (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\ResolveHost (dword) 

If the host name is not an IP address, Servers Alive uses the default IP that is defined when 
you set options on the the Setup dialog box. You can also configure Serves Alive to resolve the 
host name to an IP address when you set the registry entry to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\SpecificType (string) 

For snmpv1 traps only, specify the SPECIFIC TRAP value of the trap generated by the SNMP 
TRAP sender. The default is "0". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeType 

If required create this, then set it to "1" to include the generic and specific type of the trap in the 
message for a received SNMP trap. 

Example message: 

Trap received from 199.8.7.6(172.22.150.179) with generic type 5, specific type 23 
trigger rule With .... 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeType 

Set to "1" to include the generic and specific type of the trap in the message for a received 
SNMP trap. 

Example message: 

Trap received from 199.8.7.6(172.22.150.179) with generic type 5, specific type 23 
trigger rule With .... 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AcceptIncompleteResponses 

Set to "1" to accept incomplete response pages as correct and continue checking content as 
normal. The check response notes that this was an "incomplete response". See Check Tab: 
URL (HTTP/HTTPS) Option (Entries Dialog Box). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 

If any error code found within this comma separated list occurs during the authentication phase, 
Servers Alive still sees the authentication as being successful. This is not a guarantee that the 
check will pass. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\CopyRemovesHostID (string) 

Set to 1 so that duplicating an entry does not copy the HostId. See Edit > New Entry Based On 
. . .  
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Dependsonwithoutprettyname (string) 

If an entry has a prettyname, then this is shown in the DEPENDS ON list on the ADD/EDIT 
entry page and is set to 1 to always show a description. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 

Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword). 

A value of 1 turns this feature on. Usually, Servers Alive de-authenticates at the end of any 
check cycle that includes authentication. If this does not succeed, it can cause any subsequent 
checks to fail. To force an authentication disconnect before a check, add the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\EveningStart (dword) 

By default, the morning starts at 8h (8AM) and the evening starts at 18h (6PM). You can 
change this by adding or editing the registry entry. Times are in 24h format. 6pm would be 18. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\ForcedDriveLetter (string value) 

By default, Servers Alive selects the next available drive letter to connect with when performing 
a disk space check. You can force Servers Alive to use a specific one if you choose. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\HTMLAlertsSeparator(string) 

The <sa_alerts> tag displays a <br> tag between each alert, by default. You can change the 
<br> to another value by entering the string you want in the registry entry. 

Set to "1" to append a count of 'downs' to NOT OK on the main window, e.g. "NOT OK(6)". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTP (dword) 

You can log all communication during an HTTP/HTTPS check to a file so that you can debug 
the process. Enter a value of 1 in the registry entry to enable this feature. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTPFIle (string) 

You can log all communication during an HTTP/HTTPS check to a file so that you can debug 
the process. Enter the path and name of the file log. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\MorningStart (dword) 

By default, the morning starts at 8h (8AM) and the evening starts at 18h (6PM). You can 
change this by adding or editing the registry entry. Times are in 24h format. 6pm would be 18. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Startup\NumberOfVisibleItems (string) 

You can change the number of entries displayed by editing the registry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\OnCall_start_day (dword) 
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To set the first day of the week for the schedule on the On Call tab of the People dialog box, 
edit this registry key with one of the following values: 1, 2, 3, 4, 5, 6, 7. The values are as 
follows: 1 = Sunday, 2 = Monday, 3 = Tuesday, 4 = Wednesday, 5 = Thursday, 6 = Friday, 7 = 
Saturday. Any value below 1 or above 7 defaults to 1, or Sunday. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\PerItemCycle {string} 

You can edit the registry to reduce the amount of time that Servers Alive waits between two 
checks. The default is 250 ms. Enter values starting at 10. 

The check process is case-sensitive. This means that a process with the name "fest" is different 
from a process with the name "Test." You can change this so that each check is case-
insensitive by editing the registry key with a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\SortStringPathSize (string) 

When sorting the template-based HTML output by GroupPath or EntryPath, you can edit the 
registry entry to set the number of bytes used by those parameters: 

Not in the registry or =0 defaults to 250. Above 1250 goes back to 1250. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\tabs_look (dword) 

You can change the way tabs on dialog boxes appear: 0 - tab dialog style; 

1 - property page style like Windows Properties dialog boxes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Name (string) 

To change the font size and font type, such as Arial, for entries in the Main window, you can 
enter the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Size (string) 

To change the font size and font type, such as Arial, for entries in the Main window, you can 
enter the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URL_Word_Separator (string) 

By default, the software interprets a space as a word separato in URL checksr. Change it with 
this registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URLContentInsensitive (dword) 

Servers Alive performs the check in a case-sensitive way when you click the Should Contain 
option in the software. This can be changed by adding or editing the registry value: 1 = case 
insensitive; 0 = case sensitive (default). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForServiceChecks (reg_dword) 

The service check's authentication will by default use a connection to IPC$ in order to get 
authenticated towards the remote system. In some cases this does not work correctly (due to 
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security settings on the remote system). You can now globally change the authentication 
method used for service checks by setting this registry value to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForProcessChecks (reg_dword) 

The process check's authentication will by default use a connection to IPC$ in order to get 
authenticated towards the remote system. In some cases this does not work correctly (due to 
security settings on the remote system). You can now globally change the authentication 
method used for process checks by setting the registry value to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\AlwaysHostName (regdword) 

You can edit the Windows registry to define whether to use the host name for statistical logging 
to files. 0 - use the host name if no pretty name is defined, otherwise use the pretty name. 1 - 
always use the host name. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_AlwaysHostName (regdword) 

You can also edit the Windows registry to define whether to use the host name, 0 - use the host 
name if no pretty name is defined, otherwise use the pretty name. 1 - always use the host 
name. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_prettynamesize (string) 

You can edit the Windows registry with the registry key to define the size of the host name, also 
known as the pretty name, within the database for statistical logging. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_Timeformat 

You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status 

Many of the alerts incorporate keywords to describe a server state. By default, the software 
uses the words up and down, but this can be changed through the registry. A list of single letter 
keys is in the registry entry HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status. Each 
letter corresponds with a particular check type, as follows: D – Drive Space; E – External check; 
F – Perfmon; I – UDP; M – SNMP; N – Netware; O – Oracle; P – Ping; Q – MS-SQL; R – 
Process; S – Windows Service; U – URL; X – IPX Ping; W – Winsock port (TCP); Under each 
of the single letter keys, you can find numbered string values. Each one of these represents a 
particular status keyword, as follows: 1 – down; 2 – possibly down; 3 – unavailable; 4 – 
maintenance; 5 – up; 6 – unchecked; 7 – possibly unavailable. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status\P\1 = "-" (string) 

If you want to allow Servers Alive to use "-" and "+," instead of "down" and "up" for all pings, 
you must set the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status\P\5 = "+" (string) 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatusSummary\FixedSubject (string) 

Edit this registry entry to specify a default subject for status summaries. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SYSLog\WithoutProcess (dword) 

By default, the syslog messages sent by Servers Alive include the process name "Servers 
Alive". You can remove this by adding or editing the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\FTPSleepTime (dword) 

The upload of WAP pages can give a "Busy executing command" error when several files have 
to be uploaded. By default, Servers Alive waits 100ms after the upload in order to give the 
socket the time to do a correct reset. If this is too much or to little time, you can change the 
value in the registry. The maximum value is 5000 (ms). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeAllLargeResponse (dword) 

If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You can edit the Windows registry with the registry key to modify the responses. 
You will need the following: Associated extension: WML; Content type (MIME):  
text/vnd.wap.wml. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeAllSmallResponse (dword) 

If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You will need the following: Associated extension: WML; Content type (MIME):  
text/vnd.wap.wml. You can edit the Windows registry with the keys to modify the responses. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeDownSmallResponse (dword) 

If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You can edit the Windows registry with the registry key to modify the responses. 
You will need the following: Associated extension - WML; Content type (MIME) - 
text/vnd.wap.wml. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Password (string) 

If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry. to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Server (string) 
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If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Username (string) 

If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\ServersAlive\StartUp\NetwareVolumev5 (string) 

You can now configure Servers Alive to use Netware Version 5 volume checks by setting the 
registry key to 1. 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders 

On some Windows 95 and 98 systems, the HTTPS checks fail and write the error message to 
the log: "failed due to Could not acquire security credentials: error 0x80090305." To fix the 
error, do the following: 1. Install Internet Explorer 5.5 or newer. 2. Install the DSCLIENT.EXE 
file that can be found on the Windows 2000 server CD in the directory: 
\Clients\Win9x\DSCLIENT.EXE. This updates several important pieces of the security 
subsystem. 3. Update the Windows registry by adding ", schannel.dll" to the end of the string 
found in the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndIgnoreTAG (string) 

A CRC check of a URL (HTTP/HTTPS) check retrieves the web page and calculates a CRC 
(checksum) on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. In 
between those two tags you can still exclude some parts too, as they are often used for 
changing data like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\EndTAG (string) 

A CRC (checksum) check of a URL (HTTP/HTTPS) check retrieves the web page and 
calculates a CRC on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those tags too, as they are often used for changing data 
like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartIgnoreTAG (string) 

A CRC check of a URL (HTTP/HTTPS) check retrieves the web page and calculates a CRC 
(checksum) on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those two tags, as they are often used for changing data 
like a date or time. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\CRC\StartTAG (string) 
A CRC (checksum) check of a URL (HTTP/HTTPS) check retrieves the web page and 
calculates a CRC on the content of the page. However, the check only does this for all that text 
between the <BODY> and </BODY> tags. The CRC check can automatically reset the CRC 
after each cycle. An altered page generates only one down cycle and the next up again. You 
can still exclude some parts between those two tags, as they are often used for changing data 
like a date or time. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\gb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\kb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\mb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\DiskSpace\PercentageMeasure (string) 
Possible values: KB, MB, GB, TB, %. The default value is MB. When performing a disk space 
check, the %e parameter contains the actual free space on the share that is checked. If the 
compare value is given in MB, the %e parameter is also in MB. However, if the compare value 
is given as a percentage, the %e is in bytes. You can now control how %e is returned when 
checking by a percentage by editing this registry value. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\tb (string value) 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\diskspace\tb (string value) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) 
If ExcludeDateTimeInMail is 1, the generated SMTP mailings do not include the last line (Mail 
generated by ... date/time). To remove the date/time from the mails, you must add or edit the 
registry entry. You can use 1 or 0. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\ 
The default page uses HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\Servers Alive\HTMLPage\ as the root for its registry keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\CheckTypeSortOrder (string) 
The default is WIPXSRDUQONME. If you choose to use the sort=check option in the sa_report 
tag, you can specify a custom priority for the various check types. You edit the registry entry 
and supply a string that lists the order of importance for all checks. Winsock TCP (W) - Winsock 
UDP (I) - PING (P) - IPX Ping (X) - NT Service (S) - NT process (R) - Disk space (D) - URL (U) 
- SQL server (Q) - Oracle (O) - Netware (N) - SNMP (M) - External (E). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStart 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStop 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\DownIcon (string) 
Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\HostColumn (string) 
You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\Includedownstats (dword) 
If you want to see the number of times a host has been down since the last log filename 
change in the saved HTML file, you must add or edit the registry key. You can add a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\IncludeIcons (dword) 
When this value is 1, the icons are substituted for the normal words. Servers Alive can replace 
the words UP - DOWN - ... in the HTML page by icons. To do this you must add or edit the 
registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStart 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStop 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceIcon (string) 
Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\PlaceOfCheckTime (dword) 
0 is below the table, 1 is above the table. Servers Alive displays the last check time just before 
or just after the table with the hosts. This can be configured by adding or editing the registry 
key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\SmallStatusColumn (string) 
You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\StatusColumn (string) 
You change the default size of the columns by adding or editing the registry values. Example: 
"100" or "35%" or "AUTO". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableBackground (string) 
To change the background color of the table of the generated HTML page, you must add or edit 
the registry key. Example: "#FF0000" or "Red". By default, Servers Alive generates <TABLE 
BORDER="1"> as beginning of the table with the entry's statuses. Using the previous table 
background property gives you the option to specify <TABLEBGCOLOR="tablebackground">. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\TableProperties (string) 
By adding or editing the registry value, you are now able to specify <TABLE 
BGCOLOR="tablebackground" tableproperties>. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStart 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStop 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableIcon (string) 
Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStart 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStop 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedIcon (string) 
Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStart 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

[376] 
 



Servers Alive 8 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStop 
For each of the different statuses that Servers Alive can display in the HTML pages, you can 
change the font type by adding or editing the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\UpIcon (string) 
Servers Alive can replace the words UP - DOWN - ... in the HTML page by icons. To do this, 
you must add or edit the registry values. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ 
A web page with a display name of WebServers uses 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ as the root for its registry keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\http_show_host_and_prettyname (string) 
You can force the web server to include the host name for each entry that has a pretty name by 
editing the key. You can use a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\KeepAliveSound (string) 
Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\KeepAliveSoundMinutes (dword) 
Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\KeepAlivewithSound (dword) 
Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\StartSound (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\KeepAlive\StopSound (string) 
Servers Alive plays a sound when starting or stopping as a proof that it is still alive. You must 
enter 1 in the registry key to enable this. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\CloseEachTime (dword) 

If you want to safeguard the Servers Alive logs against missing data due to power failures or 
critical operating system errors, you can request that Servers Alive close the log file each time 
the software writes to the log file by editing the registry entry. A value of 1 forces Servers Alive 
to close the log file each time the software writes to the log file. This value changes the default 
action. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\db_DateFormat 
You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\db_Timeformat 
You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Log\HTTPBytesinLog (string) 
You can set registry entries for saving a retrieved web page in the log file. When performing a 
URL check with a "contains" clause, Servers Alive saves 150 bytes (by default) of the retrieved 
web page in the log file. You can change how much is saved or changed by adding or editing 
the registry entry. A value of -1 means the full web page. Use this with care because your log 
file will grow very fast. A value of 0 defaults back to 150 bytes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\MIBdb\ParentLevelsToSearch (string) 

By default,when the SNMP TRAP receiver does a lookup of a received OID, it looks for the 
actual OID. If the actual OID is not found, it then searches for the parent of the given OID. To 
extend the search up by more than one level, create the key 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\MIBdb\ParentLevelsToSearch and set the value to more than 1. 

Example: 

A trap is received with OID .1.3.6.1.4.1.232.6.2.6.8.1.0.2 

Within the mib database we find .1.3.6.1.4.1.232.6.2.6.8.1 

With the ParentLevelsToSearch set to 1 (or default) it would be translated as... 

 

With the ParentLevelsToSearch set to 2 it would be translated as... 

.iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.c
pqHeTemperatureTable.cpqHeTemperatureEntry.0.2 

...since ".1.3.6.1.4.1.232.6.2.6.8.1" is 
".iso.org.dod.internet.private.enterprises.compaq.cpqHealth.cpqHeComponent.cpqHeThermal.
cpqHeTemperatureTable.cpqHeTemperatureEntry". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\DoubleMessage (dword) 
Note that, in some rare cases, the SMS message must be sent twice before it is received. To 
enable this feature, you must add or edit the registry entry. You can use a value of 1 or 0. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxMessageSize (string) 
Most SMS providers limit the number of characters within a message. Servers Alive provides a 
default limit of 160 characters. Enter a number to define the maximum size of the message. 160 
characters is the default if you do not edit this registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\MaxRedials 
By default, the SMS feature tries to send the message twice, using one re-dial. You can change 
the number of re-dials to a maximum of ten re- dials by editing the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Paging\SplitLongMessage (string) 
Most SMS providers limit the number of characters within a message. Servers Alive provides a 
default limit of 160 characters. If you enter a value of 1, Servers Alive splits messages that 
exceed the number of characters that you enter in the MaxMessageSize registry entry. If you 
enter a value of 0, Servers Alive truncates the message at the number of characters that you 
enter in the MaxMessageSize entry. Any characters after that point are not sent. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\PingSize 

The size in bytes of the ICMP frame sent by a ping. The default is 32 bytes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType 

Specify type of proxy authentication for when the default Automatic selection is not 100% 
effective: 

Set to Effect 

0 None (will be internally converted to 1) 

1 Automatic (default)* 

2 Basic 

3 NTLM4 (Digest) 

*"Automatic" is the default setting. The first frame is sent without authentication information. 
Then, based on the response from the proxy server (407 frame), the system sends the needed 
authentication. 

See also HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType_2 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType_2 

Specify type of proxy authentication for when the default Automatic selection is not 100% 
effective: 

Set to Effect 

0 None (will be internally converted to 1) 
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1 Automatic (default)* 

2 Basic 

3 NTLM4 (Digest) 

*"Automatic" is the default setting. The first frame is sent without authentication information. 
Then, based on the response from the proxy server (407 frame), the system sends the needed 
authentication. 

See also HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Proxy\AuthenticationType 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\RRD\pause_for_debug (string) 

Set to 1 to add a PAUSE command to the BAT file that does the RRD update. This make it 
possible to see the output of the RRDTool command. 

For debug purposes ONLY. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\RRD\UseLocalTime (dword) 
By default, the RRDTools logging is completed in UTC (GMT) time. You can change the 
logging time to the local time by editing the Windows registry with the key. You can enter 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use (string) 
With certain versions of the IPHLPAPI.DLL file, you must specify the DNS servers to use when 
querying for the MX records in the registry key. If you do not specify the DNS servers, Servers 
Alive attempts to determine which DNS servers to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use_2 (string) 

You can enter the DNS server to use in case Servers Alive cannot detect the other DNS 
servers. Or, you can enter a value in this registry entry to specify a different DNS server than 
the server defined within the operating system. With certain versions of the IPHLPAPI.DLL file, 
you must specify the DNS servers to use when querying for the MX records in the registry key. 
If you do not specify the DNS servers, Servers Alive attempts to determine which DNS servers 
to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Alternate_max_size (string) 
You can limit the size of the body text for SMTP messages by editing the registry entry. This 
value does not count the size of the additional footers or the main section. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateFooter (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateHELO (string) 
The HELO/EHLO command is used to identify the client sender to the SMTP server. The 
sending server identifies itself and the receiving server accepts any given name, per request. 
EHLO is the Enhanced SMTP (ESMTP) version of HELO. To create or edit an HELO/EHLO 
command, you can edit the registry entry. A value of 0 uses the name of the SMTP server as 
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defined in the Setup dialog box for the HELO/EHLO command. A value of 1 uses the name of 
the system that runs Servers Alive for the HELO/EHLO command. A value of 2 uses the 
domain name of the system running Servers Alive for the HELO/EHLO command. If no domain 
name is defined, Servers Alive uses NO.DOMAIN.NAME for the command. A value of 3 uses 
machinename.Domainname; for the HELO/EHLO command. If no domain name is defined, 
Servers Alive uses machinename.NO.DOMAIN.NAME. A value of 4 uses the IP address of the 
system running Servers Alive for the command. A value of 5, the default, uses the 
machinename.domainname for the command. If no domain name is added, Servers Alive uses 
the IP address for the command. If no numeric value is used, Servers Alive uses whatever 
string is defined for the HELO/EHLO command. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateSMTPPort (string) 
You can specify an alternate port, although not 25, for the primary and alternate SMTP server 
by modifying the keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\AlternateXHeader (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomDateFormat (string) 
You can specify a custom date and time format for the customer headers and footers in SMTP 
mail: {cdate} custom date format. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string) 
You can add a custom footer message to all messages sent by Servers Alive. To do this, add 
or edit the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\CustomTimeFormat (string) 
You can specify a custom date and time format for the customer headers and footers in SMTP 
mail: {ctime} custom time format. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\KeepAliveTo (string) 
By default, the keep-alive mailings are sent to the default primary Mailto parameter. This can be 
altered with the registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\pingtimeout (dword) 
Before sending a mail, Servers Alive pings the SMTP server to see if it is responding. You can 
use the SMTP\PingTimeout parameter to determine the amount of time Servers Alive should 
wait for a response (max. 32 sec). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use (string) 
Send Direct check box, with certain versions of the IPHLPAPI.DLL file, you must specify the 
DNS servers to use when querying for the MX records in the registry key. If you do not specify 
the DNS servers, Servers Alive attempts to determine which DNS servers to use. If the first 
DNS server does not respond correctly, the software uses the second DNS server, if specified, 
to get the MX record for the recipient domain. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use_2 (string) 

You can enter the DNS server to use in case Servers Alive cannot detect the other DNS 
servers. Or, you can enter a value in this registry entry to specify a different DNS server than 
the server defined within the operating system. With certain versions of the IPHLPAPI.DLL file, 
you must specify the DNS servers to use when querying for the MX records in the registry key. 
If you do not specify the DNS servers, Servers Alive attempts to determine which DNS servers 
to use. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\Primary_max_size (string) 
You can limit the size of the body text for SMTP messages by editing the registry entry. This 
value does not count the size of the additional footers or the main section. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryFooter (string) 
You can use the keys to add custom footers to any SMTP mail Servers Alive sends. You can 
use the variables in the PrimaryFooter entry: {time} hh:mm:ss format; {date} dd:mm:yy format; 
{sdate} dd:mm:yy format; {stime} hh:mm format; {saversion} Servers Alive version number; {0d} 
Carriage return character; {0a} New line character; {25} Colon. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryHELO (string) 
The HELO/EHLO command is used to identify the client sender to the SMTP server. The 
sending server identifies itself and the receiving server accepts any given name, per request. 
EHLO is the Enhanced SMTP (ESMTP) version of HELO. To create or edit an HELO/EHLO 
command, you can edit the registry entry. A value of 0 uses the name of the SMTP server as 
defined in the Setup dialog box for the HELO/EHLO command. A value of 1 uses the name of 
the system that runs Servers Alive for the HELO/EHLO command. A value of 2 uses the 
domain name of the system running Servers Alive for the HELO/EHLO command. If no domain 
name is defined, Servers Alive uses NO.DOMAIN.NAME for the command. A value of 3 uses 
machinename.Domainname; for the HELO/EHLO command. If no domain name is defined, 
Servers Alive uses machinename.NO.DOMAIN.NAME. A value of 4 uses the IP address of the 
system running Servers Alive for the command. A value of 5, the default, uses the 
machinename.domainname for the command. If no domain name is added, Servers Alive uses 
the IP address for the command. If no numeric value is used, Servers Alive uses whatever 
string is defined for the HELO/EHLO command. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimarySMTPPort (string) 
You can specify an alternate port, although not 25, for the primary and alternate SMTP server 
by modifying the keys. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword) 
If SMTP/ResolveAtStart equals 1, then Servers Alive attempts to resolve the SMTP, and 
alternate SMTP, server name to its IP address when Servers Alive starts and uses that from 
then on. You can enter 1 or 0. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SMTP\timeout (dword) 
Another parameter called SMTP\Timeout controls how long Servers Alive waits for the SMTP 
server to respond. The default is 15 seconds, and the maximum is 60 seconds. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\Localhost (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\Localhost (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\ResolveHost (dword) 
If the host name is not an IP address, Servers Alive uses the default IP that is defined when 
you set options on the the Setup dialog box. You can also configure Serves Alive to resolve the 
host name to an IP address when you set the registry entry to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrap\SpecificType (string) 

For snmpv1 traps only, specify the SPECIFIC TRAP value of the trap generated by the SNMP 
TRAP sender. The default is "0". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeType 

If required create this, then set it to "1" to include the generic and specific type of the trap in the 
message for a received SNMP trap. 

Example message: 

Trap received from 199.8.7.6(172.22.150.179) with generic type 5, specific type 23 
trigger rule With .... 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeType 

Set to "1" to include the generic and specific type of the trap in the message for a received 
SNMP trap. 

Example message: 

Trap received from 199.8.7.6(172.22.150.179) with generic type 5, specific type 23 
trigger rule With .... 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AcceptIncompleteResponses 

Set to "1" to accept incomplete response pages as correct and continue checking content as 
normal. The check response notes that this was an "incomplete response". See Check Tab: 
URL (HTTP/HTTPS) Option (Entries Dialog Box) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 
If any error code found within this comma separated list occurs during the authentication phase, 
Servers Alive still sees the authentication as being successful. This is not a guarantee that the 
check will pass. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\CopyRemovesHostID (string) 

Set to 1 so that duplicating an entry does not copy the HostId. See Edit > New Entry Based On 
. . . . 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\CopyRemovesHostID (string) 
 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Dependsonwithoutprettyname (string) 

If an entry has a prettyname, then this is shown in the DEPENDS ON list on the ADD/EDIT 
entry page and is set to 1 to always show a description. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword). 
A value of 1 turns this feature on. Usually, Servers Alive de-authenticates at the end of any 
check cycle that includes authentication. If this does not succeed, it can cause any subsequent 
checks to fail. To force an authentication disconnect before a check, add the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\EveningStart (dword) 
By default, the morning starts at 8h (8AM) and the evening starts at 18h (6PM). You can 
change this by adding or editing the registry entry. Times are in 24h format. 6pm would be 18. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\ForcedDriveLetter (string value) 
By default, Servers Alive selects the next available drive letter to connect with when performing 
a disk space check. You can force Servers Alive to use a specific one if you choose. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\HTMLAlertsSeparator(string) 
The <sa_alerts> tag displays a <br> tag between each alert, by default. You can change the 
<br> to another value by entering the string you want in the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Include_down_counter_for_down (dword) 

Set to "1" to append a count of 'downs' to NOT OK on the main window, e.g. "NOT OK(6)". 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTP (dword) 
You can log all communication during an HTTP/HTTPS check to a file so that you can debug 
the process. Enter a value of 1 in the registry entry to enable this feature. 

KEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\logHTTPFIle (string) 
You can log all communication during an HTTP/HTTPS check to a file so that you can debug 
the process. Enter the path and name of the file log. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\MorningStart (dword) 
By default, the morning starts at 8h (8AM) and the evening starts at 18h (6PM). You can 
change this by adding or editing the registry entry. Times are in 24h format. 6pm would be 18. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Startup\NumberOfVisibleItems (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\OnCall_start_day (dword) 
To set the first day of the week for the schedule on the On Call tab of the People dialog box, 
edit this registry key with one of the following values: 1, 2, 3, 4, 5, 6, 7. The values are as 
follows: 1 = Sunday, 2 = Monday, 3 = Tuesday, 4 = Wednesday, 5 = Thursday, 6 = Friday, 7 = 
Saturday. Any value below 1 or above 7 defaults to 1, or Sunday. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\PerItemCycle {string} 
You can edit the registry to reduce the amount of time that Servers Alive waits between two 
checks. The default is 250 ms. Enter values starting at 10. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\ProcessnameCaseInsensitive (dword) 
The check process is case-sensitive. This means that a process with the name "fest" is different 
from a process with the name "Test." You can change this so that each check is case-
insensitive by editing the registry key with a value of 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\SortStringPathSize (string) 

When sorting the template-based HTML output by GroupPath or EntryPath, you can edit the 
registry entry to set the number of bytes used by those parameters: 

Not in the registry or =0 defaults to 250. Above 1250 goes back to 1250. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\tabs_look (dword) 
You can change the way tabs on dialog boxes appear: 0 - tab dialog style; 

1 - property page style like Windows Properties dialog boxes. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Name (string) 
To change the font size and font type, such as Arial, for entries in the Main window, you can 
enter the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\Tree_Font_Size (string) 
To change the font size and font type, such as Arial, for entries in the Main window, you can 
enter the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URL_Word_Separator (string) 
By default, the software interprets a space as a word separato in URL checksr. Change it with 
this registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URLContentInsensitive (dword) 

Servers Alive performs the check in a case-sensitive way when you click the Should Contain 
option in the software. This can be changed by adding or editing the registry value: 1 = case 
insensitive; 0 = case sensitive (default). 

[385] 
 



Servers Alive 8 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForServiceChecks (reg_dword) 

The service check's authentication will by default use a connection to IPC$ in order to get 
authenticated towards the remote system. In some cases this does not work correctly (due to 
security settings on the remote system). You can now globally change the authentication 
method used for service checks by setting this registry value to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\URLContentInsensitive (dword) 
 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StartUp\UseimpersonateForProcessChecks (reg_dword) 

The process check's authentication will by default use a connection to IPC$ in order to get 
authenticated towards the remote system. In some cases this does not work correctly (due to 
security settings on the remote system). You can now globally change the authentication 
method used for process checks by setting the registry value to 1. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\AlwaysHostName (regdword) 
You can edit the Windows registry to define whether to use the host name for statistical logging 
to files. 0 - use the host name if no pretty name is defined, otherwise use the pretty name. 1 - 
always use the host name. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_AlwaysHostName (regdword) 
You can also edit the Windows registry to define whether to use the host name, 0 - use the host 
name if no pretty name is defined, otherwise use the pretty name. 1 - always use the host 
name. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_Dateformat 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_prettynamesize (string) 
You can edit the Windows registry with the registry key to define the size of the host name, also 
known as the pretty name, within the database for statistical logging. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatsLog\db_Timeformat 
You can define the date and time format for the database logging by specifying the registry 
entry keys. When the registry keys are empty, the date and time format of the operating system 
are used. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status 
Many of the alerts incorporate keywords to describe a server state. By default, the software 
uses the words up and down, but this can be changed through the registry. A list of single letter 
keys is in the registry entry HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status. Each 
letter corresponds with a particular check type, as follows: D – Drive Space; E – External check; 
F – Perfmon; I – UDP; M – SNMP; N – Netware; O – Oracle; P – Ping; Q – MS-SQL; R – 
Process; S – Windows Service; U – URL; X – IPX Ping; W – Winsock port (TCP); Under each 
of the single letter keys, you can find numbered string values. Each one of these represents a 
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particular status keyword, as follows: 1 – down; 2 – possibly down; 3 – unavailable; 4 – 
maintenance; 5 – up; 6 – unchecked; 7 – possibly unavailable. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status\P\1 = "-" (string) 
If you want to allow Servers Alive to use "-" and "+," instead of "down" and "up" for all pings, 
you must set the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\Status\P\5 = "+" (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\StatusSummary\FixedSubject (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\SYSLog\WithoutProcess (dword) 
By default, the syslog messages sent by Servers Alive include the process name "Servers 
Alive". You can remove this by adding or editing the registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\FTPSleepTime (dword) 
The upload of WAP pages can give a "Busy executing command" error when several files have 
to be uploaded. By default, Servers Alive waits 100ms after the upload in order to give the 
socket the time to do a correct reset. If this is too much or to little time, you can change the 
value in the registry. The maximum value is 5000 (ms). 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeAllLargeResponse (dword) 
If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You can edit the Windows registry with the registry key to modify the responses. 
You will need the following: Associated extension: WML; Content type (MIME):  
text/vnd.wap.wml. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeAllSmallResponse (dword) 
If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You will need the following: Associated extension: WML; Content type (MIME):  
text/vnd.wap.wml. You can edit the Windows registry with the keys to modify the responses. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\IncludeDownSmallResponse (dword) 
If you want to publish WML files with your own web server, you must add the needed MIME 
type to your web server. Some WML browsers need those to be able to show the downloaded 
WML files. You can edit the Windows registry with the registry key to modify the responses. 
You will need the following: Associated extension - WML; Content type (MIME) - 
text/vnd.wap.wml. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Password (string) 
If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry. to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 
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HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Server (string) 
If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU Consulting\Servers 
Alive\WAP\Username (string) 
If you want to store your WAP page on a remote server that requires authentication, you can 
use the registry entry to supply the authentication information. The server listed here should be 
the same as the server listed in the software for WAP file storage. 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\DBU 
Consulting\ServersAlive\StartUp\NetwareVolumev5 (string) 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders 
On some Windows 95 and 98 systems, the HTTPS checks fail and write the error message to 
the log: "failed due to Could not acquire security credentials: error 0x80090305." To fix the 
error, do the following: 1. Install Internet Explorer 5.5 or newer. 2. Install the DSCLIENT.EXE 
file that can be found on the Windows 2000 server CD in the directory: 
\Clients\Win9x\DSCLIENT.EXE. This updates several important pieces of the security 
subsystem. 3. Update the Windows registry by adding ", schannel.dll" to the end of the string 
found in the registry key. 

[388] 
 



Servers Alive 8 

10. Addenda 

10.1 AIM Tab (People Dialog Box) 

 

Enable AIM for This Person 

Click this option to allow the software to send messages to the selected person. 

AIM Him/Her At __________ Using the Green Schedule 

Enter an AIM address. 

AIM Him/Her At __________ Using the Blue Schedule 

Enter an AIM address. 

AIM Him/Her At __________ Using the Yellow Schedule 

Enter an AIM address. 
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Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
period that you want to change and then click one of the Send or Don't Send buttons. The 
blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green Send button, an alert that 
occurs at that time is sent to the address entered in AIM Him/Her __________ Using the 
Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

ICQ Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 
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10.2 AIM (AOL Instant Messenger) (Setup 
Dialog Box) 

 

In order to send an AIM message, Servers Alive must log on to the AIM network. Because an 
AIM user can have only one concurrent log-in, you should use a different user account for 
sending the AIM alerts than the user account that you use to receive the alerts. 

If sending an AIM alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. For more information, see Failure Settings. 

Enable AIM 

Click this check box to enable this feature and enter information on the dialog box. 

From (AIM Username) 

Enter the AIM name that you want to appear on the alert message as the sender. 

From (AIM Password) 

Enter the appropriate AIM password for the sender name. 

Default To 

Enter the AIM name to which the alert is sent. 

Default Message 

Enter text for the body of the message. This is the default text for the alert message. 
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You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%c for the complete host/check description. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 

%p for the pretty name. 

%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon).Test It 

Tests the settings. You should receive a test message. Remember to click the Apply button 
first, or Servers Alive uses the previous settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 
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Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

ICQ (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 

SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

10.3 ICQ (Setup Dialog Box) 

 

For each alert, Servers Alive logs on and logs off of the ICQ network. The software does not 
stay connected to the network for multiple ICQ alerts. 

If sending an ICQ alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. For more information, see Failure Settings. 
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In order to send an ICQ message, Servers Alive must log on to the ICQ network. Because an 
ICQ user can have only one concurrent log-in, you should use a different user account for 
sending the ICQ alerts than the user account that you use to receive the alerts. 

Enable ICQ 

Click this check box to enable this feature and enter information in the dialog box. 

Login 

Enter the appropriate name for logging in to the ICQ network. 

Password 

Default To 

Enter an ICQ number to which the alert message is sent. This is the ICQ number for your 
account. 

Default Message 

Enter text for the body of the message. This is the default text for the alert message. You can 
use the parameters listed in the previous description. 

Tests the settings. You should receive a test message. Remember to click the Apply button 
first, or Servers Alive uses the previous settings. 

Reset 

Resets the counter that tracks the number of messages that the alert sends when completing a 
check. You can view the number of messages sent since the last time that you clicked the 
Reset button. 

See Also 

Alerts (Setup Dialog Box) 

SMTP (Setup Dialog Box) 

Numeric Paging (Setup Dialog Box) 

Alpha Paging - SMS (Setup Dialog Box) 

Audio (Setup Dialog Box) 

SNMP Trap Sending (Setup Dialog Box) 

Other Mail (Setup Dialog Box) 

MSN Messenger (Setup Dialog Box) 

AIM (AOL Instant Messenger) (Setup Dialog Box) 

XMPP (Jabber) (Setup Dialog Box) 

SNPP (Network Paging) (Setup Dialog Box) 
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SMPP (Network Paging) (Setup Dialog Box) 

NotePage - PageGate (Setup Dialog Box) 

Executive Alerts (Setup Dialog Box) 

10.4 ICQ Tab (People Dialog Box) 
  

 

Enable ICQ for This Person 

Click this option to allow the software to send messages to the selected person. 

ICQ Him/Her At __________ Using the Green Schedule 

Enter an ICQ number. 

ICQ Him/Her At __________ Using the Blue Schedule 

Enter an ICQ number. 

[395] 
 



Servers Alive 8 

ICQ Him/Her At __________ Using the Yellow Schedule 

Enter an ICQ number. 

Grid 

To change the schedule, you must first select a time. Each block represents 15 minutes. You 
cannot select a smaller time scale than 15 minutes. Click and drag the pointer to select the time 
period that you want to change and then click one of the Send or Don't Send buttons. The 
blocks change color to signify the schedule. The various colors for each schedule cannot 
overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the grid to select a time 
period. This button allows Servers Alive to send a message during the time period that you 
selected. For example, if you drag the cursor and then click the green Send button, an alert that 
occurs at that time is sent to the number entered in ICQ Him/Her __________ Using the 
Green Schedule. 

Don't Send 

Click this button after you have selected a time period on the grid. This action tells Servers 
Alive not to send a message during the time period that you selected. 

See Also 

Edit > People (People Dialog Box) 

Person Tab (People Dialog Box) 

SMTP Tab (People Dialog Box) 

Pager Tab (People Dialog Box) 

MSN Tab (People Dialog Box) 

AIM Tab (People Dialog Box) 

XMPP Tab (People Dialog Box) 

On Call Tab (People Dialog Box) 

10.5 What Tab: Send AIM Message 
(Add/Edit Alert Dialog Box) 
To access this dialog box, click the Add button on the Alert tab of the Entries dialog box and 
then click Instant Message > Send AIM Message. The same options on the What tab appear 
when you create or edit an executive alert on the Setup dialog box. 
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To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup button on the Main window and select the Alerts 
branch of the Setup tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 

Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain variables. 

You can use the following variables: 

%a for additional information. For a ping check, this is the round trip time. 

%d for the date. 

%e for extra information. For URL checking, this could contain "404 Not Found" as the 
error message. 

%g contains the group-name. 

%h for the host name. 

%i for hostID; used for numeric paging. 

%m contains the RRD timestamp, useful for undertaking your own type of RRD logging. 
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%r for the remark. 

%s for the status. 

%t for the last check time. 

%u for the unique ID of the host. 

%w for the IP address of the host that the software checks, if known. If the IP address is 
not known, the host name is used. (For an HTTP check via a proxy-server it will contain the 
IP address of the proxy-server) 

%y for the status change date. 

%z for the status change time. 

{0a} for chr(10) for a line feed. 

{0d} for chr(13) for a carriage return. 

{25} for a : (colon). 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send ICQ Message (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

What Tab: Send SNMP Trap (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 
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When Tab (Add/Edit Alert Dialog Box) 

 Trap Alert Tab (Add/Edit Alert Dialog Box) 

10.6 What Tab: Send ICQ Message 
(Add/Edit Alert Dialog Box) 
To access this dialog box, click the Add button on the Alert tab of the Entries dialog box and 
then click . The same options on the What tab appear when you create or edit an executive 
alert on the Setup dialog box. 

 

If sending an ICQ alert by LAN (local area network) fails, Servers Alive can send the alert 
through a DUN (dial-up networking) connection. 

For each alert, Servers Alive logs on and logs off of the ICQ network. The software does not 
stay connected to the network for multiple ICQ alerts. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit button on the Alert tab. 

To 

Enter the information that you want to appear in the To line of the alert message. If you want to 
specify multiple recipients, separate them with a comma. To enter specific information, such as 
an IP or email address, click the Setup Main window and select the Alerts branch of the Setup 
tree. 

When using a person entry, you can enclose the person's name in parentheses; for example: 
(person). When using a team definition, enclose the team name in curly braces, as in {team}. 
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Add 

Click this button to add a person, team, or other item to the box using one of the following 
dialog boxes: 

Select a Person to Add Dialog Box 

Select a Team to Add Dialog Box 

Message (Body) 

Enter the message that you want for the alert. You must specify the message that Servers Alive 
sends. You can use the variables listed below to help you create informative messages. The 
message and subject can contain these variables: 

%h for the host name. 

%p for the pretty name. 

%s for the status. 

%t for the last check time. 

%d for the date. 

%u for the unique ID of the host. 

%c for the complete host/check description. 

%e for extra information. For a URL check, this could contain "404 Not Found" as the error 
message. 

%a for additional information. For a ping check, this is the round trip time. 

%i for hostID; used for numeric paging. 

%z for the status change time. 

%y for the status change date. 

%r for a remark. 

{0d} for chr(13) for a carriage return. 

{0a} for chr(10) for a line feed. 

See Also 

Add/Edit Alert Dialog Box 

What Tab: Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box)  

What Tab: Send Other Mail (Add/Edit Alert Dialog Box) 

What Tab: Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

What Tab: Alpha Page/SMS (Add/Edit Alert Dialog Box) 

[400] 
 

http://www.helpandmanual.com/order.html


Servers Alive 8 

What Tab: Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

What Tab: Send Network Page (SMPP) (Add/Edit Alert Dialog Box) 

What Tab: Generic NotePager-PageGate Message File (Add/Edit Alert Dialog Box) 

What Tab: Numeric Page (Add/Edit Alert Dialog Box) 

What Tab: Execute Command (Add/Edit Alert Dialog Box) 

What Tab: Sound (Add/Edit Alert Dialog Box) 

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) 

What Tab: Send MSN Message (Add/Edit Alert Dialog Box) 

What Tab: Send WinPOPUP Message (Add/Edit Alert Dialog Box) What Tab: Send SNMP Trap 
(Add/Edit Alert Dialog Box) 

What Tab: Send AIM Message (Add/Edit Alert Dialog Box) 

What Tab: Do an SNMP SET (Add/Edit Alert Dialog Box) 

When Tab (Add/Edit Alert Dialog Box) 

Trap Alert Tab (Add/Edit Alert Dialog Box) 
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Box), 208 

Check Tab: TCP Protocol Option (Entries 
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Check Tab: UDP Protocol Option (Entries 
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Check Tab: URL (HTTP/HTTPS) Option 
(Entries Dialog Box), 196 

Check Tab: URL (RTSP/MMS) Option 
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Check Tab: VMWare (Entries Dialog Box), 
215 

Columns 
displaying, 4 
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moving, 4 

COM ODBC (ODBC Query Addon), 355 
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Commands List, 149 
Conditions of Use, 10 
Copyright, 12 
Create Database Connection String Dialog 

Box, 77 
Custom Fields (Setup Dialog Box), 129 
Custom Scripts (Setup Dialog Box), 134 
Custom Tab (Entries Dialog Box), 293 
Default Host Names, 9 
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Edit > Entry (Entries Dialog Box), 297 
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Edit > New Entry (Entries Dialog Box), 160 
Edit > New Entry Based On . . ., 296 
Edit > People (People Dialog Box), 304 
Edit > Protocols (Protocols Dialog Box), 323 
Edit > Teams (Teams Dialog Box), 319 
Edit Menu, 158 
Email, 11 
Entry Items 

adding, 5 
editing, 5 

Example Template, 106 
Executive Alerts (Setup Dialog Box), 66 
Executive When Tab (Add/Edit Executive 

Alert Dialog Box), 68 
External Check Samples: COM-based 

Checks, 344 
External Checks: Error Level, 343 
Failure Settings, 59 
File > Setup (Setup Dialog Box), 20 
File Menu, 19 
FileSize Check, 347 
General (Setup Dialog Box), 120 

General Tab (Entries Dialog Box), 162 
Getting Started, 1 
Getting Started in the Main Window, 1, 4, 

9, 16 
Help Menu, 342 
HKEY_LOCAL_MACHINE\SOFTWAR

E\WOW6432Node\DBU 
Consulting\Servers 
Alive\CRC\EndIgnoreTAG (string), 
201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\CRC\EndTAG (string), 201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\CRC\StartIgnoreTAG (string), 
201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\CRC\StartTAG (string), 201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\diskspace\gb (string value), 195 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\diskspace\kb (string value), 194 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\diskspace\mb (string value), 194 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\DiskSpace\PercentageMeasure 
(string), 195 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\diskspace\tb (string value), 195 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\ExcludeDateTimeInMail 
(dword), 29, 239 
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HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\, 114 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\DownFontStart, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\DownFontStop, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\DownIcon (string), 
113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\HostColumn 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\Includedownstats 
(dword), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\IncludeIcons 
(dword), 114 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\MaintenanceFontSt
art, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\MaintenanceFontSt
op, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\MaintenanceIcon 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\PlaceOfCheckTime 
(dword), 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\SmallStatusColumn 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\StatusColumn 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\TableBackground 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\TableProperties 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UnavailableFontSta
rt, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UnavailableFontSto
p, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UnavailableIcon 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UncheckedFontStar
t, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UncheckedFontSto
p, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UncheckedIcon 
(string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
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Consulting\Servers 
Alive\HTMLPage\UpFontStart, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UpFontStop, 112 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\UpIcon (string), 113 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\HTMLPage\WebServers\, 114 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\http_show_host_and_prettyna
me (string), 145 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Log\CloseEachTime (dword), 75 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Log\db_DateFormat, 77 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Log\db_Timeformat, 77 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Log\HTTPBytesinLog (string), 
75 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Paging\DoubleMessage 
(dword), 42 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Paging\MaxMessageSize 
(string), 43 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Paging\MaxRedials, 42 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Paging\SplitLongMessage 
(string), 43 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\RRD\UseLocalTime (dword), 93 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use 
(string), 31, 239 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Alternate_DNS_to_use_
2 (string), 31 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Alternate_max_size 
(string), 30 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\AlternateFooter (string), 
29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\AlternateHELO (string), 
30 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\AlternateXHeader 
(string), 29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\CustomDateFormat 
(string), 29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\CustomFooterMessage 
(string), 239 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
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Alive\SMTP\CustomTimeFormat 
(string), 29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\KeepAliveTo (string), 28 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\pingtimeout (dword), 28 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use 
(string), 23 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Primary_DNS_to_use_2 
(string), 23 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\Primary_max_size 
(string), 30 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\PrimaryFooter (string), 
29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\PrimaryHELO (string), 30 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string), 
29 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword), 
28 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SMTP\timeout (dword), 28 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 

Alive\SNMPTrap\Localhost (string), 
46 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SNMPTrapReceiver\IncludeTyp
e, 155 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SNMPTrap\ResolveHost 
(dword), 272 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SNMPTrap\SpecificType 
(string), 46 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\AcceptIncompleteResp
onses, 196, 202 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgno
reList, 179, 186, 191 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\CopyRemovesHostID 
(string), 296 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\Dependsonwithoutprett
yname (string), 163 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthe
nticationConnection (dword)., 179, 
186, 191 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\EveningStart (dword), 
127 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\logHTTP (dword), 201 
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HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\logHTTPFIle (string), 
201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\MorningStart (dword), 
127 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\Startup\NumberOfVisibleItems 
(string), 129 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\OnCall_start_day 
(dword), 316 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\PerItemCycle {string}, 
125 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\ProcessnameCaseInse
nsitive (dword), 165 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\SortStringPathSize 
(string), 106 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\tabs_look (dword), 125 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\Tree_Font_Name 
(string), 6 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\Tree_Font_Size 
(string), 6 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 

Alive\StartUp\URL_Word_Separator 
(string), 201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\URLContentInsensitive 
(dword), 201 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\UseimpersonateForPro
cessChecks (reg_dword), 186 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StartUp\UseimpersonateForSer
viceChecks (reg_dword), 180 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StatsLog\db_AlwaysHostName 
(regdword), 84 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StatsLog\db_Dateformat, 84 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StatsLog\db_prettynamesize 
(string), 84 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StatsLog\db_Timeformat, 84 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\StatusSummary\FixedSubject 
(string), 120 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\SYSLog\WithoutProcess 
(dword), 80 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\FTPSleepTime (dword), 
116 
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HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\IncludeAllLargeResponse 
(dword), 117 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\IncludeDownSmallRespo
nse (dword), 117 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\Password (string), 116 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\Server (string), 116 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\Servers 
Alive\WAP\Username (string), 116 

HKEY_LOCAL_MACHINE\SOFTWAR
E\WOW6432Node\DBU 
Consulting\ServersAlive\StartUp\Net
wareVolumev5 (string), 216 

HTML Page (Setup Dialog Box), 97 
ICQ (Setup Dialog Box), 391, 392 
ICQ Tab (People Dialog Box), 389, 394 
Installation, 2 
Installing a Remote Agent, 132 
Interchange Data (Setup Dialog Box), 85 
Interface Settings (Setup Dialog Box), 128 
License Agreement, 10 
Logfile (Setup Dialog Box), 73 
Logging Tab (Entries Dialog Box), 287 
Mailing List, 11 
Maintenance Mode, 9 
Menu 

Help, 340 
Register, 340 
View, 340 

MIB Database (SNMP) (Setup Dialog Box), 
137 

Misc Settings (Setup Dialog Box), 126 
MSN Messenger (Setup Dialog Box), 50 
MSN Tab (People Dialog Box), 310 

Network Tab (Entries Dialog Box), 294 
NotePage - PageGate (Setup Dialog Box), 

64 
Notes Check (NotesDB Check), 351 
Numeric Paging (Setup Dialog Box), 38 
On Call Tab (People Dialog Box), 314 
Organizing Entries with Groups, 6 
Other Licensing Conditions, 11 
Other Mail (Setup Dialog Box), 48 
Output (Setup Dialog Box), 97 
Output Tab (Entries Dialog Box), 286 
Pager Tab (People Dialog Box), 308 
People and Teams Example, 320 
Person Tab (People Dialog Box), 305 
Primary (Setup Dialog Box), 23 
Proxy Settings (Setup Dialog Box), 121 
Radius (Protocols Dialog Box), 335 
Register Menu, 341 
Registry Keys, 356 
Registry Settings, 120 
Registry Settings for SMTP, 28 
Remote Client/Icon, 17 
Remote Clients (Setup Dialog Box), 145 
Remote Control Tool, 316 
Remote DF COM (*NIX Diskspace Check), 

345 
Remote PS COM (*NIX Process Check), 349 
Remote Windows Systems, 19 
RRD Logging (Round Robin Database) 

(Setup Dialog Box), 94 
RRD Tools (Round Robin Database) (Setup 

Dialog Box > RRD Tools > General), 91 
Schedule Tab (Add/Edit Alert Dialog Box), 

278 
Schedule Tab (Entries Dialog Box), 290 
Scripts Dialog Box, 136 
Security (Setup Dialog Box), 147 
Security Issues, 17 
Select a Person to Add Dialog Box, 233 
Select a Team to Add Dialog Box, 233 
Select an MSN Contact to Add, 267 
Select Entries Tab (Global Add/Change 

Dialog Box), 303 
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Servers Alive 
configuring, 4 
downloading, 3 
extending, 3 
installing, 3 

settings 
alerts, 20 
built-in servers, 20 
check, 20 
general, 20 
logging, 20 
output, 20 

SLACK (Setup Dialog Box), 36 
SMPP (Network Paging) (Setup Dialog Box), 

60 
SMTP (Setup Dialog Box), 22 
SMTP Tab (People Dialog Box), 307 
SMTP2POP3 COM (Mailflow Check), 352 
SNMP Trap Receiver (Setup Dialog Box), 

153 
SNMP Trap Sending (Setup Dialog Box), 46 
SNMPv3 Authentication Parameters Dialog 

Box, 212 
SNPP (Network Paging) (Setup Dialog Box), 

56 
Sound, 9 
SSH Server (Setup Dialog Box), 152 
Startup Settings (Setup Dialog Box), 123 
Statistical Logging (Setup Dialog Box), 80 
Statistics, 8 
Status Summary (Setup Dialog Box), 117 
Syslog (Setup Dialog Box), 78 
TCP (Protocols Dialog Box), 324 
Technical Support, 11 
Telnet Server (Setup Dialog Box), 146 
Terminal Server Sessions, 17 
To Database (Interchange Data) (Setup 

Dialog Box), 87 
To Database (Logfile) (Setup Dialog Box), 

76 
To Database (Statistical Logging) (Setup 

Dialog Box), 83 
To File (Interchange Data) (Setup Dialog 

Box), 85 
To File (Logfile) (Setup Dialog Box), 74 

To File (Statistical Logging) (Setup Dialog 
Box), 81 

Trademarks, 12 
Trap Alert Tab (Add/Edit Alert Dialog Box), 

281, 283 
Trap Alerts (Setup Dialog Box), 156 
Twitter (Setup Dialog Box), 70 
UDP (Protocols Dialog Box), 327 
Uptime Logging (Setup Dialog Box), 96 
View Menu, 341 
WAP Page (Setup Dialog Box), 114 
Warranties and Liabilities, 12 
Web Server (Setup Dialog Box), 143 
What Tab (Global Add/Change Dialog Box), 

301 
What Tab: Alpha Page/SMS (Add/Edit Alert 

Dialog Box), 240 
What Tab: Do an SNMP SET (Add/Edit Alert 

Dialog Box), 274 
What Tab: Execute Command (Add/Edit 

Alert Dialog Box), 252 
What Tab: Generic NotePager-PageGate 

Message File (Add/Edit Alert Dialog 
Box), 247 

What Tab: HTTP(S) GET/POST (Add/Edit 
Alert Dialog Box), 261 

What Tab: Numeric Page (Add/Edit Alert 
Dialog Box), 250 

What Tab: Send AIM Message (Add/Edit 
Alert Dialog Box), 395 

What Tab: Send ICQ Message (Add/Edit 
Alert Dialog Box), 398 

What Tab: Send MSN Message (Add/Edit 
Alert Dialog Box), 264 

What Tab: Send Network Page (SMPP) 
(Add/Edit Alert Dialog Box), 245 

What Tab: Send Network Page (SNPP) 
(Add/Edit Alert Dialog Box), 242 

What Tab: Send Other Mail (Add/Edit Alert 
Dialog Box), 234 

What Tab: Send SMTP Mail (Alternate) 
(Add/Edit Alert Dialog Box), 237 

What Tab: Send SMTP Mail (Primary) 
Add/Edit Alert Dialog Box, 230 

What Tab: Send SNMP Trap (Add/Edit Alert 
Dialog Box), 271 
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What Tab: Send Tweet (Twitter alert), 263 
What Tab: Send WinPOPUP Message 

(Add/Edit Alert Dialog Box), 269 
What Tab: Send XMPP/Jabber Message, 

267 
What Tab: SLACK (Add/Edit Alert Dialog 

Box), 273 

What Tab: Sound (Add/Edit Alert Dialog 
Box), 259 

What's New, 1 
When Tab (Add/Edit Alert Dialog Box), 275 
XMPP (Jabber) (Setup Dialog Box), 53 
XMPP Tab (People Dialog Box), 313 
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